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Disclaimer
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1 Introduction

1.1 Instrument description

The 917 Coulometer is a compact titration system for coulometric Karl
Fischer titration. This titrator combines in a single device the touch-sensi-
tive color monitor for convenient and efficient operation, the magnetic
stirrer and the membrane pump for adding and aspirating solvents. The
upper side of the housing offers space for the titration cell. Thanks to its
compact construction, you can use the 917 Coulometer in a small space
as a stand-alone titrator.

You manage reagents, sensors, methods, etc. conveniently in the internal
memory of the coulometer. You can also save your files externally through
the USB connector, e.g. on a USB flash drive. On this storage medium you
can not only store your methods and determinations, but also create a
backup together with all of the data and settings of your system.

The integrated Ethernet connector is available to you should you wish to
connect your 917 Coulometer to a network. The network connection
offers you the following advantages:

￭ Saving data to a computer within the network
￭ Printing reports on a network printer
￭ Sending displayed messages as e-mails

1.1.1 Titration and measuring modes
The 917 Coulometer supports the following titration and measuring
modes.

￭ KFC
Coulometric water content determination according to Karl Fischer
with voltametric measurement.

￭ BRC
Coulometric bromine index determination. Determining the amount of
double bonds in e.g. mineral oils.

￭ MEAS
Measuring modes:

– Ipol (voltametric measurement with selectable polarization cur-
rent)

– Upol (amperometric measurement with selectable polarization
voltage)

– T (temperature measurement)
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1.1.2 Connectors
The 917 Coulometer is equipped with the following connectors:

￭ Power connection
For connecting to the power grid using the power supply unit provi-
ded.

￭ Two MSB connectors (Metrohm Serial Bus)
For connecting dosing devices, one additional stirrer or a Remote Box.

￭ USB connector
For connecting peripheral devices (printer, PC keyboard, etc.), a USB
flash drive, a Sample Processor or a USB hub.

￭ Sensor connectors
One connector each for:

– Generator electrode
– Indicator electrode
– Temperature sensor (Pt1000 or NTC)

￭ Ethernet connector
For connecting the Coulometer to a network.

￭ Two connection nipples
For connecting tubing for replacing reagent using the built-in pump.

1.1.3 Intended use
The 917 Coulometer is designed for usage as a titrator in analytical labora-
tories. Its main application field is coulometric Karl Fischer titration.

This instrument is suitable for processing chemicals and flammable sam-
ples. Therefore, the use of the instrument requires the user to have basic
knowledge and experience in handling toxic and caustic substances.
Knowledge regarding the application of fire prevention measures prescri-
bed for laboratories is also mandatory.

1.2 About the documentation

CAUTION

Please read through this documentation carefully before putting the
instrument into operation. The documentation contains information
and warnings which the user must follow in order to ensure safe opera-
tion of the instrument.
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1.2.1 Symbols and conventions
The following symbols and formatting may appear in this documentation:

Cross-reference to figure legend

The first number refers to the figure number, the
second to the instrument part in the figure.

Instruction step

Perform the steps one after the other.

Method Dialog text, parameter in the software

File ▶ New Menu or menu item

[Continue] Button or key

WARNING

This symbol draws attention to a possible life-threat-
ening hazard or risk of injury.

WARNING

This symbol draws attention to a possible hazard due
to electrical current.

WARNING

This symbol draws attention to a possible hazard due
to heat or hot instrument parts.

WARNING

This symbol draws attention to a possible biological
hazard.

WARNING

Warning of optical radiation

CAUTION

This symbol draws attention to possible damage to
instruments or instrument parts.

NOTICE

This symbol highlights additional information and
tips.
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2 Safety instructions

2.1 General notes on safety

WARNING

Operate this instrument only according to the information contained in
this documentation.

This instrument left the factory in a flawless state in terms of technical
safety. To maintain this state and ensure non-hazardous operation of the
instrument, the following instructions must be observed carefully.

2.2 Electrical safety

The electrical safety when working with the instrument is ensured as part
of the international standard IEC 61010.

WARNING

Only personnel qualified by Metrohm are authorized to carry out service
work on electronic components.

WARNING

Never open the housing of the instrument. The instrument could be
damaged by this. There is also a risk of serious injury if live components
are touched.

There are no parts inside the housing which can be serviced or replaced
by the user.

Supply voltage

WARNING

An incorrect supply voltage can damage the instrument.

Only operate this instrument with a supply voltage specified for it (see
rear panel of the instrument).
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Protection against electrostatic charges

WARNING

Electronic components are sensitive to electrostatic charges and can be
destroyed by discharges.

Do not fail to pull the power cord out of the power socket before you
set up or disconnect electrical plug connections at the rear of the
instrument.

2.3 Tubing and capillary connections

CAUTION

Leaks in tubing and capillary connections are a safety risk. Tighten all
connections well by hand. Avoid applying excessive force to tubing con-
nections. Damaged tubing ends lead to leakage. Appropriate tools can
be used to loosen connections.

Check the connections regularly for leakage. If the instrument is used
mainly in unattended operation, then weekly inspections are manda-
tory.

2.4 Flammable solvents and chemicals

WARNING

All relevant safety measures are to be observed when working with
flammable solvents and chemicals.

￭ Set up the instrument in a well-ventilated location (e.g. fume cup-
board).

￭ Keep all sources of flame far from the workplace.
￭ Clean up spilled liquids and solids immediately.
￭ Follow the safety instructions of the chemical manufacturer.
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2.5 Recycling and disposal

This product is covered by European Directive 2012/19/EU, WEEE – Waste
Electrical and Electronic Equipment.

The correct disposal of your old instrument will help to prevent negative
effects on the environment and public health.

More details about the disposal of your old instrument can be obtained
from your local authorities, from waste disposal companies or from your
local dealer.
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3 Overview of the instrument

3.1 Front of the instrument

Figure 1 Front

1 Display
Touch screen.

2 Fixed key [Home]
Opens the main dialog.

3 Fixed key [Back]
Saves the entry and opens the next-higher
dialog page.

4 Fixed key [Help]
Opens the online help for the dialog dis-
played.

5 Fixed key [Print]
Opens the print dialog.

6 Key
Pressing the key pumps air into the solvent
bottle. The overpressure in the solvent bottle
pushes solvent into the titration cell.

7 Key
Pressing the key aspirates air out of the aspi-
ration bottle. The vacuum in the aspiration
bottle aspirates the liquid out of the titration
cell and into the aspiration bottle.

8 Fixed key [Manual]
Opens the manual control.

9 Fixed key [STOP]
Cancels the running determination.

10 Fixed key [START]
Starts a determination.

11 Magnetic stirrer
For placing the titration vessel holder.
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3.2 Rear of the instrument

Figure 2 Rear

1 USB connector (type A)
For connecting printers, USB flash drives,
USB hubs, 885 Compact Oven SC, etc.

2 Ethernet connector (RJ-45)
For connecting to a network.

3 Indicator electrode connector (Ind.)
For connecting the indicator electrode.

4 Temperature sensor connector (Temp.)
For connecting temperature sensors (Pt1000
or NTC). Two B sockets, 2 mm.

5 MSB connector (MSB 1 and MSB 2)
Metrohm Serial Bus. For connecting external
dosing devices, stirrers or a Remote Box.
Mini DIN, 8-pin.

6 Generator electrode connector (Gen.)
For connecting the generator electrode.

7 Power socket (Power)
For connecting the external power supply
unit.

8 Power switch
Switches the instrument on/off.

9 Connection nipple for PVC tubing
For aspirating the contents of the titration
cell.

10 Connection nipple for PVC tubing
For aspirating solvent.

11 Type plate
Contains the serial number.
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4 Installation

4.1 Setting up the instrument

4.1.1 Packaging
The instrument is supplied in protective packaging together with the sepa-
rately packed accessories. Keep this packaging, as only this ensures safe
transportation of the instrument.

4.1.2 Checks
Immediately after receipt, check whether the shipment has arrived com-
plete and without damage by comparing it with the delivery note.

4.1.3 Location
The instrument has been developed for operation indoors and may not be
used in explosive environments.

Place the instrument in a location of the laboratory which is suitable for
operation and free of vibrations and which provides protection against
corrosive atmosphere and contamination by chemicals.

The instrument should be protected against excessive temperature fluctua-
tions and direct sunlight.
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4.2 Setting up the titration cell for coulometry

4.2.1 Inserting the titration cell

Figure 3 Inserting the titration cell

Set up the titration cell on the magnetic stirrer as follows:

 

1 Attach the 6.2047.040 titration vessel holder to the magnetic stirrer.

 

2 Insert the 6.1464.320 titration cell into the titration vessel holder.

4.2.2 Preparing the titration cell

Filling the adsorber tube

Before setting up the titration cell, the 6.1403.030 adsorber tube has to
be filled with 6.2811.000 molecular sieve. Proceed as follows:
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6.1403.030

6.2811.000

1

2

3

4

Figure 4 Filling the adsorber tube

 

1 Insert a small cotton plug into the bottom of the adsorber tube. Do
not pack the cotton too tightly.

 

2 Fill the molecular sieve up to ¾ of the height.

 

3 Place a small cotton plug on the molecular sieve. Do not pack the
cotton too tightly.

 

4 Seal the adsorber tube with the appropriate cover.

NOTICE

Note that the molecular sieve must be replaced at regular intervals.
Each time you refill the adsorber tube with molecular sieve, you can, for
example, write the date directly on the adsorber tube.
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Equipping the titration cell

6.1903.030

6.1464.320

6.2713.010

6.1437.000

6.0345.100

6.2713.020

6.1403.030

6.1448.020

6.2701.040

6.2713.000

6.0341.100

2

1

2

5

2

3

4

6

6.0344.100

Figure 5 Equipping the titration cell

Equip the titration cell as follows:

 

1 Place the 6.1903.030 stirring bar in the titration cell.

 

2 Cut the 6.2713.0x0 ground-joint sleeves to the correct length and
attach them to the ground joints of the inserts (electrodes, adsorber
tube, etc.).

Take care to ensure that the edges of the ground-joint sleeves are cut
to size cleanly and that there are no fringes. The ground-joint sleeves
must not protrude at the lower edge of the ground-joint opening.

 

3 Insert the 6.1403.030 adsorber tube into the generator electrode.
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4 Insert the 6.0345.100 generator electrode without diaphragm or the
6.0344.100 generator electrode with diaphragm together with the
adsorber tube into the large ground-joint opening at the rear.

 

5 Insert the 6.0341.100 indicator electrode into the left ground-joint
opening.

 

6 Place the 6.1448.020 septum on the front opening of the titration
cell and screw it shut with the 6.2701.040 screw cap.

Tighten the screw cap only enough so that it seals. The septum must
not bend.

Filling the titration cell (generator electrode without dia-
phragm)

Proceed as follows when using a generator electrode without a dia-
phragm:

 

1 Fill approximately 100 mL of reagent into the titration cell using the
6.2738.000 funnel.

 

2 Close the remaining ground-joint opening on the right with the
6.1437.000 ground-joint stopper (with ground-joint sleeve attached).

Filling the titration cell (generator electrode with dia-
phragm)

Proceed as follows when using a generator electrode with a diaphragm:

 

1 Fill approximately 5 mL of catholyte into the generator electrode.

 

2 Fill approximately 100 mL of anolyte into the titration cell using the
6.2738.000 funnel. The level of the anolyte should be roughly 1 - 2
mm above the level of the catholyte.

 

3 Close the remaining ground-joint opening on the right with the
6.1437.000 ground-joint stopper (with ground-joint sleeve attached).
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4.2.3 Mounting the addition and aspiration tube

Figure 6 Mounting the addition and aspiration tube

Insert the addition and aspiration tube as follows into the titration cell:

 

1 Attach the 6.2713.000 ground-joint sleeve that has been cut to size
to the ground joint of the 6.1437.000 stopper.

 

2 Insert the stopper into the 6.1439.010 addition and aspiration tube.

 

3 Attach the 6.2713.000 ground-joint sleeve that has been cut to size
to the ground joint of the addition and aspiration tube.

 

4 Insert this assembly into the ground-joint opening.

 

5 Connect the tubing for the reagent addition at the upper connector
of the addition and aspiration tube (5).

 

6 Connect the tubing for the aspiration of the titration cell at the lower
connector of the addition and aspiration tube (6).

Details regarding how to connect the addition tubing and the aspiration
tubing can be found in the tutorial for the 917 Coulometer.
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4.3 Connecting the coulometer to the power supply

Connecting the power supply unit

The 917 Coulometer has an external power supply unit for a 24 V power
supply (DC). This is connected to the power socket of the coulometer.

WARNING

An incorrect supply voltage can damage the instrument.

Operate the instrument only with the supply voltage specified for it. Use
the supplied power supply unit exclusively, see chapter Technical specifi-
cations.

Figure 7 Connecting the power supply unit

Proceed as follows:

 

1 Connect the plug of the external power supply unit with the power
socket of the coulometer.
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NOTICE

The plug of the power supply unit is protected against accidental
disconnection of the cable by means of a pull-out protection fea-
ture. If you wish to pull out the plug, you first need to pull back
the outer plug sleeve marked with arrows.

 

2 Connect the power cord with the external power supply unit of the
coulometer and with the power grid.

CAUTION

Switch off the Coulometer correctly by pressing the power switch
before you disconnect the electricity supply. If this is not done, then
there is a danger of data loss.

4.4 Connecting sensors

The measuring interface contains the following measuring inputs:

￭ Gen. for a generator electrode
￭ Ind. for a double Pt electrode
￭ Temp. for a temperature sensor of the Pt1000 or NTC type

CAUTION

Under all circumstances, avoid mixing up the electrode cable from the
indicator electrode with the one from the generator electrode. Mark
the screw heads of the cables accordingly.

4.4.1 Connecting generator electrodes

Screwing the electrode cable to the generator electrode

 

1 Unscrew the protective cap from the generator electrode.
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1

Figure 8 Unscrewing the protective cap from the generator elec-
trode

 

2 Tighten the 6.2104.120 electrode cable to the generator electrode.

2
6.2104.120

Figure 9 Screwing the electrode cable to the generator electrode

Connecting the electrode cable to the coulometer

 

1 Plug the electrode plug into the Gen. socket of the coulometer.
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Figure 10 Connecting a generator electrode

NOTICE

The electrode cable is protected against accidental disconnection
of the cable by means of a pull-out protection. If you wish to pull
out the plug again, you first need to pull back the outer plug
sleeve.

4.4.2 Connecting indicator electrodes

Screwing the electrode cable to the indicator electrode

 

1 Unscrew the protective cap from the indicator electrode.

1

Figure 11 Unscrewing the protective cap from the indicator elec-
trode

 

2 Tighten the 6.2104.020 electrode cable to the indicator electrode.
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2

6.2104.020

Figure 12 Screwing the electrode cable to the indicator electrode

Connecting the electrode cable to the coulometer

 

1 Plug the electrode plug into the Ind. socket of the coulometer.

Figure 13 Connecting an indicator electrode
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NOTICE

The electrode cable is protected against accidental disconnection
of the cable by means of a pull-out protection. If you wish to pull
out the plug again, you first need to pull back the outer plug
sleeve.

4.4.3 Connecting a temperature sensor
A temperature sensor of the Pt1000 or NTC type can be connected to the
Temp. connector.

Connect the temperature sensor as follows:

1 Insert the plugs of the temperature sensor into the Temp. sockets of
the coulometer.

NOTICE

Always insert the red plug into the red socket. This is the only way
that shielding against electrical interference can be ensured.
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4.5 Connecting MSB devices

In order to connect MSB devices, e.g. dosing device or Remote Box, the
Coulometer has two connectors at what is referred to as the Metrohm
Serial Bus (MSB). Various peripheral devices can be connected in sequence
(daisy chain) at a single MSB connector (8-pin Mini DIN socket) and be
controlled simultaneously by the Coulometer. In addition to the connec-
tion cable, stirrers and the Remote Box are each equipped with their own
MSB socket for this purpose.

NOTICE

The additional stirrer must not be connected to the MSB 1!

The following figure provides an overview of the instruments that can be
connected to an MSB socket, along with a number of different cabling
variations.

MSB

Stirrer / Ti Stand

Dosimat / Dosino

Dosimat

Remote Box

Dosino

Ti Stand / Stirrer

Figure 14 MSB connections
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NOTICE

When connecting MSB devices together, the following must be
observed:

￭ No additional stirrer may be connected to the MSB 1!
￭ Only one device of the same type may be used at a single MSB con-

nector at one time.
￭ When making the connection, take care to ensure that the flat part

of the MSB plug marked with arrows is pointing in the direction of
the marking on the MSB connector (see figure 15, page 22).

Figure 15 MSB connector

CAUTION

Switch off the Coulometer before you plug in MSB devices. When it is
switched on, the Coulometer automatically recognizes which device is
connected to which MSB connector. The connected MSB devices are
entered automatically in the device manager.

MSB connections can be extended with the 6.2151.010 cable. The maxi-
mum connection length permitted is 6 m.

4.5.1 Connecting a dosing device
You can connect two dosing devices to the Coulometer.

The types of dosing devices that are supported are:

￭ 800 Dosino
￭ 805 Dosimat
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Proceed as follows:

 

1 Switch off the Coulometer.

 

2 Connect the dosing device connection cable to an MSB connector on
the rear side of the Coulometer.

 

3 Switch on the Coulometer.

4.5.2 Connecting an additional stirrer or titration stand
Proceed as follows:

 

1 Switch off the Coulometer.

 

2 Connect the connection cable of the magnetic stirrer or of the titra-
tion stand to MSB 2 on the rear of the Coulometer.

 

3 Switch on the Coulometer.

4.5.3 Connecting a Remote Box
Instruments that are controlled via remote lines and/or that send control
signals via remote lines can be connected via the 6.2148.010 Remote Box.
In addition to Metrohm, other instrument manufacturers also use similar
connectors that make it possible to connect different instruments
together. These interfaces are also frequently given the designations "TTL
Logic", "I/O Control" or "Relay Control" and they generally have a signal
level of 5 volts.

Control signals are understood to be electrical line statuses or brief
(> 200 ms) electrical pulses which display the operational state of an
instrument or which trigger or report an event. Sequences on a variety of
instruments can thus be coordinated in a single complex automation sys-
tem. However, no exchange of data is possible.

Proceed as follows:

 

1 Switch off the Coulometer.

 

2 Connect the Remote Box connection cable to an MSB connector on
the rear side of the Coulometer.

 

3 Switch on the Coulometer.
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You will find precise information concerning the pin assignment of the
interface on the Remote Box in the appendix.

4.6 Connecting USB devices

4.6.1 General
The 917 Coulometer has a USB connector (type A socket) for peripheral
devices with a USB interface and for the 885 Compact Oven SC. If you
wish to connect more than one device to the USB, you can use a commer-
cially available USB hub.

NOTICE

We recommend that the Coulometer be switched off while you set up
or disconnect connections between the devices.

4.6.2 Connecting a USB hub
Use a USB hub with its own power supply.

Connect the USB hub as follows:

1 With the help of the 6.2151.030 cable (length 0.6 m) or the
6.2151.020 cable (length 1.8 m), connect the USB connector of the
Coulometer (Type A) with the USB connector of the hub (Type B, see
manual for the USB hub).

The USB hub is recognized automatically.

4.6.3 Connecting a printer
Printers connected to the 917 Coulometer must meet the following
requirements:

￭ Printer languages: HP-PCL, HP-PCL-GUI, Canon BJL Commands or
Epson ESC P/2

￭ Paper size: A4 or Letter.

Connect the printer as follows:

1 With the aid of the 6.2151.020 cable, connect the USB connector of
the Coulometer (type A) with the USB connector of the printer (type
B, see manual for the printer).

 

2 Configure the printer in the device manager of the Coulometer (see
chapter 10.6, page 79).
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4.6.4 Connecting a balance
If you want to connect a balance to the Coulometer you need a USB/
RS-232 adapter (6.2148.050).

The following table offers an overview of the balances that you can use
together with the Coulometer and of which cable you will need for
connection to the RS-232 interface:

Balance Cables

AND ER, FR, FX with RS-232 inter-
face (OP-03)

6.2125.020 + 6.2125.010

Mettler AB, AG, PR (LC-RS9) In the scope of delivery for the
balance

Mettler AM, PM, PE with interface
option 016

or

Mettler AJ, PJ with interface
option 018

6.2146.020 + 6.2125.010

Also from Mettler: ME 47473
adapter and either ME 42500
hand switch or ME 46278 foot
switch

Mettler AT 6.2146.020 + 6.2125.010

Also from Mettler: ME 42500
hand switch or ME 46278 foot
switch

Mettler AX, MX, UMX, PG, AB-S,
PB-S, XP, XS

6.2134.120

Mettler AE with interface option
011 or 012

6.2125.020 + 6.2125.010

Also from Mettler: ME 42500
hand switch or ME 46278 foot
switch

Ohaus Voyager, Explorer, Analyti-
cal Plus

Cable AS017-09 from Ohaus

Precisa balances with RS-232-C
interface

6.2125.080 + 6.2125.010

Sartorius MP8, MC, LA, Genius,
Cubis

6.2134.060

Shimadzu BX, BW 6.2125.080 + 6.2125.010
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Connect the balance as follows:

 

1 Connect the USB plug of the USB/RS-232 adapter with the USB con-
nector of the Coulometer (Type A).

The USB/RS-232 adapter will be recognized automatically and
entered in the device manager of the Coulometer.

 

2 Connect the RS-232 interface of the USB/RS-232 adapter with the
RS-232 interface of the balance (see table for cable).

 

3 Switch on the balance.

 

4 If necessary, switch on the RS-232 interface of the balance.

 

5 Configure the RS-232 interface of the USB/RS-232 adapter in the
device manager of the Coulometer (see chapter 10.8, page 85).

 

6 Enter and configure the balance in the device manager of the Coul-
ometer (see chapter 10.7, page 83).

 

7 Make sure that the parameters of the USB/RS-232 adapter config-
ured in the device manager match those of the balance.

4.6.5 Connecting a PC keyboard
The PC keyboard is used as an aid for text and numerical input.

Connect the PC keyboard as follows:

1 Connect the USB plug of the keyboard with the USB connector of
the Coulometer (Type A).

 

2 Enter and configure the keyboard in the device manager of the Coul-
ometer (see chapter 10.9, page 87).

4.6.6 Connecting a barcode reader
The barcode reader is used as an aid for text and numerical input. You can
connect a barcode reader with USB interface.

Connect the barcode reader as follows:

 

1 Connect the USB plug of the barcode reader with the USB connector
of the Coulometer (Type A).
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2 Enter and configure the barcode reader in the device manager of the
(see chapter 10.10, page 88).

Settings on the barcode reader:

Program the barcode reader as follows (also see manual for the barcode
reader):

1 Switch the barcode reader to programming mode.

 

2 Specify the desired layout for the keyboard (USA, Germany, France,
Spain, German-speaking Switzerland).

This setting must match the setting in the device manager.

 

3 Make sure that the barcode reader is set in such a way that Ctrl char-
acters (ASCII 00 to 31) can be sent.

 

4 Program the barcode reader in such a way that the ASCII character
02 (STX or Ctrl B) is sent as the first character. This first character is
normally referred to as the "Preamble" or "Prefix Code".

 

5 Program the barcode reader in such a way that the ASCII character
04 (EOT or Ctrl D) is sent as the last character. This last character is
normally referred to as the "Postamble", "Record Suffix" or "Postfix
Code".

 

6 Exit the programming mode.

4.6.7 Connecting the 885 Compact Oven SC

NOTICE

In order for the 885 Compact Oven SC to be controlled with the
917 Coulometer, the following firmware versions must be installed on
the instruments as a minimum requirement:

￭ 917 Coulometer 5.917.0025
￭ 885 Compact Oven SC 5.885.0013

The 885 Compact Oven SC is connected via the USB interface. The
6.2151.110 USB cable is required for this.

If the USB interface on the 917 Coulometer is also needed for other USB
devices (USB flash drive, USB keyboard, USB/RS-232 adapter for balance),
use a USB hub with its own power supply.
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Connect the 885 Compact Oven SC as follows:

1 Switch off the 917 Coulometer.

 

2 Connect the 885 Compact Oven SC to the Coulometer using a USB
cable.

 

3 Switch on the 885 Compact Oven SC.

 

4 Switch on the 917 Coulometer.

NOTICE

When the 917 Coulometer is started, the 885 Compact Oven SC is
added to the device manager and the settings from the device
manager are transferred to the instrument.

The switch-on sequence must be strictly observed with the 885
Compact Oven SC.

 

5 Configure the 885 Compact Oven SC in the device manager (see
chapter 10.5, page 75).

4.7 Connecting the Coulometer to a network

The 917 Coulometer has a network connection (Ethernet). This can be
used to integrate your Coulometer in your network. You can, for example,
store data on a PC within the network or print reports on a network
printer. In Chapter 10, page 64, you will find information as to which
settings are necessary for the network connection.

Connecting the Coulometer to a network
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5 Titrations

5.1 Coulometric water content determination according
to Karl Fischer (KFC)

The coulometric Karl Fischer titration is a variation of the classic water
content determination method according to Karl Fischer.

The conventional method works with a methanolic solution of iodine, sul-
fur dioxide and a base as buffer substance. When titrating a sample con-
taining water several reactions take place, which can be summarized by
the following equation:

H2O + I2 + [RNH]SO3CH3 + 2 RN <=> [RNH]SO4CH3 + 2 [RNH]I

According to the equation above, the I2 reacts quantitatively with H2O.
This chemical relation is the base for the water content determination.

With the coulometric Karl Fischer titration, the necessary iodine is directly
and electrochemically generated in the submitted electrolyte ("electronic
buret"). Between the amount of electric charge and the amount of gener-
ated iodine, there is a strictly quantitative relationship, which is used for
high-precision dosing of the iodine. No titer needs to be determined as
the coulometric Karl Fischer method is an absolute determination. It must
only be ensured that the reaction generating the iodine runs with a 100%
current efficiency. This is the case with all the reagents available at pres-
ent.

The endpoint indication is effected voltametrically by modulating an alter-
nating current of constant strength to a double Pt electrode. This produ-
ces a voltage difference between the Pt wires, which significantly declines
when lowest amounts of free iodine are present. This circumstance is used
for detecting the endpoint of the titration.
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5.2 Bromine index determination (BRC)

The bromine index is a measure for the content of olefins in a sample.

The basis for the bromine index determination is the addition of bromine
to the double bond of olefins. A bromine molecule is used for every car-
bon-carbon double bond.

With the bromine index determination, the necessary bromine is directly
and electrochemically generated in the submitted electrolyte ("electronic
buret"). Between the amount of electric charge and the amount of gener-
ated bromine, there is a strictly quantitative relationship, which is used for
high-precision dosing of the bromine. No titer needs to be determined as
the bromine index determination is an absolute determination.

The bromine index is usually indicated in mg bromine per 100 g sample.
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6 Operation

6.1 Switching the instrument on and off

Switching on the instrument

CAUTION

Peripheral devices (e.g., printers, 885 Compact Oven SC, etc) must be
connected and switched on before you switch on the 917 Coulometer.

NOTICE

English is set as the default dialog language when the instrument is
switched on for the first time.

Proceed as follows:

 

1 ￭ Press the power switch on the left-hand side of the back panel of
the 917 Coulometer.
The 917 Coulometer is initialized. A system test is performed. This
process takes some time.

NOTICE

If a buret unit is connected, then a request appears to carry out
the Prepare function:

All tubings and the cylinder are rinsed with the Prepare function.
The preparing of the buret unit is described in chapter 27.3.3,
page 221.
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￭ Confirm the message with [OK].

The main dialog is displayed:

Switching off the instrument

CAUTION

The 917 Coulometer must be switched off by pressing the power
switch on the rear of the instrument before the electricity supply is
interrupted. If this is not done, then there is a danger of data loss.

Proceed as follows:

 

1 Press the power switch on the left-hand side of the back panel of the
917 Coulometer.

The current data is saved and the system is shut down. This process
takes just a short time. At the same time, all other instruments
connected to the 917 Coulometer via a USB cable are also being
switched off (except the 885 Compact Oven SC).

6.2 Fundamentals of operation

6.2.1 Touch-sensitive screen
The entire 917 Coulometer user interface is touch-sensitive. Simply touch
a few of the buttons on the interface to learn how a touch-sensitive

screen reacts. You can always return to the main dialog by touching [ ].

In order to enable an element on the 917 Coulometer user interface, just
touch the screen with your fingertip, the eraser of a pencil or a stylus (spe-
cial tool for operating instruments with touch-sensitive screens).

CAUTION

Never touch the touch screen with a pointed or sharp object such as a
ballpoint pen.

In the default setting, the software is configured in such a way that an
acoustic signal will be generated every time an active control is touched.
This setting can be deactivated in the system settings (see chapter 7.5,
page 55).
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6.2.2 Display elements and controls

The following display elements and controls are available:

Table 1 Fixed keys which are always available

[Home] always opens the main dialog.

[Back] saves the entry and opens the next-higher dialog
page.

[Help] opens the online help for the dialog displayed.

[Print] opens the printing dialog.

[Manual] opens the manual control.

[Stop] cancels the running determination.

[Start] starts a determination.

The file name of the loaded method, the time and the system status are
displayed in the main dialog in the Title bar.

In the other dialogs, the title bar shows the headings of the next upper
level and of the displayed dialog. This is an aid for orientation during navi-
gation through the user dialog.

Table 2 Screen elements

Buttons open a new dialog when they are tap-
ped.
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Inactive buttons with gray lettering indicate
that the respective function is not available at the
moment.

Input fields open an input dialog when tapped.

Tapping on the selection symbol opens a selec-
tion list.

A check box can also be activated or deactiva-
ted by tapping on it.

6.2.3 Status display
The current status of the system is displayed in the upper right-hand cor-
ner of the title bar.

Table 3 Status displays

The instrument is in normal status.

The working medium is being conditioned.

Conditioning has been paused.

The working medium is conditioned.

A method has been started.

A method has been paused.

An action has been started in manual control.
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6.2.4 Entering text and numbers
In the editing dialog for text or numerical input, enter the individual char-
acters by tapping in the input field. The following functions are available:

Text editor

Table 4 Editing functions

Editing function Description

[OK] The modification is applied and the editing dialog
is exited.

[Cancel] The editing dialog is exited without applying the
modification.

[Delete entry] The content of the input field is deleted com-
pletely.

[⌫] The character in front of the cursor is deleted.

[⇦] The cursor within the input field is shifted to the
left by one character.

[⇨] The cursor within the input field is shifted to the
right by one character.

[a…z] The lower-case letters are displayed. The label
changes to [A…Z]. The upper-case letters are
displayed again by tapping.

[0–9] Numbers and mathematical characters are dis-
played.

[Special charac-
ters]

Special characters are displayed. You can use the
button [More] to navigate through all available
characters.
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Number editor

Table 5 Editing functions

Editing function Description

[OK] The modification is applied and the editing dialog
is exited.

[Cancel] The editing dialog is exited without applying the
modification.

[Delete entry] The content of the input field is deleted com-
pletely.

[off] If not only numbers but also special values (e.g.,
off) can be entered, then the corresponding but-
tons will be shown to the right of the numerical
keypad.

[R1] For many parameters, a result previously defined
in the method can also be entered in place of a
number (see chapter 31.5, page 313). You can
select the result variable by touching [R1].

NOTICE

A commercially available USB keyboard can be connected to make text
and numerical input easier. The key assignment is described in chapter
10.9, page 87.
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7 System settings

Main dialog: System ▶ System settings

This chapter describes the various system settings and configurations.

￭ Selecting the dialog language (see chapter 7.1.1, page 37).
￭ Setting the date and time (see chapter 7.1.2, page 38).
￭ Defining system-specific dialog options (see chapter 7.2, page 39).
￭ User administration (see chapter 7.3, page 42).
￭ Defining settings for the measured value display (see chapter 7.4, page

55).
￭ Configuring settings for acoustic signals (see chapter 7.5, page 55).

7.1 General system settings

7.1.1 Selecting the dialog language
The user interface is available in several languages. In addition to the two
default dialog languages English and German, additional languages can
be selected.

Proceed as follows to select the dialog language:

 

1 Opening the system settings

￭ In the main dialog, tap on [System].
￭ Tap on [System settings].

The System / System settings dialog is displayed.
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2 Selecting the dialog language

￭ Tap on the Dialog language list box and select the desired lan-
guage.

 

3 Saving the settings

Tap on the fixed keys [ ] or [ ].

The main dialog is displayed in the respective dialog language.

7.1.2 Setting the date, time and local time
The Coulometer displays the date and time in accordance with ISO
standard 8601.

Proceed as follows to set the date and time:

 

1 Opening the system settings

￭ In the main dialog, tap on [System].
￭ Tap on [System settings].

The System / System settings dialog is displayed.

 

2 Entering the date

￭ Tap on the input field for the date.
The editor opens.

￭ Enter the current date in the format YYYY-MM-DD and confirm
with [OK].
The arrow keys [⇦] and [⇨] are used to move the cursor to the
left or to the right by one character.

The input is saved and the editor is closed.

 

3 Entering the time

￭ Tap on the input field for the time.
The editor opens.

￭ Enter the current time in the format hh:mm:ss (24-hour format)
and confirm with [OK].
The arrow keys [⇦] and [⇨] are used to move the cursor to the
left or to the right by one character.

The input is saved and the editor is closed.
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4 Enter the local time

￭ Tap on the list box Local time - UTC and select the difference
from the UTC (Coordinated Universal Time).
The selection off means that the time is saved with no difference
from the UTC.

 

5 Saving the settings

Tap on the fixed keys [ ] or [ ].

The time settings are saved.

7.2 System-specific dialog options

Main dialog: System ▶ System settings ▶ Dialog options

If you work without a login function, in this dialog you can define
whether the system should generally be operated in expert mode or in
routine mode. If you work with the login function activated, you must
define this setting separately for each user (see chapter 7.3.1, page 44).

Dialog

Dialog mode in which the user may operate the system.

Selection Expert dialog | Routine dialog

Expert dialog
All functions that are supported by the system are available.

Routine dialog
The user dialog can be limited for routine operations. Only selected
functions are available (see Configuring the routine dialog, page 41).
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[Fixed keys]

Block unneeded fixed keys (see "Blocking unneeded fixed keys", page
40).

[Routine dialog]

Configure functions for the routine dialog (see "Configuring the routine
dialog", page 41).

Selecting the dialog mode

Proceed as follows to change the dialog mode:

 

1 Select the dialog mode

Open the selection list Dialog and select either Expert dialog or
Routine dialog.

 

2 Saving the settings

Tap on the fixed keys [ ] or [ ].

The setting will apply to all dialogs.

NOTICE

If you have selected Routine dialog and if the routine dialog was
configured in such a way that the dialog System settings / Dia-
log options is blocked, then you can switch back over to the
expert dialog as follows:

￭ Operation without login function:
In the main dialog, enter User = Metrohm.

￭ Operation with login function:
A user who works with expert dialog must log in.

Blocking unneeded fixed keys

This following configurations apply for both dialog modes: routine dialog
and expert dialog.

Blocking fixed keys

Proceed as follows to block unneeded fixed keys:

 

1 Display fixed keys which can be blocked

Tap on the [Fixed keys] button.

All fixed keys which can be blocked are displayed.
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2 Deactivate fixed keys

Deactivate those fixed keys which are not permitted to be used.

 

3 Saving the settings

Tap on the fixed keys [ ] or [ ].

Deactivated fixed keys cannot be used.

Configuring the routine dialog

A suitable Standard configuration has already been saved for routine
operations:

￭ Methods can only be loaded, but not modified or created.
￭ Determinations cannot be recalculated.

You can readjust this standard configuration by disabling additional func-
tions or re-enabling disabled functions.

NOTICE

The configuration of the routine dialog applies for all routine users. You
also have the option of defining user-specific routine settings. To do
this, you must work with the login function activated and create an
identification profile for each user (see chapter 7.3.2, page 47).

Proceed as follows to modify the configuration for the routine dialog:

 

1 Opening the dialog

Tap on the [Routine dialog] button.

The list of all buttons in the main dialog, in the manual control, etc. is
displayed:
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2 Deactivate buttons

Deactivate those buttons which are not permitted to be used.

All deactivated buttons will appear grayed-out, i.e. they are inactive.

 

3 Deactivate other functions

Many additional buttons and parameters can be disabled in the dia-
logs of [System], [Load method], [Control], [Edit parameters]
and [Results]. The corresponding option must be activated in order
to enable these buttons.

 

4 Saving the settings

Tap on the fixed keys [ ] or [ ].

All deactivated functions will appear grayed-out, i.e. they are inac-
tive.

7.3 User administration

Main dialog: System ▶ System settings ▶ User admin.

All of the functions of the user administration are described in this chap-
ter. No user administration is mandatory for the simple operation of a
titration system. If, however, you wish to be in compliance with FDA Guid-
ance 21 CFR Part 11, then you must use the functions of the user adminis-
tration. Additional information regarding the requirements of the FDA
Guidance can be found in the document Compliance Guide Touch Con-
trol.

NOTICE

If you work with the login function activated, then the user administra-
tion is accessible only for users with administrator rights. This means
that you must ensure that at least two users have administrator rights
so at least one of them will be available. Keep the access rights for a
user with administrator rights in a safe place so that they are accessible
in an emergency.
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The following data is displayed in the user list for each user:

￭ Name
￭ Dialog mode in which the user may operate the system.
￭ Status

You can use the user list two different ways:

￭ Operation with login function:
If you work with the login function activated, i.e. if each user must log
into the system before starting work, then only those users entered in
the list can log in. The user who is currently logged in is shown in the
main dialog.

￭ Operation without login function:
If you work without the login function, the users whose names are
entered in the list can be selected in the main dialog or a user name
can be entered. This makes it possible to document who has operated
the titration system.

[Login options]

Define the settings for the login, Audit Trail, etc. (see chapter 7.3.3, page
48).

[Create ID profile]

Create an identification profile for the selected user on a storage medium
(see chapter 7.3.2, page 47).

[New]

Adding a new user to the list (see chapter 7.3.1, page 44).

[Delete]

Delete the selected user from the list.
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NOTICE

Once users have worked with the login function and password protec-
tion, they can no longer be deleted, even if the password protection is
disabled again. The status of these users must be set to inactive
(requirement of FDA Guidance 21 CFR Part 11).

The last user with administrator rights cannot be deleted.

[Edit]

Editing the data of the selected user (see chapter 7.3.1, page 44).

7.3.1 Editing the user configuration
User list: User ▶ New / Edit

User

The designation of the user is used for unambiguous identification, e.g.
the company internal shorthand symbol or the personal number. The user
name is printed out in all reports containing determination data and
stored in the determination file. Each file always contains the name of the
user who created it and the name of the last user to edit it.

Entry 24 characters maximum
Default value empty

Full name

Complete name of the user.

Entry 24 characters maximum
Default value empty
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Dialog

Dialog mode in which the user may operate the system.

Selection Expert dialog | Routine dialog

Expert dialog
All functions that are supported by the system are available.

Routine dialog
The user dialog can be limited for routine operations. Only selected
functions are available (see Configuring the routine dialog, page 41).

Status

Status of the user. Users can be deactivated. This function is useful, for
instance, if the user is no longer authorized to operate the system or no
longer works for the company.

Selection active | inactive
Default value active

active
The user is authorized to operate the system.

inactive
The user is not authorized to operate the system and can no longer log
in.

Admin. rights

on | off (Default value: off)

If this option is activated, then the user has administrator rights.

NOTICE

The last user with administrator rights cannot be deleted anymore.

[Favorites]

Saving methods and sample tables as user-specific favorites (see chapter
18, page 155).

[Signature method]

Assign the permission to use and sign methods (see ""Edit user / Signature
method" dialog", page 45).

[Signature determ.]

Assign the permission to use and sign determinations (see ""Edit user /
Signature determination" dialog", page 46).

"Edit user / Signature method" dialog

User: Edit ▶ Signature method
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Authorizations for using and signing methods can be defined in this dia-
log. These settings are only effective if you are working with the login
function enabled and password protection.

Use only released methods

on | off (Default value: off)

If this option is activated, then the user may only start methods that have
been released.

Review methods (signature level 1)

on | off (Default value: off)

If this option is activated, then the user may only sign methods which
have the status saved. The method is assigned the status reviewed.

Release methods (signature level 2)

on | off (Default value: off)

If this option is activated, then the user may only sign methods which
have the status reviewed. The method is assigned the status released.

NOTICE

If the two options Review methods and Release methods are
selected for a user, then this user can sign different methods at either
level 1 or level 2, but not the same method at both level 1 and level 2.

Delete signatures

on | off (Default value: off)

If this option is activated, then the user may delete the signatures of a
method which has been released. The method is assigned the status
saved. The signatures of a method can only be deleted if it has the status
released.

"Edit user / Signature determination" dialog

User: Edit ▶ Signature determ.

Authorizations for signing determinations can be defined in this dialog.
These settings are only effective if you are working with the login function
enabled and password protection.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 7 System settings

917 Coulometer ￭￭￭￭￭￭￭￭ 47

Review determinations (signature level 1)

on | off (Default value: off)

If this option is activated, then the user may only sign determinations at
the first level. The determination is assigned the status reviewed.

Release determinations (signature level 2)

on | off (Default value: off)

If this option is activated, then the user may only sign determinations at
the second level. The determination is assigned the status released.

Delete signatures

on | off (Default value: off)

If this option is activated, then the user may delete the signatures of a
determination which has been released. The signatures of a determination
can only be deleted if it has the status released.

7.3.2 Creating an identification profile
User list: User ▶ Create ID profile

If you plan to carry out the login with an identification profile (see chapter
7.3.3, page 48), then you must first create an identification profile on a
storage medium for each user. A check can then be made at the time of
login as to whether or not the user does exist and whether or not he or
she is working in the expert dialog or in the routine dialog. After a suc-
cessful login the routine dialog settings stored on the card are loaded.

NOTICE

In addition to the user name, the current routine dialog settings are also
stored in this identification profile. This means you can define user-spe-
cific routine dialog settings for each user. However, you must configure
them (see "Configuring the routine dialog", page 41), before you cre-
ate the identification profile.

Before you create the identification profile, check whether the desired rou-
tine dialog settings are active.

 

1 Plug in a storage medium

Plug in the USB storage medium.

 

2 Select a user

In the user list, select the user for whom the profile is to be created.
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3 Create the identification profile

Tap on [Create ID profile].

The user configuration and the current routine dialog settings are
saved.

7.3.3 Defining login options
Main dialog: System ▶ System settings ▶ User admin. ▶ Login
options

There are a number of different ways to log onto the system:

￭ Without login
￭ Login via user name
￭ Login via user name and password
￭ Login via identification profile
￭ Login via identification profile and password

NOTICE

If you work with the login function activated, then the user administra-
tion is accessible only for users with administrator rights. This means
that you must ensure that at least two users have administrator rights
so at least one of them will be available. Keep the access rights for a
user with administrator rights in a safe place so that they are accessible
in an emergency.

NOTICE

If you exit this dialog with [ ] or [ ], and if you have selected one
of the login variants Login via user name or Login via identifica-
tion profile, then the login dialog will open automatically and you
must also log in to the system.

This means that you must make sure that you have first defined all the
users and created the identification profiles before you activate the
login function.
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Login via user name

on | off (Default value: off)

If this option is activated, then the user must log in with his or her unam-
biguous identification.

Login via identification profile

on | off (Default value: off)

If this option is activated, then the login will take place via USB storage
medium with the identification profile stored on it.

Password required

on | off (Default value: off)

If this option is activated, then the user must enter a password in addition
to his or her user name or identification profile.

Logout automatically

on | off (Default value: off)

If this option is activated, then the user will be logged out automatically
after the specified time.

Input range 1 to 60 min

Login only for the same user

on | off (Default value: off)

If this option is activated, then only the same user may log in again after
he or she has logged out. Users with administrator rights can, however,
log in at any time.

[Audit Trail]

Define the settings for recording an Audit Trail (see chapter 7.3.7, page
53).
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[Reasons]

Predefining a list of reasons which can be selected for the modification/
signature of a method or determination (see chapter 7.3.6, page 52).

[Modific. options]

Defining the modifications for which a reason is required (see chapter
7.3.5, page 52).

[Password options]

Define the settings for the password, see following chapter.

7.3.4 Password options
Main dialog: System ▶ System settings ▶ User admin. ▶ Login
options ▶ Password options

You can make various settings for password entry in the password
options.

Minimum password length

Minimum number of characters of the passwords.

Input range 1 to 10 
Default value 1 

No. of entry attempts

If the user has logged in incorrectly this many times, then it will automat-
ically be deactivated. It can only be reactivated by a user with administra-
tor rights.

Input range 2 to 5 
Selection off
Default value off
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Special characters required

on | off (Default value: off)

If this option is activated, then the password must contain one of the fol-
lowing special characters: ° § + ¦ @ * # ç % & ¬ ( ) = ' ^ ` ~ ] [ } { - _ : . ; , >
< £ !

Password expires

on | off (Default value: off)

If this option is activated, then the user must define a new password after
the time specified. A password that has already been used cannot be used
again.

Input range 1 to 999 days
Default value 365 days

Forgotten password

CAUTION

If a user has forgotten his password, a new user name must be defined.
The same user name can only be used again after a re-installation and
re-creating the user list.

Proceed as follows:

 

1 Create a backup

Create a backup (see chapter 11.3, page 97).

 

2 Executing a system initialization

Switch off the Coulometer and execute a system initialization (see
chapter 29.1, page 302).

 

3 Restore backed-up data

Use the function Restore to reload the data from the backup into
your system (see chapter 11.3.1, page 97).

Deactivate the options User list and System settings / User
admin..

 

4 Switch on the Coulometer

Switch the Coulometer back on again after a few seconds.
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5 Restore the user list

Create the user list again and redefine the login options.

7.3.5 Modification options
Main dialog: System ▶ System settings ▶ User admin. ▶ Login
options ▶ Modific. options

In the dialog Login options / Modification options, you can define for
which actions a reason must be entered. These reasons are documented
in the Audit Trail (see chapter 7.3.7, page 53) together with the modifi-
cation. The reason for the last modification is shown in the properties of
the method or determination.

NOTICE

The reasons are only requested when working with activated login
function and password.

Saving modified method

on | off (Default value: off)

If this option is activated, then a reason must be given when saving a
method modification.

Recalculating determination

on | off (Default value: off)

If this option is activated, then a reason must be given when determina-
tions are being recalculated.

7.3.6 Reasons
Main dialog: System ▶ System settings ▶ User admin. ▶ Login
options ▶ Reasons

In the dialog Login options / Reasons, you can create a selection list
containing reasons from which a selection can be made when signing and
modifying methods and determinations. Some reasons have already been
provided.
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[New]

Add a new reason to the list.

[Delete]

Delete the selected reason from the list.

[Edit]

Change the designation of the selected reason.

7.3.7 Audit Trail
Main dialog: System ▶ System settings ▶ User admin. ▶ Login
options ▶ Audit Trail

An Audit Trail is an automatically generated log of all user activities. An
Audit Trail contains precise logs of user actions (date, time, user, action,
etc.). Recording an Audit Trail is important for compliance with FDA Guid-
ance 21 CFR Part 11 when using PC programs. A step-by-step description
of how you must proceed to remain in compliance with the FDA Guidance
is included in the document Compliance Guide Touch Control. The Audit
Trail is saved to the internal memory.

You can also use the Audit Trail function specifically to record the data
which are of interest to you.

You can view, filter and export the Audit Trail on a PC with the supplied
software program AuditTrailViewer. Details concerning utilization of the
AuditTrailViewer can be found in the Appendix (chapter 31.6, page 314).

If necessary, you can delete all of the entries in the Audit Trail with
[Delete Audit Trail]. Do not fail to create a backup before doing so,
however.
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Security log

on | off (Default value: off)

If this option is activated, then the following events will be recorded: user
login/logout, password changes, automatic deactivation of users and mes-
sages displayed during the login procedure.

User administration log

on | off (Default value: off)

If this option is activated, then all changes with respect to user administra-
tion will be recorded (modifying user list/user data, changing login
options, etc.).

Method log

on | off (Default value: off)

If this option is activated, then all changes with respect to methods and
determinations will be recorded (saving, deleting, renaming, copying and
loading methods; editing method parameters; starting, stopping, pausing
determinations).

Data log

on | off (Default value: off)

If this option is activated, then the following events will be recorded:
changing sample data; settings in the Control dialog, recalculating deter-
minations, changing statistics data, changing the titer/concentration of a
titrant, changing the calibration data of a sensor, changing the value of a
common variable.

System log

on | off (Default value: off)

If this option is activated, then the program start and the displayed mes-
sages of the following types will be recorded:

￭ : General warning messages

￭ : Error messages
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7.4 Measured value display

Main dialog: System ▶ System settings ▶ Meas. value display

This setting refers exclusively to the display of the measured values in the
live display and in the manual control. The values will, however, always be
stored with their full accuracy.

7.5 Acoustic signals

Main dialog: System ▶ System settings ▶ Acoustic signals

You can define acoustic signals in order to direct attention to particular
events. You can define signals for the following events:

￭ Wrong manipulation
An acoustic signal will sound each time an invalid action is attempted
(e.g. pressing [ ] again when Help is open).

￭ Display a message
A short beep will sound each time a message appears on the display.
This informs the user that the message must be confirmed.

￭ Button contact
Each time a button is touched on the touch screen, this will be con-
firmed by an acoustic signal.

￭ External data input
An acoustic signal will provide confirmation each time data is received
from external devices (e.g. balance, barcode reader).
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8 Reagents

Main dialog: System ▶ Reagents

This chapter describes how you can create a list of the reagents used in
the system.

The list of reagents gives the designation and type of each reagent.

[New]

Add a new reagent to the list, see following chapter.

[Delete]

Delete the selected reagent from the list.

[Edit]

Edit the data of the selected reagent, see following chapter.

8.1 Editing reagent data

Main dialog: System ▶ Reagents ▶ New / Edit
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Reagent

The designation of the reagent is used for unambiguous identification.

Entry 24 characters maximum

Comment

Entry 24 characters maximum

[Reagent monitoring]

Set the parameters for the reagent monitoring, see following chapter.

8.2 Reagent monitoring

The conditions for the monitoring of the reagent are defined in the dialog
Edit reagent / Reagent monitoring.

If one of the following values is reached, then the reagent must be
replaced. The values are checked in the following cases:

￭ at the start of the determination.



8.2 Reagent monitoring ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

58 ￭￭￭￭￭￭￭￭ 917 Coulometer

￭ at the end of the determination.

Number of determ.

The number of determinations to be carried out with a certain amount of
reagent depends on the type of sample and its amount.

Input range 1 to 999 
Selection off
Default value off

Working life

Working life of the reagent.

Input range 1 to 999 days
Selection off
Default value off

Reagent capacity

This parameter is only visible with coulometric reagents.

Water capacity of the reagent.

Input range 1 to 9999 mg
Selection off
Default value off

Drift

This parameter is only visible with coulometric reagents.

During conditioning the measured drift has to be in the following range
for 2 min: 'specified drift value + 50 µg/min'.

Input range 1 to 999 µg/min
Selection off
Default value off

[Status]

Display the status overview of the current values of the reagent monitor-
ing.

[Reagent replacement]

Edit the parameters for the reagent exchange.

"Reagent monitoring / Status" dialog

The current reagent monitoring values are displayed in this dialog.

[Reset]

Reset the values to zero.
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Dialog "Reagent monitoring / Reagent replacement"

The parameters for the reagent replacement are defined in this dialog.

Reagent replacement

The reagent can either be exchanged manually or automatically.

Selection manual | auto
Default value manual

manual
If a monitored parameter has reached the limit set, a message is being
displayed. Then the reagent has to be exchanged manually.

auto
If a monitored parameter has reached the limit set, the method defined
below is started automatically.

Memory

This parameter can only be edited with Reagent replacement = auto.

Memory location the method is loaded from. All memory locations are
selectable, even if they are currently not accessible.

Selection Internal memory | External memory 1 | Exter-
nal memory 2 | Shared memory

Default value Internal memory

Shared memory
Shared directory in the network.

Method

This parameter can only be edited with Reagent replacement = auto.

Method used for emptying the titration cell.

NOTICE

Make sure that the memory is accessible.

Entry 32 characters maximum
Selection Selection of stored methods
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9 Sensors

Main dialog: System ▶ Sensors

This chapter describes how you can create a list of the sensors used in the
system.

Two standard sensors are defined in the sensor list: Metal electrode and
Temperature sensor. These sensors cannot be deleted or renamed. A
maximum of 25 additional sensors can be added to these sensors.

For each sensor, the following data is displayed in the sensor list:

￭ Designation
￭ Type

– Metal: Metal electrode
– Temp.: Temperature sensor
– Other: Other sensor

The following sensor data is stored in the list of sensors:

￭ Name
Each sensor in the system is identified by its unambiguous name.

￭ Working life
￭ etc.

[New]

Adding a new sensor to the list (see chapter 9.1, page 61).

[Delete]

Delete the selected sensor from the list.

[Edit]

Editing the data of the selected sensor (see chapter 9.2, page 61).
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9.1 Adding a new sensor

Before you can use a sensor, you must add it to the sensor list. To do this,
use the button [New].

￭ The properties dialog is opened after the sensor type has been
selected, see following chapter. The following sensor types can be
selected:

– Metal electrode (Pt electrode)
– Other sensor
– Temperature sensor

9.2 Editing the sensor data

Sensor list: Sensor ▶ New / Edit

All of the data for the selected sensor is displayed in the dialog Sensors /
Edit.

Sensor

The designation of the sensor is used for unambiguous identification.

Entry 24 characters maximum

Order number

Order number of the sensor.

Entry 24 characters maximum
Default value empty

Serial number

Serial number of the sensor.
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Entry 8 digits maximum

Comment

Entry 24 characters maximum

[Working life]

Defining the working life of the sensor (see chapter 9.3, page 62).

9.3 Monitoring the working life

Sensor: Edit ▶ Working life

In the dialog Edit sensor / Working life, you can define the time inter-
val after which the sensor must be replaced. If you do not wish to monitor
the working life, then you can enter only the date of manufacture for doc-
umentation purposes.

Start-up

Date on which the sensor was used for the first time.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the working life will be monitored.

Working life

If you define a time interval for the working life, then the Expiry date will
be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Expiry date

If you define an expiry date, then the Working life will be tracked auto-
matically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.
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Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.
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10 Device manager

Main dialog: System ▶ Device manager

This chapter describes how you can configure the Coulometer and the
connected peripheral devices. A detailed description of the hardware
installation can be found in the corresponding installation manual.

The instrument list gives the name and type of every instrument. The Ti-
Touch titrator is a component of the 917 Coulometer and therefore per-
manently entered as control instrument in the device manager. If an 885
Compact Oven SC is connected and switched on, it is automatically
entered in the list. Peripheral devices (dosing devices, stirrers, etc.)
connected to the MSB connector are entered in the list automatically. A
USB/RS-232 adapter will also be automatically recognized and entered in
the instrument list with default settings. A printer is entered in the instru-
ment list in the default settings. You must enter a PC keyboard, a barcode
reader or a balance in the instrument list yourself.

[New]

Add a new device to the list (see chapter 10.1, page 65).

[Delete]

Delete the selected device from the list.

NOTICE

Devices which are recognized automatically cannot be deleted from the
list while they are still connected.

[Edit]

Configure the selected device (see chapter 10.2, page 65).
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10.1 Adding a new device

Of the following device types, you can enter one device each in the device
list, even if it is not yet connected:

￭ Sample Processor
￭ Balance
￭ Barcode reader
￭ USB/RS-232 adapter
￭ PC keyboard

Proceed as follows:

 

1 Displaying the device selection

Tap on [New].

 

2 Selecting the instrument

Tap on the button for the desired device.

The new device is entered in the list.

10.2 Configuring the instrument

Instrument list: Instrument ▶ Edit

The data stored for an instrument depends on the type of instrument. You
can define an instrument name and a comment for each instrument. The
instrument name of the Coulometer is printed out in the standard report
header.

The description of the individual instruments can be found in the follow-
ing specific chapters:

￭ Coulometer (see chapter 10.3, page 66)
￭ Metrohm control instruments (see chapter 10.4, page 72)
￭ 885 Compact Oven SC (see chapter 10.5, page 75)
￭ Printer (see chapter 10.6, page 79)
￭ Balance (see chapter 10.7, page 83)
￭ PC keyboard (see chapter 10.9, page 87)
￭ USB/RS-232 adapter (see chapter 10.8, page 85)
￭ Barcode reader (see chapter 10.10, page 88)
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10.3 Coulometer

Instrument list: 917 Coulometer ▶ Edit

Device name

This designation is used for identification purposes when selecting control
devices (command, manual control).

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Switch off display

If this time interval has expired without the Coulometer having been oper-
ated, then the display will be switched off. Touching the display will switch
it back on again at any time.

Input range 1 to 999 min
Selection off
Default value off

Program version

Program version of the software.

Serial number

Shows the serial number of the device.

Control Remote Box

Shows to which control device and MSB connector the Remote Box is
connected.
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The "Control Remote Box" is the interface via which the system can be
started and stopped externally. If multiple Remote Boxes are connected,
then the one that is recognized first when the program starts will be used
as the "Control Remote Box."

Selection Name of the control device / Number of the
MSB connector | Not available

10.3.1 E-mail
917 Coulometer: Edit ▶ E-mail

The system allows you to send displayed messages as e-mails. The Coul-
ometer must be connected to a network for this to function. The follow-
ing types of messages can be sent:

￭ : general warning messages

￭ : error messages

Configuring e-mail dispatch

Proceed as follows so that messages can be sent as e-mails:

 

1 Activating the option

￭ In the instrument properties of the 917 Coulometer, tap on the
[E-mail] button.

￭ In the Edit device / E-mail dialog, activate the Send the fol-
lowing messages as e-mail: option.

 

2 Configuring e-mail addresses

￭ Tap on the [E-mail settings] button.
The E-mail / Settings dialog is displayed.

￭ Enter the addresses of the mail server, the sender and the desired
recipient.

Parameter description

Send the following messages as e-mail:

on | off (Default value: off)

If this parameter is activated, then messages with the following symbols
will be sent as e-mails:

￭ : General warning messages

￭ : Error messages
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Send only during running determination

on | off (Default value: on)

If this parameter is activated, then messages will be sent as e-mails only if
a determination is running. Deactivate this parameter if messages are also
to be sent in normal status.

Mail server

Address of the mail server for outgoing mail, e.g. mail.metrohm.ch. You
can find the address of the mail server either in your e-mail program set-
tings or obtain it from your IT department.

Entry 50 characters maximum
Default value empty

Sender

E-mail address of the sender. This address must be formatted as an e-mail
address, but need not necessarily correspond to an existing e-mail
account, e.g. coulometer@metrohm.com.

Entry 50 characters maximum
Default value empty

Recipient

The messages will be sent to this e-mail address.

Entry 50 characters maximum
Default value empty

10.3.2 PC/LIMS report
917 Coulometer: Edit ▶ PC/LIMS report

You can generate a machine-readable report with all of the important
data concerning a determination, which is referred to as a PC/LIMS report.
This report can be saved as a TXT file (according to ISO/IEC 8859-1) or as a
UTF-8 file or sent to a terminal program or a LIMS via an RS-232 interface:

￭ manually with the [ ] fixed key (see chapter 26, page 205).
￭ automatically at the end of a determination (see chapter 15.5.6, page

146).

The file name of the report file is constructed as follows: PC_LIMS_Report-
ID1-YYYYMMDD-hhmmss.txt. A detailed description of the contents of
the PC/LIMS report can be found in the PC/LIMS Report Guide.

Memory

Memory location where the PC/LIMS report is stored as a file. The report
will be saved in the directory pc_lims_report. This directory will be created
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the first time a PC/LIMS report is generated. All three memory locations
are listed as possible selections, even if they cannot be accessed at the
moment.

Selection off | External memory 1 | External memory 2 |
 Shared memory

Default value off

off
The report will not be saved as a file.

Shared memory
The report will be saved in a shared directory on the network. The
shared directory is selected in the Edit device / Shared memory dia-
log (see chapter 10.3.3, page 69).

RS-232

The RS-232 interface via which the PC/LIMS report is sent. The interface
parameters are adjusted in the Edit device / Port parameters dialog
(see chapter 10.8, page 85).

Selection off | COM 1 | COM 2
Default value off

off
The report will not be sent via an RS-232 interface.

COM 2
This interface is inactive.

Coding

Format in which the PC/LIMS report is coded and stored.

Selection ISO 8859-1 | UTF-8
Default value ISO 8859-1

ISO 8859-1
This format is recommended for all languages that use the extended
ASCII code (e.g. German, English, Spanish, etc.).

UTF-8
This format is required for all languages that do not use the extended
ASCII code (e.g. Russian, Chinese, Korean, etc.).

10.3.3 Shared memory
917 Coulometer: Edit ▶ Shared memory

If you have your Coulometer connected to your network, then you can
define in this dialog a shared memory location on a computer within your
network for the purpose of saving data (methods, determinations, etc.).
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CAUTION

If the computer on which you share a memory location does not have
the same subnet as the Coulometer, then a WINS server must be pres-
ent. The computer must be entered in this server. In order for the com-
munication to work, the SMB protocol version 1 (SMBv1) must be acti-
vated. Since this function is not standard anymore in Windows 10, it
has to be activated manually. From firmware version 5.917.0024, the
SMB protocol version 2 and 3 is also supported.

Computer

Host name of the computer on which a memory location is to be shared.
If you are working with Windows, then you will find the host name of the
computer as follows: In the Windows command prompt window, enter
the command ipconfig -all. The host name is listed together with other
parameters of the computer.

Do not under any circumstances enter an IP address in this input field.

Entry max. 32 characters
Default value empty

Share name

Share name of the shared memory location (file directory) on the above-
specified computer. Please note that the Share name of a file directory
often does not match the name of the file directory. The share name can
be found on the Release tab in the Properties dialog of the shared file
directory.

Entry max. 32 characters
Default value empty

Domain

Network domain in which the above-specified computer is located. If you
are working with Windows, then you will find the domain name as fol-
lows: In the Windows command window, enter the command ipconfig
-all. The domain is listed together with other parameters of the computer.
Leave the field empty if the computer is not located within a domain.

Entry max. 32 characters
Default value empty

User

User name of the user authorized to access the shared memory location.
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Entry max. 32 characters
Default value empty

Password

Password of the user configured on the computer.

Entry max. 32 characters
Default value empty

[Connect]

Establish the network connection. If the connection has been set up cor-
rectly, then all of the input fields will become inactive and the label
switches to [Disconnect]. The network connection can be disconnected
with this.

10.3.4 TCP/IP settings
917 Coulometer: Edit ▶ TCP/IP settings

If you have connected your Coulometer to your network, then you will
have to define the network-relevant settings in this dialog. The Coulome-
ter requires an IP address so that it is identifiable on the network. The
Coulometer can acquire the IP address either dynamically from a DHCP
server or you can enter the address directly.

Get IP address automatically (DHCP)

on | off (Default value: on)

If this parameter is activated, then the Coulometer will obtain its IP
address directly from a DHCP server. In this case, the remaining parame-
ters can no longer be edited.

IP address

IP address for the Coulometer. IP addresses are 32-bit numbers and are
written as sequences of four decimals, each separated by a period, e.g.
"10.157.212.8".

Entry x.x.x.x
Default value 192.168.10.11

"x" is a decimal between 0 and 255.

Subnet mask

The net mask or subnet mask, together with the IP address, indicates to
which network the device to be connected belongs. Subnet masks are 32-
bit numbers and are written as sequences of four decimals, each separa-
ted by a period.

Entry x.x.x.x
Default value 255.255.255.0
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Default gateway

IP address for the standard gateway. A gateway sets up connections to
several networks. It is located in the same subnet as the device to be con-
figured.

Entry x.x.x.x
Default value 192.168.10.10

MAC address

Unambiguous address of the network adaptor for identification within a
network. This parameter cannot be edited.

NetBIOS name

Unambiguous designation of the device within the network. This parame-
ter cannot be edited.

10.4 Metrohm control instruments

The following Metrohm devices can be used as control instruments:

￭ Ti-Touch Titrator (permanently entered as control instrument in the
device manager)

The following specifications apply for all of the control instruments men-
tioned above.

The dialog shows the control instrument with its measuring inputs, the
MSB connectors and connected peripheral devices (dosing device, stirrer,
Remote Box).

[Properties]

Open the properties dialog of the highlighted entry.

The following properties can be displayed and edited to a certain extent:
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￭ Properties of the measuring inputs (see chapter 10.4.1, page 73)
￭ Properties of the MSB connectors (see chapter 10.4.2, page 74)
￭ Properties of the peripheral devices on the MSB connector (see chapter

10.4.3, page 75)

10.4.1 Properties – Measuring input
Instrument list: Control instrument ▶ Edit ▶ Measuring input
1 ▶ Properties

In this dialog, you define the type of temperature sensor you have
connected to the selected measuring input.

ADC type

Type of analog-digital converter.

Serial number

Serial number of the measuring interface.

Thick film type

Type of the thick film.

Temperature sensor

Type

The instrument supports the use of two different temperature measure-
ment techniques:

￭ NTC (Negative Temperature Coefficient)
￭ Pt1000 (Platinum resistance)

Select here the type that has been connected to the instrument. If an NTC
sensor is used, then it is also necessary to enter two sensor characteristics.
These characteristics are listed in the specifications of the sensor.
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Selection Pt1000 | NTC
Default value Pt1000

R (25 °C)

This parameter can only be edited with Type = NTC.

Nominal resistance of the NTC sensor at 25 °C.

Input range 1000 to 99999 ohm
Default value 30000 ohm

The default value applies to Metrohm sensors with
an NTC sensor.

B value

This parameter can only be edited with Type = NTC.

Material constant of the NTC sensor. B values of NTC sensors are fre-
quently based on different reference temperatures (usually 25 °C and
50…100 °C). When entering the B value the influence of the second ref-
erence temperature is negligible in comparison with the measuring accu-
racy of an NTC sensor.

Input range 1000 to 9999 K
Default value 4100 K

The default value applies to Metrohm sensors with
an NTC sensor. If no B value is given for your sensor
then you can retain the default value.

10.4.2 Properties – MSB connector
Instrument list: Control instrument ▶ Edit ▶ MSB connector
1/2 ▶ Properties

In this dialog, you can define when the request to carry out the Prepare
function for connected dosing devices is to be displayed. This setting
applies for all dosing devices of the selected MSB connector. The manual
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control contains a description of how to prepare the exchange unit and/or
the dosing unit (see chapter 27.3.3, page 221).

Switch on

on | off (Default value: on)

If this parameter is activated, then you will be requested to prepare the
dosing device when the Coulometer is switched on.

Attach an exchange or dosing unit

on | off (Default value: on)

If this parameter is activated, then you will be requested to prepare the
dosing device when the exchange/dosing unit is attached.

Time interval

on | off (Default value: off)

Activate this parameter if you wish to receive a regular request to prepare
the dosing unit.

Input range 0.1 to 999.9 h
Default value 12.0 h

10.4.3 Properties – Peripheral devices
Instrument list: Control instrument ▶ Edit ▶ Peripheral
device ▶ Properties

The following data is displayed for the connected dosing devices and stir-
rers:

￭ Type
￭ Serial number

10.5 885 Compact Oven SC 

NOTICE

In order for the 885 Compact Oven SC to be controlled with the
917 Coulometer, at least the following firmware versions must be
installed on the instruments:

￭ 917 Coulometer 5.917.0025
￭ 885 Compact Oven SC 5.885.0013
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The dialog displays the 885 Compact Oven SC with its tower and the oven
module. If the control instrument is not connected, then the properties
dialog of the control instrument will be displayed directly (see chapter
10.5.1, page 76).

Properties

Open the Properties dialog of the highlighted entry.

10.5.1 Properties - 885 Compact Oven SC
Instrument list: 885 Compact Oven SC ▶ Edit ▶ Properties

Device name

This designation is used for identification purposes when selecting control
instruments (command, manual control).

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Program version

Program version of the device software.

Serial number

Display of the serial number of the device.
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10.5.2 Properties - Tower
Instrument list: 885 Compact Oven SC ▶ Edit ▶ Tower ▶ Properties

Sample beaker

Work position

At this lift position, the sample beaker is optimally placed in the oven and
the needle has completely pierced the septum.

Input range 0 to 96 mm (Increment: 6)
Default value 78 mm

A lift height of 0 mm corresponds to the "home position". The lift is
located at the upper stop position.

Conditioning beaker (special beaker 1)

Work position

At this lift position, the needle has completely pierced the septum of the
conditioning beaker at the conditioning position. In the method run, the
[MOVE] command is used to move the conditioning bucket with the
Objective Special beaker 1.

Input range 0 to 96 mm (Increment: 6)
Default value 36 mm

A lift height of 0 mm corresponds to the "home position". The lift is
located at the upper stop position.
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10.5.3 Properties - Oven module
Instrument list: 885 Compact Oven SC ▶ Edit ▶ Oven mod-
ule ▶ Properties

Program version

Program version of the oven module.

Serial number

Display of the serial number of the oven module.

Initial temperature

Entering an initial temperature means that the oven will heat up to the set
temperature when the 917 Coulometer is switched on.

Input range 50 to 250 °C (Increment: 1)
Default value 110 °C
Selection off

off
The oven is not switched on.

Action when switching off the touch device.

Switch off heater

Setting for the behavior of the heater of the oven module when the Coul-
ometer is switched off.

Selection on | off
Default value on

Switch off the gas flow

Setting for the behavior of the gas flow of the oven module when the
Coulometer is switched off.
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Selection on | off
Default value on

10.6 Printer

Instrument list: Printer ▶ Edit

The list of devices always includes a printer, even if no corresponding
device is connected. In this dialog, you also define when you would like to
have a report generated as a PDF file.

Device name

Here you can enter a device name of your choice.

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Printer

Selection of the printer type.

Selection PCL Inkjet | PCL Laser | HP | Epson | Epson
new | Canon | CUSTOM NEOS | off

PCL Inkjet
for HP DeskJet printers.

PCL Laser
for HP LaserJet printers.

CUSTOM NEOS
Due to the narrow paper size, only reports marked with # in the "List
of all printable reports" (see chapter 26.3, page 209) can be printed.
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off
The reports will not be printed out on paper.

Connector

Selection of the connection type for the printer.

Selection USB | Ethernet
Default value USB

USB
Local printer at a USB interface.

Ethernet
Network printer.

NOTICE

The Coulometer prints the reports with a fixed resolution of 300 dpi. If
you are using a printer with a resolution of 360 dpi (or a multiple
thereof, e.g. an Epson), then the text will be printed out somewhat
smaller than with printers with a resolution of 300 dpi (or a multiple
thereof, e.g. a Canon or HP).

10.6.1 PDF settings
Printer: Edit ▶ PDF settings

The settings for saving a report as a PDF file are defined in this dialog.

Memory

Memory location where the PDF file will be saved. The report will be saved
in the directory PDF_Report. This directory is created when a PDF file is
generated. The file name is appended with the date and time when the
determination was started and the date and time when the PDF was gen-
erated (e.g.: Identification 1-20130320-141044-20130320-141220).
The first date and time set indicates the start of the determination, the
second date and time set indicates the generation of the PDF file. This pre-
vents previously created PDF files from being overwritten each time a new
file is created, e.g. when a result is recalculated and the report is gener-
ated again.

All three memory locations are listed as possible selections, even if they
cannot be accessed at the moment.

Selection off | External memory 1 | External memory 2 |
 Shared memory

Default value off

off
The report will not be saved as a PDF file.
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Shared memory
The report will be saved in a shared directory on the network. The
shared directory is selected in the Edit device / Shared memory dia-
log (see chapter 10.3.3, page 69).

Copy or extract content allowed

on | off (Default value: on)

If this option is activated, then content can be copied or deleted from the
PDF file.

Printing allowed

on | off (Default value: on)

If this option is activated, then the PDF file can be printed.

Change the document allowed

on | off (Default value: off)

If this option is activated, then the PDF file can be edited.

Add or change comments allowed

on | off (Default value: on)

If this option is activated, then comments can be added to the PDF file.

10.6.2 Network printer
Printer: Edit ▶ Network printer

If you have connected your Coulometer to your network, then you can
specify a network printer for your reports in this dialog.

NOTICE

If you have shared a memory location on a PC within your network and
if you have configured the Coulometer accordingly (see chapter 10.3.3,
page 69), then the settings for the parameters Domain, User and
Password will be applied and can then no longer be modified in this
dialog.
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CAUTION

If the computer on which the network printer is configured does not
have the same subnet as the Coulometer, then a WINS server must be
present. The computer must be entered in this server. In order for the
communication to work, the SMB protocol version 1 (SMBv1) must be
activated. Since this function is not standard anymore in Windows 10, it
has to be activated manually. From firmware version 5.917.0024, the
SMB protocol version 2 and 3 is also supported.

Print server

Host name of the print server or the computer on which the network
printer is configured. If you are working with Windows, then you will find
the host name as follows: In the Windows command prompt window,
enter the command ipconfig -all. The host name is listed together with
other parameters of the print server or the computer.

Do not under any circumstances enter an IP address in this input field.

Entry max. 32 characters
Default value empty

Share name

Share name of the network printer on the above-specified computer.
Please note that the Share name of a network printer often does not
match the name of the printer. The share name can be found on the
Release tab in the Properties dialog of the released network printer.

Entry max. 32 characters
Default value empty

Domain

Network domain in which the above-specified computer is located. If you
are working with Windows, then you will find the domain name as fol-
lows: In the Windows command window, enter the command ipconfig
-all. The domain is listed together with other parameters of the computer.
Leave the field empty if the computer is not located within a domain.

Entry max. 32 characters
Default value empty

User

User name of the user authorized to access the shared network printer.

Entry max. 32 characters
Default value empty
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Password

Password of the user configured on the computer.

Entry max. 32 characters
Default value empty

10.6.3 More options

Paper size

Selection of the paper size.

NOTICE

The paper size selected will be ignored when the report is printed on a
CUSTOM NEOS printer.

Selection A4 (210 mm x 297 mm) | Letter (216 mm x
279 mm)

Default value A4 (210 mm x 297 mm)

Color

on | off (Default value: off)

If this option is activated, then the report will be printed out in color.

Spooler

on | off (Default value: on)

If this option is activated, then you can continue to work while the printer
is printing. If this option is deactivated, then the Coulometer will be
blocked while the printout is being produced.

10.7 Balance

List of devices: Balance ▶ Edit
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You define the type of balance and its connector in the dialog Device
manager / Edit.

Device name

Here you can enter a device name of your choice.

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Balance type

If you have connected a balance, then you have to specify the balance
type here.

Selection AND | Mettler | Mettler AT | Mettler AX |
 Ohaus | Precisa | Sartorius | Shimadzu

Default value Sartorius

RS-232

RS-232 interface to which the balance is connected. The interface
parameters are adjusted in the Edit device / Port parameters dialog
(see chapter 10.8, page 85).

Selection COM 1 | COM 2
Default value COM 1

COM 2
The interface is disabled.

The following table indicates the balance type that needs to be selected
for the balance model:
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Balance Balance type

AND AND

Mettler AB, AE, AG, AM,
AJ, PE, PM, PJ, PR, XP, XS

Mettler

Mettler AT Mettler AT

Mettler AX, MX, UMX, PG,
AB-S, PB-S

Mettler AX

Ohaus Voyager, Explorer,
Analytical Plus

Ohaus

Precisa Precisa

Sartorius Sartorius

Shimadzu BX, BW Shimadzu

10.8 USB/RS-232 adapter

Instrument list: USB/RS-232 adapter ▶ Edit ▶ COM interface ▶ Edit

As a rule, balances are equipped with a serial RS-232 interface. To connect
a balance, you will require the 6.2148.050 cable. You can adjust the inter-
face parameters in the dialog Edit device / Port parameters. These set-
tings must match the settings on the connected device.

NOTICE

If you make changes to parameter settings in this dialog, then you must
switch the Coulometer off and back on in order for the changes to take
effect.
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Baud rate

Transfer rate in characters per second.

Selection 1200 | 2400 | 4800 | 9600 | 19200 | 38400 |
 57600 | 115200

Default value 9600

Data bits

Number of data bits.

Selection 7 | 8
Default value 8

Parity

Type of parity testing.

Selection even | odd | none
Default value none

Stop bits

Number of stop bits.

Selection 1 | 2
Default value 1

Handshake

Type of data transfer protocol.

NOTICE

In case of communication problems, try the software handshake (Soft-
ware (XON/XOFF)).

Selection none | Software (XON/XOFF) | Hardware (DTR/
CTS)

Default value Hardware (DTR/CTS)

Software (XON/XOFF)
Use the software handshake when you send a PC/LIMS report via an
RS-232 interface.
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10.9 PC keyboard

Instrument list: PC keyboard ▶ Edit

A commercially available USB keyboard can be connected to make text
and numerical input easier. It will be recognized automatically and entered
in the list of devices with default settings.

Device name

Here you can enter a device name of your choice.

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Keyboard layout

Define the country-specific keyboard layout here.

Selection English US | German DE | French FR | Spanish
ES | German CH

Default value English US

To enter texts and numbers with the PC keyboard, the appropriate text
and number input dialog must be opened on the Coulometer. Only the
following keys on the PC keyboard have a function:

Table 6 Key assignment

Function in the editing dialog PC keyboard key

[Cancel] [Esc]
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Function in the editing dialog PC keyboard key

Enter respective character Numbers, letters and special char-
acters + Shift

[OK] [Enter] / [↲]

[⌫] [←] (backspace)

Line break (for multi-line text
input)

[Enter] / [↲]

The cursor is moved up or down
by one character.

[↑] [↓]

The cursor is moved to the left or
to the right by one character.

[←] [→]

[F1]

[F2]

[F3]

[F4]

[F5]

[F6]

[F7]

NOTICE

The lettering of the USB keyboard may differ from above lettering,
depending on the country-specific keyboard used.

10.10 Barcode reader

List of devices: Barcode reader ▶ Edit
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A barcode reader can be connected to read in sample data or other texts.
A connected barcode reader will be recognized automatically and entered
in the list of devices with default settings.

You will hear an acoustic signal as confirmation that a character string has
been transmitted by the barcode reader and accepted.

NOTICE

The data will be read only if the system is in normal status, i.e. when no
determination is running.

Device name

Here you can enter a device name of your choice.

Entry 24 characters maximum

Comment

Entry 24 characters maximum

Barcode input target

Selection of the input field for the character string read in by the barcode
reader.

Selection Active input field | Method | Identification 1 |
 Identification 2 | Sample size

Active input field
The character string is entered in the input field of the opened text- or
number-input dialog.

Method
The character string is entered in the input field Method.
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Identification 1
The character string is entered in the input field Identification 1.

Identification 2
The character string is entered in the input field Identification 2.

Sample size
The character string is entered in the input field Sample size. Charac-
ter strings containing characters other than numbers and decimal sepa-
rators will be ignored.

Keyboard layout

Specify the country-specific keyboard layout for the emulation of the PC
keyboard. This setting must match the setting on the barcode reader (see
documentation for the barcode reader).

Selection English US | German DE | French FR | Spanish
ES | German CH

Default value English US
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11 File manager

Main dialog: System ▶ File manager

The saved methods, determinations, sample tables, etc. are managed in
the file manager. You can also create a backup of your system (all data
and settings). Also, an existing backup can be reloaded.

The file memory is organized as follows:

￭ Internal memory
The following files can be stored in the internal memory:

– Methods
￭ External memory

You can use a USB flash drive as an auxiliary storage medium, for
instance. The following files can be stored on an external memory:

– Backup
– Methods
– Determinations
– Sample tables
– Result tables
– Reports as *.pdf
– PC/LIMS report

11.1 Managing files

File manager: Internal memory / External memory 1 / External
memory 2

The saved files can be organized into groups. These groups are compara-
ble to file directories on your PC, although unlike your PC, only one level is
possible.

NOTICE

The file names must be unique for each memory location, i.e. you can-
not save two files with the same name, even if they are in different
groups.
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NOTICE

If you use an external storage medium with the FAT or FAT32 file sys-
tem, then you can save a maximum of 999 files per group. If you find it
necessary to store more than 999 files in a single group, then you must
reformat the storage medium with the file system ExFAT (see chapter
31.7.2, page 319).

[Show all]

Display the list of all the files in the selected memory location.

[Show files]

Display the list of all the files in the selected group.

[Rename]

Rename the selected file (see chapter 11.1.2, page 93).

[Properties]

Display the file properties (see chapter 11.1.3, page 94).
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[Copy]

Copy the selected file to a different memory location (see chapter 11.1.1,
page 93).

[Delete]

Delete the selected file.

[Load]

Load the selected file.

11.1.1 Copying a file
Proceed as follows to copy a file:

 

1 Selecting the file

￭ Select the desired file.
￭ Tap on [Copy].

The selection of memory locations is displayed.

 

2 Copy the file

￭ Tap on the desired memory location.
Only memory locations currently being accessible are active.

The file is copied. The file group is retained, i.e. the group will be cre-
ated again in the new memory location if it does not already exist
there.

11.1.2 Renaming a file
Proceed as follows to rename a file:

 

1 Selecting the file

￭ Select the desired file.
￭ Tap on [Rename].

The Show files / Rename dialog is displayed.

 

2 Change the file name

￭ Tap on the input field File name.
The text editor opens.

￭ Enter a new file name (max. 32 characters) and confirm with
[OK].

￭ Tap on [OK].

The file is saved under the new name.
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11.1.3 File properties
File manager: Internal memory / External memory 1 / External
memory 2 ▶ Show all / Show files ▶ Properties

Detailed information concerning the file is displayed in the Show files /
Properties dialog. They can be edited to a certain extent.

￭ File name
Name of the file.

￭ File group
Entry or selection of the group in which the file will be saved. If you
enter a new name, then the file will be moved into the new group.

￭ Write protection
If this option is activated, then the file cannot be saved, deleted,
moved or renamed. This is only an internal write protection feature and
is independent of the write protection of the operating system on your
computer.

￭ Created by
User who saved the file initially.

￭ Created on
Date and time at which the file was saved for the first time.

￭ Last saved by
User who saved the file most recently.

￭ Last saved on
Date and time at which the file has been saved most recently. Addition-
ally, the version of the file is displayed. The version number will be
increased by one each time the file is saved.

￭ Size
File size.

￭ Program version
Program version of the software with which the file was last saved.
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11.2 External storage medium

[Backup]

Creating a backup of all data and settings on this storage medium (see
chapter 11.3, page 97).

[Restore]

Load the backup. This function is active only if a backup is available (see
chapter 11.3, page 97).

[Memory info]

Display information on the storage medium, see following chapter.

Storage medium – Information

Detailed information about the storage medium is displayed in the dialog
External memory 1/2 / Memory info:

￭ Name
Designation of the storage medium.

￭ Write protection
If this option is activated, then the file cannot be saved, deleted,
moved or renamed. This is only an internal write protection feature and
is independent of the write protection of the operating system on your
computer.

￭ Storage capacity
Total capacity of the storage medium.

￭ Used memory
Storage capacity used on the storage medium.

￭ Free memory
Free storage capacity on the storage medium.
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Directory structure

The directory structure appears as follows on the external storage
medium:

Figure 16 Directory structure on the external storage medium

Backup All of the files of the backup are stored in this
directory. The directory will be created the first
time a backup is created.

Files This directory contains all of the groups as well
as the files contained in them (methods, deter-
minations, etc.).

pc_lims_report PC/LIMS reports are stored in this directory as
TXT files. The directory will be created the first
time a PC/LIMS report is printed out.

PDF_Report PDF reports are stored in this directory. The direc-
tory will be created the first time a report is
saved as a PDF file.

Profiles The identification profile is stored in this direc-
tory. The directory will be created the first time
an identification profile is generated.

SwUpdates Files for software updates must be saved in this
directory.
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11.3 Creating backups / Restoring data

File manager: External memory 1 / External memory 2

You can use the [Backup] function to easily create a backup containing
all the data and settings of your system. You should make a backup at
regular intervals in order to avoid data loss.

NOTICE

Only one backup can be created on a storage medium.

If a backup has already been stored on the medium, then it will be
overwritten when this function is carried out again.

11.3.1 Restoring data
You can use the function [Restore] to restore either a complete backup
or only certain data.

CAUTION

All of the methods in the internal memory will be deleted.

Backups are not backward compatible, i.e. backups of the latest version
cannot be restored using earlier versions.

Proceed as follows to restore backed-up data:

 

1 Select the storage medium

￭ Connect the storage medium on which the backup is located.
￭ Select the storage medium under System ▶ File manager.

 

2 Select data

￭ Tap on [Backup].
The selection of the data that can be restored separately is dis-
played (see the following).

￭ Deselect the data sets which are not to be restored.
￭ Tap on [Load data].

The selected data blocks are restored.

 

3 Complete the restoration

￭ Switch the Coulometer off and on again.
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Restorable data blocks

The following data blocks can be loaded individually:

￭ Methods
All of the methods stored in the internal memory.

￭ Sample table
Current sample table.

￭ Result table
Current result table.

￭ Current determination data
All the data for the current determination (including the method with
which the determination was carried out).

￭ Control
Settings in the control dialog.

￭ User list
Settings for each user under System settings / User administra-
tion.

￭ System settings / User admin.
￭ Titrants

All titrants with all their data.
￭ Sensors

All sensors with all their data.
￭ Device data

All of the devices configured in the device manager, with all of the
data.

￭ GLP data
All data from the GLP manager.
Deactivate if the backup is to be loaded onto a different system.

￭ Common variables
All common variables.

￭ Templates
￭ Routine dialog settings

Current routine dialog settings (see Dialog options / Routine dia-
log).

￭ Sample racks
The sample racks present in the properties of the USB sample pro-
cessor.

￭ Own subsequences
All subsequences created and stored by the user.
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12 GLP manager

Main dialog: System ▶ GLP manager

In the GLP manager you can document data for various GLP tests. The
results of the automatic system tests carried out after switching on are
also documented.

The following tests can be documented:

￭ GLP test "Measurement" (see chapter 12.3, page 101)
￭ GLP test "Titration" (see chapter 12.3, page 101)
￭ System validation (see chapter 12.4, page 105)

In addition, you can also:

￭ Create a list with your test tools (see chapter 12.2, page 100).
￭ Define a service interval for having routine maintenance carried out by

a Metrohm service technician (see chapter 12.5, page 109).
￭ Define an interval for the regular performance of backups (see chapter

12.5, page 109).

Further information about quality management and validation is also given
in the documentation series Quality Management with Metrohm and
Application Bulletin AB 255 (Validation of Metrohm Karl Fischer titra-
tors in accordance with GLP/ISO 9001).

The table shows the last time that each test was carried out and when the
next test is to be carried out. A test is entered in the list the first time that
it is documented.

[Test tools]

Configuring the test tools for GLP tests (see chapter 12.2, page 100).
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[GLP tests HW/SW]

Document the GLP tests "Measurement" and "Titration" (see chapter
12.3, page 101).

[System validation]

Document the system validation (see chapter 12.4, page 105).

[Monitoring]

Defining the time intervals for system maintenance and backups (see
chapter 12.5, page 109).

[View test data]

Display the data of the selected test.

12.1 Automatic system test

The system test is carried out automatically when the Coulometer is
switched on. The result of each individual test is shown in green if no error
has occurred. If a result is shown in red, then an error occurred when the
respective test was carried out. Switch the Coulometer off and back on
again. If the error still occurs pleased notify Metrohm Service.

Print report at system start

on | off (Default value: off)

If this parameter is activated, then the result of the system test will be
printed out automatically when the Coulometer is switched on.

12.2 Test tools

Main dialog: System ▶ GLP manager ▶ Test tools

You can create a list of test tools to be used in the tests in the GLP man-
ager.

The following test tools have already been defined:

￭ 767 Calibrated Reference: Device for checking measuring inputs
and electrode cable.

￭ 822 Titr.Curve Simulator: Curve simulator for checking the hard-
ware and software.

￭ 773 pH/mV Simulator: Device for checking measuring inputs and
electrode cable.

￭ 868 UR Generator: Device for checking measuring inputs and elec-
trode cable.

[New]

Add a new test tool to the list.
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[Delete]

Delete the selected test tool from the list.

[Edit]

Change the designation of the selected test tool.

12.3 GLP tests for measurement and titration

Main dialog: System ▶ GLP manager ▶ GLP tests HW/SW ▶ GLP
test "Measurement" / GLP test "Titration"

You can document the GLP tests for measurements and titrations in the
dialog GLP manager / GLP tests Hardware/Software and its subdia-
logs. The following procedure describes the GLP test "Measurement," but
also applies for the GLP test "Titration".

Proceed as follows:

 

1 Open the properties dialog

￭ In the System / GLP manager dialog, tap on the [GLP tests
HW/SW] button and then on the [GLP test "Measurement"]
button.

 

2 Edit data

￭ Define the test method, the test results, etc. (see "Dialogs "GLP
tests HW/SW / GLP test "Measurement"" and "GLP tests HW/SW /
GLP test "Titration""", page 102).

 

3 Define the hardware used

￭ Tap on [Hardware].
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￭ Select the hardware used for the test (see "Dialogs "GLP test
"Measurement" / Hardware" and "GLP test "Titration" / Hard-
ware"", page 104).

￭ Tap on the fixed key [ ].

The dialog GLP tests HW/SW / GLP test "Measurement"
appears again.

 

4 Define the test interval

￭ Tap on [GLP test interval].
￭ Enter the time interval or the date for the next GLP test (see "Dia-

logs "GLP test "Measurement" / Test interval" and "GLP test
"Titration" / Test interval"", page 103).

￭ Tap on the fixed key [ ].

12.3.1 Parameter description

Dialogs "GLP tests HW/SW / GLP test "Measurement"" and
"GLP tests HW/SW / GLP test "Titration""

Method

Method the GLP test has been carried out with.

Entry 32 characters maximum
Selection Selection of methods stored in the internal

memory

User

User who carried out the GLP test.

Entry 24 characters maximum
Selection Selection of configured users

Test date

Date on which the GLP was carried out.

Format: YYYY:MM:DD

Test result

Result of the test.

Selection Test OK | Test not OK
Default value Test OK

Comment

Entry 24 characters maximum
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[GLP test interval]

Defining the time interval for the GLP test (see "Dialogs "GLP test
"Measurement" / Test interval" and "GLP test "Titration" / Test interval"",
page 103).

[Hardware]

Documenting the hardware with which the GLP test was carried out (see
"Dialogs "GLP test "Measurement" / Hardware" and "GLP test "Titra-
tion" / Hardware"", page 104).

Dialogs "GLP test "Measurement" / Test interval" and "GLP
test "Titration" / Test interval"

Test date

Date on which the GLP was carried out.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which a GLP test
has to be carried out again will be monitored.

GLP test interval

If you define a time interval for the GLP test, then the date in Next GLP
test will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next GLP test

If you define a date for the next GLP test, then the GLP test interval will
be tracked automatically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.
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Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

Dialogs "GLP test "Measurement" / Hardware" and "GLP test
"Titration" / Hardware"

Test tool

Selection of the test tool. Test tools are defined at GLP manager ▶ Test
tools.

Selection Selection of configured test tools

Control device

Selection of the control device with which the GLP test has been carried
out.

Selection Selection of configured control devices

Measuring input

Selection of the measuring input used for the GLP test. The selection is not
dependent on whether the control device has one or two measuring inter-
faces.

Selection 1 | 2
Default value 1

Dosing device

Selection of the MSB connector to which the dosing device is connected.
The selection does not depend on the number of MSB connectors of the
control instrument.

Selection 1 | 2 | 3 | 4
Default value 1
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12.4 System validation

Main dialog: System ▶ GLP manager ▶ System validation

In the dialog GLP manager / System validation and its subdialogs, you
can document the system validation results and define the time interval
after which validation must be carried out again.

Proceed as follows:

 

1 Open the properties dialog

￭ In the System / GLP manager dialog, tap on the [System vali-
dation] button.

 

2 Edit data

￭ Define the method, the result, etc. (see ""GLP manager / System
validation" dialog", page 106).

 

3 Define the validation interval

￭ Tap on [Validation interval].
￭ Enter the time interval or the date for the next system validation

(see "Dialog "System validation / Validation interval"", page 107).
￭ Tap on the fixed key [ ].

The dialog GLP manager / System validation appears again.

 

4 Enter statistical data

￭ Tap on [Test statistics].
￭ Enter the statistical data for the last system validation (see ""Sys-

tem validation / Test statistics" dialog", page 108).
￭ Tap on the fixed key [ ].
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The dialog GLP manager / System validation appears again.

 

5 Insert a note

￭ Tap on [Note (SOP)].
￭ Enter a brief description, e.g. a summary of the SOP (standard

operating procedure) according to which the system validation
was carried out (see ""System validation / Note (SOP)" dialog",
page 107).

￭ Tap on the fixed key [ ].

12.4.1 Parameter description

"GLP manager / System validation" dialog

Method

Method with which the system validation has been carried out.

Entry 32 characters maximum
Selection Selection of methods stored in the internal

memory

User

User who carried out the system validation.

Entry 24 characters maximum
Selection Selection of configured users

Test date

Date on which the system validation was carried out.

Format: YYYY:MM:DD

Test result

Result of the test.

Selection Test OK | Test not OK
Default value Test OK

Comment

Entry 24 characters maximum

[Note (SOP)]

Enter a brief description, e.g. a summary of the SOP (standard operating
procedure) according to which the system validation has been carried out.

[Validation interval]

Defining the time interval for the system validation (see "Dialog "System
validation / Validation interval"", page 107).
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[Test statistics]

Documenting the statistical data of the system validation (see ""System
validation / Test statistics" dialog", page 108).

"System validation / Note (SOP)" dialog

In this dialog, you can enter a brief text, e.g. a summary of the SOP
(standard operating procedure) according to which the system validation
was carried out.

Dialog "System validation / Validation interval"

Last validation

Date on which the last system validation was carried out.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which a system
validation has to be carried out again will be monitored.

Validation interval

If you define a time interval for the system validation, then the date in
Next validation will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next validation

If you define a time interval for the next system validation, then the Vali-
dation interval will be tracked automatically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.
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Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

"System validation / Test statistics" dialog

In the dialog System validation / Test statistics, you can document the
statistical data for the last system validation.

Number (n)

Number of determinations carried out.

Input range 1 to 9999999999 
Default value empty 

Mean value

Mean value out of single results.

Input range –999999999.00000 to 999999999.00000 
Default value empty 

s abs

Absolute standard deviation of the results.

Input range 0.00000 to 999999999.00000 
Default value empty 

s rel

Relative standard deviation of the results.

Input range 0.00000 to 100.00000 %
Default value empty %

d rel

Systematic deviation of the results.

Input range 0.00000 to 100.00000 %
Default value empty %

a sys

Systematic error.

Input range 0.00000 to 9999999999.00000 
Default value empty 
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12.5 System monitoring

12.5.1 Service interval
Main dialog: System ▶ GLP manager ▶ Monitoring ▶ Service inter-
val

In the dialog GLP manager / Service interval, you can define the time
interval for the maintenance of the system by the Metrohm Service
department. The service interval is checked each time the system is
started.

Last service

Date on which the last servicing was carried out.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which system
maintenance must be carried out again will be monitored.

Service interval

If you define a time interval for the system maintenance, then the date in
Next service will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next service

If you specify a date for the next system maintenance, then the Service
interval will be tracked automatically.

Format: YYYY:MM:DD

12.5.2 Backup interval
Main dialog: System ▶ GLP manager ▶ Monitoring ▶ Backup inter-
val

In the dialog GLP manager / Backup interval, you can define the time
interval for backups. The backup interval is checked each time the system
is started.

Last backup

Date on which the last backup was created.

Format: YYYY:MM:DD
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Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which a backup
has to be created again will be monitored.

Backup interval

If you define a time interval for the creation of backups, then the date in
Next backup will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next backup

If you specify a date for the next backup, then the Backup interval will
be tracked automatically.

Format: YYYY:MM:DD
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13 Common variables

Main dialog: System ▶ Common variables

You can save 25 method-independent variables, or common variables.
These variables can be used in future calculations (as variables CV01…
CV25). Common variables are useful, e.g. for the following applications:

￭ Determination of a blank value which will be taken into account during
the content determination of the sample.

￭ Determination of the content of a standard solution, which will be
taken into account during the content determination of the sample.

The designation and the value (including the unit) are displayed for every
common variable in the list.

[Delete]

Delete the selected common variable from the list.

[Edit]

Edit the data of the selected common variable, see following chapter.
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13.1 Editing common variables

List of common variables: Common Variable ▶ Edit

The common variables can be modified as follows:

￭ Edit manually, see the following.
￭ Automatic assignment from the determination run. A calculation result

must be configured accordingly for this purpose (see chapter 13.4,
page 115).

Name

Designation of the common variable.

Entry 24 characters maximum
Default value empty

Value

Value of the common variable.

Input range –999999999 to 9999999999 
Default value empty 

Unit of the common variable.

Entry 10 characters maximum
Default value empty
Selection % | mol/L | mmol/L | g/L | mg/L | mg/mL |

 mg/100 g | ppm | g | mg | µg | mL | µL | mg/
piece | °C | µg/min | mL/min | µL/min

Default value %
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Next assignment

This parameter is displayed only if a validity has been defined for the com-
mon variable.

Date on which the validity of the common variable expires.

Format: YYYY:MM:DD

[Validity]

Defining the time interval for the validity of the common variable (see
chapter 13.3, page 114).

[Properties]

Display the properties of the common variable, see following chapter.

13.2 Properties of common variables

Common variable: Edit ▶ Properties

Detailed information concerning the common variable is displayed in the
Edit common variables / Properties dialog:

￭ Status
Status of the common variable. If the time interval for the validity has
expired, then invalid will be displayed.

￭ Method
Method with which the value has been assigned to the common varia-
ble. If the value was entered manually, then manual will be displayed.

￭ Method status (only for automatic assignment from the determina-
tion run)

￭ Determination status (only for automatic assignment from the
determination run)

￭ Last assignment
Date and time of the last assignment.

￭ User
User who assigned the value to the common variable.
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13.3 Monitoring validity

Common variable: Edit ▶ Validity

In the dialog Edit common variables / Validity, you can define the
time interval after which a new value must be assigned to the common
variable.

Last assignment

Date on which the common variable was last assigned a value.

Format: YYYY:MM:DD

Monitoring

on | off (Default value: off)

If this parameter is activated, then the time interval after which the com-
mon variable must be assigned a new value will be monitored.

Validity

If you define a time interval for the validity of the common variable, then
the date in Next assignment will be tracked automatically.

Input range 1 to 999 days
Default value 999 days

Next assignment

If you specify a date for the next assignment, then the time interval for the
Validity will be tracked automatically.

Format: YYYY:MM:DD

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.
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Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

13.4 Assigning a result automatically to a common varia-
ble

NOTICE

This instruction is based on the assumption that the method contains a
calculation command with a calculation.

Proceed as follows to assign a result to a common variable:

 

1 Opening the editing dialog of the result

￭ In the command list, select the command CALC.
￭ Tap on the [Edit command] button.
￭ Select the result whose value is to be assigned to a common vari-

able and tap on [Edit].

The editing dialog of the result is displayed.

 

2 Define result options

￭ Tap on the [Result options] button.

￭ Activate the parameter Save as common variable.
￭ Define Variable = CV01…CV25.
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3 Saving the settings

Tap on the fixed keys [ ] or [ ].

In the future, the calculated result will be assigned to the selected
common variable (result name, value and unit).
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14 Templates

Main dialog: System ▶ Templates

You have the option of defining system-specific templates. You can
use these templates when editing the respective data.

You can create the following templates:

￭ Sample data (see chapter 14.1, page 117)
Create sample identifications and sample assignments.

￭ Custom result templates (see chapter 14.2, page 121)
Define formulas for result calculations.

￭ Input lines (see chapter 14.3, page 125)
Define input signals on the remote interface.

￭ Output lines (see chapter 14.4, page 127)
Defining output signals on the remote interface.

￭ Report header (see chapter 14.5, page 130)
Create a system-specific report header that contains information con-
cerning the laboratory, for example.

14.1 Sample data

Main dialog: System ▶ Templates ▶ Sample data

You can create the following templates in the dialog Templates / Sam-
ple data:

￭ Sample identifications (see chapter 14.1.1, page 118)
List with sample identifications. If you must enter the sample identifica-
tion before starting a determination, then you can select the entries
contained in this list.
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￭ Sample assignments (see chapter 14.1.2, page 119)
You can assign a particular method to a sample identification.

Use sample identification list

on | off (Default value: off)

Activate this parameter so that the sample identifications defined in the
list will be displayed as selections.

Use sample assignment table

on | off (Default value: off)

Activating/deactivating the use of the sample assignment table.

NOTICE

If this parameter is activated, the following will no longer be possible:

￭ Carrying out determinations without their sample identification
being defined in the sample assignment table.

￭ Defining a method in the sample table. Previously defined methods
will be ignored.

Assignment ident.

Identification which is used as assignment identification to load the cor-
rect method.

Selection Identification 1 | Identification 2
Default value Identification 1

Request assignment identification

on | off (Default value: off)

If this parameter is activated, then the sample identification will be reques-
ted automatically at the start of a determination.

14.1.1 Sample identification list
Main dialog: System ▶ Templates ▶ Sample data ▶ Sample identi-
fication list
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You can create a system-specific list with sample identifications in the dia-
log Sample data / Sample identification list. This list makes it easier
for you to enter frequently used sample identifications, i.e. this list is avail-
able to you for entering them (main dialog, command REQUEST, etc.). It
may be a good idea to define the unchanging part of the identification as
a template and to add the variable part during sample data input.

[New]

Add a new sample identification to the list.

[Delete]

Delete the selected sample identification from the list.

[Edit]

Change the designation of the selected sample identification.

14.1.2 Sample assignment table
Main dialog: System ▶ Templates ▶ Sample data ▶ Sample assign-
ment table
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In the sample assignment table, a particular method is assigned to a sam-
ple identification. In this way, you ensure that your samples will be
processed with the correct method; mix-ups are not longer possible.
When you start a determination, you need only enter the sample identifi-
cation; the method is loaded automatically.

[New]

Add a new sample assignment to the list, see following chapter.

[Delete]

Delete the selected sample assignment.

[Edit]

Edit the selected sample assignment, see following chapter.

Editing the sample assignment

Identification

Identification of the sample.

NOTICE

You can place an * as a wildcard at the beginning or end of the charac-
ter string. Doing so allows you to prefix or suffix a sequential number,
for example, to the identification, which will be ignored when methods
are being assigned.

Entry 24 characters maximum
Selection Selection of defined identifications in the

sample identification list

Memory

Memory location the method is loaded from. All memory locations are
selectable, even if they are currently not accessible.

Selection Internal memory | External memory 1 | Exter-
nal memory 2 | Shared memory

Default value Internal memory

Shared memory
Shared directory in the network.

Method

Method that is loaded when a sample with the above-specified identifica-
tion is processed. You can also enter a method that does not yet exist in
the selected memory. When a determination is started there is a check
whether the method is available.
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Entry 32 characters maximum
Selection Selection of methods stored in the selected

memory

14.2 Custom result templates

Main dialog: System ▶ Templates ▶ Custom result templates

In the dialog Templates / Custom result templates, you can define the
result calculations which can be loaded in the calculation command
CALC. With the exception of the following points, creating a result tem-
plate is identical to editing a calculation in the command CALC (see chap-
ter 28.5.1.2, page 259):

￭ No result variable can be assigned to the template.
￭ The definition of limit values is not possible.

NOTICE

Up to nine wildcards can be inserted in the calculation formula, the
Variables F1…F9. Use these variables, e.g. for the molar mass of your
analyte. If you have loaded a result template with these wildcards in the
calculation command, then you will automatically be prompted to enter
the numerical values.

[New]

Add a new result template to the list, see following chapter.

[Delete]

Delete the selected result template from the list.

[Edit]

Edit the data of the selected result template, see following chapter.
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14.2.1 Editing result templates
List of result templates: Result template ▶ New / Edit

Result name

The result name is the text which will be shown in the results display and
in the report.

Entry max. 24 characters
Default value R

Calculation formula

Shows the calculation formula. A special editor is opened for the defini-
tion (see chapter 28.5.3, page 264).

Entry max. 100 characters
Default value empty

Decimal places

Number of decimal places used to display the result.

Input range 0 to 5 
Default value 2 

Result unit

The result unit is displayed and saved together with the result.

Entry max. 10 characters
Selection % | mol/L | mmol/L | g/L | mg/L | mg/mL |

 mg/100 g | ppm | g | mg | µg | mL | µL | mg/
piece | °C | µg/min | mL/min | µL/min

Default value %

[Note]

Entering a note on the calculation.

[Note for wizard]

Enter a note on the calculation. This note is displayed when loading the
result template.

[Result options]

Defining additional settings for the calculation.

"Edit result template / Result options" dialog

In the dialog Edit result template / Result options, settings for how to
process the calculated result are defined.
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Variable for mean value

If the statistic calculations have been activated (see method options), the
mean value of the single results will be saved as variable SMN1 to SMN9.
As default value, always the first free variable is being displayed.

Selection SMN1 … SMN9 | off

off
For the result not statistic calculations are carried out.

Save as titer

The result can be saved as titer for the selected titrant.

NOTICE

The titer is assigned to the titrant defined in the last titration command
before the calculation. Please note that the CALC command containing
the titer assignment is inserted after the titration command with which
the titer is determined.

Selection Single value | Mean value | off
Default value off

Single value
The result of the current determination is saved as titer.

Mean value
If statistic calculations are carried out for the result, the current mean
value of the determination series is saved.

off
The result is not saved as titer.

Save as common variable

on | off (Default value: off)

The calculated result can be saved as a method-independent variable, a
so-called common variable. The result is then also available in other
methods for calculations. In all cases, only the single value will be saved,
even if the statistics function is enabled.

Variable

Selection of the common variable to which the result is being assigned.

Selection CV01 … CV25
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Display result

on | off (Default value: on)

If you deactivate this parameter, the result is neither displayed in the result
dialog nor printed in the result report. This can be advisable for intermedi-
ate results.

Save result in result table

on | off (Default value: off)

The calculated result can be saved in the result table. This may be advisa-
ble if e.g. the results of all determinations carried out on a particular day
are to be displayed clearly. A maximum of nine results from a determina-
tion can be saved in the result table.

Precision

Setting, with which accuracy the result is used in additional calculations.

Selection Round | Truncate | Full precision
Default value Round

Round
The result is rounded to the defined number of decimal places (com-
mercial rounding, in accordance with the US Pharmacopeia USP). If the
digit at the first dropped decimal place is 1, 2, 3 or 4, then it will be
rounded off; if this digit is 5, 6, 7, 8 or 9, then it will be rounded up.
Negative digits will be rounded in accordance with their amount, i.e.
away from zero.

Truncate
The result is cut to the number of decimal places defined.

Full precision
The result is used with full accuracy (floating point number either in
"single precision" (32 bit) or in "double precision" (64 bit), according to
the standard IEEE 754).
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14.3 Input lines

Main dialog: System ▶ Templates ▶ Input lines

In the dialog Templates / Input lines, you can define the input signals at
the remote interface as a template. You can select these templates in the
command SCAN. The list can contain a maximum of 20 templates.

Table 7 List of predefined input signals

Signal name Input signal Function

Cond OK ******1* queries "Cond OK" condition of device.

End1 ****1*** waits for the EOD pulse from Device 1 (Titrino,
Titrando).

End2 *1****** waits for the EOD pulse from Device 2.

EndMeter ***11*** waits for the EOD pulse from 780/781 pH/Ion
meter (stirrer 1 will be switched on during the
waiting period).

Ready* **1****1 queries the "Ready" condition of Devices 1 and 2
(Titrino, Titrando).

The status of devices working in parallel can be
scanned with this signal. In this case the "Ready"
line of both devices must be statically set (i.e. con-
stantly) at the end of a determination. Devices
which only transmit a brief impulse cannot be
controlled in parallel.

Ready1 *******1 queries the "Ready" condition of Device 1.

Ready2 **1***** queries the "Ready" condition of Device 2.
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Signal name Input signal Function

Sample ready ***1**** waits for a stepping pulse, of, for instance, a
connected Sample Processor, as soon as it is
ready.

[New]

Add a new input signal to the list, see following chapter.

[Delete]

Delete the selected input signal from the list.

[Edit]

Edit the data of the selected input signal, see following chapter.

14.3.1 Editing the input signal
List of input signals: Input signal ▶ New / Edit

Signal name

Designation of the template.

Entry 24 characters maximum

Input signal

Entering the desired bit pattern:

Entering the bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status

The input lines are always numbered from right to left, i.e. with the signal
*******1 line 0 is expected to be active.

NOTICE

We recommend masking lines that are of no interest or for which no
defined condition can be predicted with an asterisk (*).

Entry Bit pattern of exactly 8 characters
Default value ********



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 14 Templates

917 Coulometer ￭￭￭￭￭￭￭￭ 127

14.4 Output lines

Main dialog: System ▶ Templates ▶ Output lines

In the dialog Templates / Output lines, you can define the output sig-
nals at the remote interface as a template. You can select these templates
in the command CTRL. The list can contain a maximum of 20 templates.

Table 8 List of predefined output signals

Signal name Output signal Function

Continue *********p**** sends a stepping pulse to the connected Sample
Processor.

Init 00000000000000 initializes the remote interface.

Meter Cal C *********1001* switches the 781 pH/Ion meter to concentration
calibration.

Meter Cal pH *********0101* switches the 780/781 pH/Ion meter to pH calibra-
tion and starts the calibration.

Meter enter *********1111* simulates the [Enter] key of the 780/781 pH/Ion
meter; mandatory for pH calibration in order to
start the measurement of the second buffer.

Meter Mode C *********1000* switches the 781 pH/Ion meter to concentration
measurement.

Meter Mode I *********0100* switches the 780/781 pH/Ion meter to voltametric
measurement with polarization current and starts
the measurement.

Meter Mode pH *********0001* switches the 780/781 pH/Ion meter to pH
measurement and starts the measurement.
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Signal name Output signal Function

Meter Mode T *********0010* switches the 780/781 pH/Ion meter to tempera-
ture measurement and starts the measurement.

Meter Mode U *********0011* switches the 780/781 pH/Ion meter to voltage
measurement and starts the measurement.

Start device* ********p****p starts Devices 1 and 2 (e.g. Titrino, Titrando, etc.)
*).

The signal is transmitted as a short pulse of 200
ms.

Start device1 *************p starts Device 1 (e.g. Titrino, Titrando, etc.) *).

The signal is transmitted as a short pulse of 200
ms.

Start device2 ********p***** starts Device 2 (e.g. Titrino, Titrando, etc.) *).

The signal is transmitted as a short pulse of 200
ms.

Start Dos* *****p*p****** starts Dosimat at Devices 1 and 2 (Titrino via "acti-
vate").

The signal is transmitted as a short pulse of 200
ms.

Start Dos1 *******p****** starts Dosimat at Device 1 (Titrino via "activate").

The signal is transmitted as a short pulse of 200
ms.

Start Dos2 *****p******** starts Dosimat at Device 2 (Titrino via "activate").

The signal is transmitted as a short pulse of 200
ms.

*) In the case of the 780/781 pH/Ion meter, a result report is triggered.

[New]

Add a new output signal to the list, see following chapter.

[Delete]

Delete the selected output signal from the list.

[Edit]

Edit the data of the selected output signal, see following chapter.
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14.4.1 Editing the output signal
List of input signals: Output signal ▶ New / Edit

Signal name

Designation of the template.

Entry 24 characters maximum

Output signal

Entering the desired bit pattern:

Entering the bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status
￭ p = set pulse

The output lines are always numbered from right to left, i.e. with the sig-
nal *************1 line 0 is set.

NOTICE

We recommend masking lines that are of no interest or for which no
defined condition can be predicted with an asterisk (*).

Entry Bit pattern of exactly 14 characters
Default value **************

Pulse length

Duration of the sent pulses.

Input range 100 to 1000 ms
Default value 200 ms
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14.5 Report header

Main dialog: System ▶ Templates ▶ Report header

In the dialog Templates / Report header, you can create a system-spe-
cific report header that contains information concerning the laboratory,
for example. The report header can contain a maximum of four lines of 46
characters each and will always be printed out in front of the standard
report header. The standard report header contains the instrument type,
serial number and program version of the software, instrument name and
printing date.

Print logo

on | off (Default value: off)

If this parameter is activated, then the logo defined below will be printed
out in the right margin.

Logo

Selection Metrohm logo | Custom logo
Default value Metrohm logo

Custom logo
Select this setting if your logo is to be printed out in the report header.
How to create a logo is described below.

Applying the custom logo

You can create a graphics file of your own and use it as a logo in the
report header in place of the Metrohm logo.

NOTICE

Observe the size of the graphics object. The maximum size of your
graphics file is 64 kB. We recommend a maximum of 500 × 200 pixels.

Proceed as follows to create your own logo:

 

1 Creating the logo

￭ Create a graphics file with the desired logo in an image process-
ing program.

￭ Save the graph as a JPG file under the file name
"CustomImage.jpg".
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2 Copying the file to an external storage medium

￭ Copy the file "CustomImage.jpg" to the directory "917".
If this structure is not maintained, the file will not be found
because the software directly accesses the "917" directory.

￭ Plug in the external storage medium at the Coulometer.

 

3 Loading the graphics file

￭ In the Templates / Report header dialog, tap on the [Load]
button.
The file is copied to the internal memory.

￭ Switch the instrument off and back on again.

 

4 Applying the custom logo

￭ In the Templates / Report header dialog, activate the Print
logo option.

￭ Define Logo = Custom logo.

Your logo will now be printed in the report header of all reports in
the future.
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15 Methods

15.1 Creating a new method

Proceed as follows to create a new method:

 

1 Opening the method table

￭ In the main dialog, tap on [Load method].
￭ Tap on [New method].

The method table with the stored templates opens:

 

2 Loading the method

￭ Tap on [Empty method].

or

￭ Select the desired template and tap on [Load template].

The method is now loaded. New method is displayed in the main
dialog in the title line.

If a new method has been created, then the individual parameters can be
modified with [Edit parameters].
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15.2 Saving a method

If you modify method parameters, then you can save these as your own
method.

To save a method, proceed as follows:

 

1 Open the command sequence

￭ In the main dialog, tap on [Edit parameters].

The command sequence of the method is displayed:

 

2 Modifying/applying the method name

￭ Tap on [Save method].
A method name will be suggested for new methods. If the
method has already been saved once, then the method name will
be displayed.

Applying the name:
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￭ Tap on [Save].

The method will be saved and the command sequence is displayed.

Entering a new name:

￭ Tap on the input field File name.
The text editor opens.

￭ Enter a new file name (max. 32 characters) and confirm with
[OK].

￭ Tap on [Save].

The method will be saved and the command sequence is displayed.

15.3 Loading a method

Proceed as follows to load a method:

 

1 Opening the method table

￭ In the main dialog, tap on [Load method].
The selection of memory locations is displayed. This selection will
be skipped if only the internal memory is accessible.

￭ Select the memory location where the desired method is saved.
The selection of file groups is displayed (see chapter 11.1, page
91). If only one group is available, then the method table will be
displayed directly.

￭ Select the group with the desired method.
￭ Tap on [Show files].

The method table with the stored methods opens:

 

2 Selecting the method

￭ Select the desired method.
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3 Loading the method

￭ Tap on [Load].

The method is now loaded. The method name is displayed in the
main dialog in the title line.

NOTICE

The data of the current determination will be deleted when you load a
method.

15.4 Editing a method

Main dialog: Edit parameters

In the dialog Parameters / Sequence, you can define and edit the
method commands which are executed successively during a determina-
tion.

The following data is displayed in the command list for each command:

￭ Line number
￭ Name
￭ Comment

You can adjust the comment in accordance with your requirements.

[Save method]

Save the current method (see chapter 15.2, page 133).

[Method options]

Define various settings which refer to the entire method, e.g. statistics,
automatic saving of determinations, settings for sample data, etc. (see
chapter 15.5, page 137).
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[Insert command]

Insert a new method command. It is inserted before the selected com-
mand.

NOTICE

Not all commands are available for subsequences. Commands which
cannot be inserted into subsequences are disabled.

[Delete command]

Delete the selected method command.

[Edit command]

Edit the selected method command.

15.4.1 Inserting a command
A method is comprised of individual commands. When you start a deter-
mination, the commands are executed one after the other.

The following constraints apply:

￭ Maximum of 99 commands

Inserting a command

To insert a command in a method, proceed as follows:

 

1 Open the command overview

￭ In the main dialog, tap on [Edit parameters].
￭ Tap on the [Insert command] button.

This dialog contains all of the commands which can be inserted into
a method run, organized into thematic groups.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 15 Methods

917 Coulometer ￭￭￭￭￭￭￭￭ 137

 

2 Select a command group

￭ Tap on the desired command group.

In the case of [Report], the command is inserted directly into the
command list. For all other command groups, the available com-
mands will be displayed (titration / measuring commands, etc.).

 

3 Inserting a command

Tap on the desired command.

The dialog is closed and the command is displayed in the command
list.

15.5 Method options

Main dialog: Edit parameters ▶ Method options

Method options are settings which apply to the method as a whole and
not to an individual command.

The following settings are available:

￭ Activate/deactivate statistics calculations
￭ Save determination automatically
￭ Sign a method electronically
￭ Check the method when the determination starts
￭ Define a fixed sample size
￭ etc.

Statistics

on | off (Default value: off)

If this parameter is activated, then statistics calculations will be carried out
for all of the defined results. The prerequisite here, however, is that a vari-
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able for the mean value is defined in the result options (see "Dialog "Edit
calculation / Result options"", page 261).

Number of determinations

The number of determinations that are carried out for the statistics calcu-
lations.

If an additional determination has to be added to the determination
series, because one determination has been incorrect, for example, then
this can be accomplished in the statistical overview (see chapter 24, page
194).

Input range 2 to 20 
Default value 3 

[Save automat.]

Define the settings for automatically saving the determination (see chap-
ter 15.5.6, page 146).

[Properties]

Display the properties of the current method and sign electronically (see
chapter 15.5.4, page 144).

[Note]

Enter a note on the method (see chapter 15.5.5, page 146).

[Start/Stop options]

Edit functions which are carried out immediately after the method is
started or stopped, see chapter Start options, page138 and chapter Stop
options, page 140.

[Sample data]

Specify method-specific settings for the sample data, e.g. designation of
the sample identifications, limits for the sample size (see chapter 15.5.3,
page 141).

15.5.1 Start options
Main dialog: Edit parameters ▶ Method options ▶ Start/Stop
options ▶ Start options

In the dialog Method options / Start options, you can configure the
functions which are carried out when a determination is started.

Method check at start

on | off (Default value: on)

If this option is activated, then the following tests are carried out at the
method start.

￭ Are the required control and peripheral devices connected?
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￭ Are the titrant and the sensor on hand?
￭ Have the monitoring intervals expired?
￭ etc.

NOTICE

We recommend that the method check only be deactivated if the titra-
tion must begin immediately after the start of the determination (e.g.
with very rapid reactions such as enzyme-catalyzed reactions). If the
method check is deactivated, it could happen that the determination
run will be interrupted, e.g. because devices, titrants or sensors are not
on hand.

The following settings can be implemented for a connected S885 Com-
pact Oven SC:

Rack reset

on | off (Default value: off)

If this option is activated, then the sample rack is initialized at the time of
the method start. The following actions are carried out:

￭ The lift is moved upwards.
￭ The sample rack is rotated to the starting position.
￭ The sample variable is reset to the value 1.

Check rack

Definition of the sample rack which must be attached at the time of the
method start. This ensures that the method will be carried out only with
this sample rack.

NOTICE

The sample rack can, however, only be checked if the Rack reset
option is activated.

For methods for the 885 Compact Oven SC, this parameter must be set
to no as it has a fixed rack.

Selection no | Selection of the configured sample racks
Default value no
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Increase sample variable automatically

on | off (Default value: on)

The sample variable describes the current position of the sample on the
rack of the Sample Processor. If this option is activated, then the sample
variable is automatically increased by 1 at the end of each determination.

This option must be deactivated if the sample variable is to be altered spe-
cifically with a SAMPLE command.

Request rack position at start

on | off (Default value: off)

If this option is activated, then the rack position of the first sample to be
processed is requested.

15.5.2 Stop options
Main dialog: Edit parameters ▶ Method options ▶ Start/Stop
options ▶ Stop options

In the dialog Method options / Stop options, you can define the
actions which are carried out when a method is canceled.

The method can be canceled as follows:

￭ Manual stop with the fixed key [ ]
￭ Stop because of an error
￭ Stop by remote signal via the Control Remote Box

Switch off stirrers

on | off (Default value: on)

If this option is activated, then all of the connected stirrers will be
switched off.

Set remote lines

Selection of the signal out of the templates or entering the required bit
pattern. Templates are defined under System ▶ Templates ▶ Output
lines.

NOTICE

A line set active is not being reset automatically, not even at the end of
the determination.

Entering the bit pattern:

￭ 0 = line inactive
￭ 1 = line active
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￭ * = retain line status
￭ p = set pulse

The output lines are always numbered from right to left, i.e. with the sig-
nal *************1 line 0 is set. With a pulse, the length is set to 200 ms.
If you wish to set pulses with other lengths, you have to define a corre-
sponding template.

Entry Bit pattern containing exactly 14 characters
or a max. of 24 characters for the name of
the template

Default value **************
Selection Selection of the templates defined

15.5.3 Sample data
Main dialog: Edit parameters ▶ Method options ▶ Sample data

You can define the following method-specific settings in the dialog
Method options / Sample data:

￭ Modify the designation for the sample identifications
￭ Define a fixed sample size
￭ Define limits for the sample size

If you define limits, these will be monitored at the start and at the end
of the determination.

Below you will find an example demonstrating the effects on the main
dialog of the settings in this dialog (see "Modifying sample data", page
142).

Identification 1, Identification 2

on | off (Default value: on)

If this option is activated, then the input field for the sample identification
in the main dialog will be displayed.

Designation

A designation of your own choosing can be defined for the input field for
each method.

Entry 16 characters maximum

Fixed sample size

on | off (Default value: off)

Activate this parameter if the same sample amount is always to be used
for all determinations. If this is case, then you can define the sample size
here. It will be displayed in the main dialog, but it can no longer be
changed there.
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Sample size

This parameter can only be edited when Fixed sample size is activated.

Input range –999999999 to 9999999999 
Default value 1.0 

Unit of sample size.

Selection g | mg | µg | mL | µL | pieces
Default value g

NOTICE

You can also use the parameter Fixed sample size if you would like to
establish a default for the sample size.

Example: For a particular determination, you require 10 mL of sample.
Now and again, however, you have too little sample available and you
must perform the determination with 5 mL, for instance. In this case,
proceed as follows:

1. Activate the parameter Fixed sample size.
2. Define the value and unit for the sample size, in the above exam-

ple, for instance, [10 mL].
3. Deactivate the parameter Fixed sample size again.
4. Save method.

⇨ Each time you load this method, 10 mL is entered as the sample size,
but in the example mentioned you can enter the lesser quantity of 5
mL.

[Sample size limits]

This button is accessible only ifFixed sample size is deactivated.

Define the limit values for the sample size (see "Defining limit values for
the sample size", page 143).

Modifying sample data

This instruction is for the purpose of clarifying the settings which are pos-
sible in this dialog. The following settings should be made:

￭ Change the designation for the input field of the first sample identifica-
tion.

￭ Hide the input field for the second sample identification.
￭ Define a fixed sample size.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 15 Methods

917 Coulometer ￭￭￭￭￭￭￭￭ 143

Proceed as follows:

 

1 Change the designation for the input field

￭ Tap on the input field Identification 1.
The text editor opens.

￭ Change the designation in Batch and confirm with [OK].
￭ Deactivate the parameter Identification 2.

 

2 Define a fixed sample size

￭ Activate the parameter Fixed sample size.
￭ Enter the value 10 mL as Sample size.

 

3 Displaying the main dialog

Tap on the fixed key [ ].

The data is saved and the adjusted main dialog appears.

Only Identification 1 is shown with the title "Batch." The fixed sample
size "10 mL" is shown, but cannot be edited.

Defining limit values for the sample size

In the dialog Sample data / Sample size limits, you can define the limit
values for the sample size. These values are not monitored during sample
data input, but rather:

￭ when the determination is started.
￭ when the determination is finished.
￭ upon automatic sample data query via the command REQUEST.
￭ when the determination is being recalculated.

An entry is made in the message list automatically when these limits are
infringed (see chapter 23.2, page 182).
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Monitoring sample size limits

on | off (Default value: off)

If this parameter is activated, then the sample size will be monitored.

Lower limit

Input range –999999999 to 9999999999 
Default value 0 

Upper limit

Input range –999999999 to 9999999999 
Default value 9999999999 

Display message

on | off (Default value: off)

If this parameter is activated, a message is displayed in case the limits are
infringed. You can select whether you want to continue with the determi-
nation or cancel the run.

If this parameter is deactivated, then the message will be entered only in
the message list of the determination.

Timeout

The message is displayed during this time. Afterwards, the determination
is continued automatically.

Input range 0 to 999999 s
Default value 30 s
Selection off

off
The determination will not be continued until after the message has
been confirmed.

15.5.4 Method properties
Main dialog: Edit parameters ▶ Method options ▶ Properties

Detailed information concerning the method is displayed in the Method
options / Properties dialog and the methods can be signed electroni-
cally here:
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￭ Method status
Current status of the method.

– new
The method has been newly created and not yet saved.

– saved
The current method has been saved.

– modified
The current method has been modified.

– reviewed
The current method has been signed at level 1.

– released
The current method has been signed at level 2.

￭ Created by
User who created the method.

￭ Created on
Date and time at which the method was created.

￭ Last saved by
User who saved the method most recently.

￭ Last saved on
Date and time at which the method was most recently saved. The ver-
sion of the method is displayed as well. The version number will be
increased by one each time the file is saved.

The following data is displayed only if the option Saving modified
method under Login options / Modification options is activated:

￭ Modified by
User who modified and saved the method most recently.

￭ Modified on
Date and time at which the method was most recently modified and
saved.

￭ Reason
Reason for the modification of the method.

￭ Comment
Comment for the modification of the method.

The following information is only shown if the method has been signed at
level 1:

￭ Reviewed by
User who signed the method at level 1.

￭ Reviewed on
Date and time at which the method has been signed at level 1.

￭ Reason
Reason for the signing of the method.

￭ Comment
Comment for the signing of the method.
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The following information is only shown if the method has been signed at
level 2:

￭ Released by
User who signed the method at level 2.

￭ Released on
Date and time at which the method has been signed at level 2.

￭ Reason
Reason for the signing of the method.

￭ Comment
Comment for the signing of the method.

[Delete signature]

Delete all of the signatures for the method or the determination. This but-
ton is inactive if level 2 has not yet been signed (see chapter 16.2, page
150).

[Sign]

Sign the method or determination. This button is active only when work-
ing with activated login function and password (see chapter 16.1, page
149).

15.5.5 Note
Main dialog: Edit parameters ▶ Method options ▶ Note

In this dialog, you can enter a short text, e.g. important information about
carrying out the determination.

[Display options]

Definition when the note is being displayed.

Automatically after loading the method

on | off (Default value: off)

If this parameter is activated, the note is displayed when loading the
method. It can otherwise only be read in this dialog.

15.5.6 Saving a determination automatically
Main dialog: Edit parameters ▶ Method options ▶ Save automat.

In the dialog Method options / Save automatically, you can specify
whether the determination is to be saved automatically and/or whether a
PC/LIMS report is to be created.

Save determination automatically

on | off (Default value: off)

If this parameter is activated, then the determination will be saved auto-
matically.
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Memory

Memory location where the determination will be saved.

Selection External memory 1 | External memory 2 |
 Shared memory

Default value External memory 1

Shared memory
The determination will be saved in a shared directory on the network.
The shared directory is selected in the Edit device / Shared memory
dialog (see chapter 10.3.3, page 69).

Group

Directory where the determination will be saved.

Entry 32 characters maximum
Selection Selection of available directories | empty
Default value empty

File name

File name of the determination. The file name is always extended to
include the date and the time of day (YYYYMMDD-hhmmss) in order to
ensure that the file names are unique for all determinations.

Entry max. 16 characters
Selection Identification 1 | Identification 2 | Method
Default value Identification 1

Identification 1
The first 16 characters of the text which was entered in the main dia-
log for Identification 1 + YYYYMMDD-hhmmss.

Identification 2
The first 16 characters of the text which was entered in the main dia-
log for Identification 2 + YYYYMMDD-hhmmss.

Method
The first 16 characters of the text, of the method name +
YYYYMMDD-hhmmss.

Write protection

on | off (Default value: on)

If this parameter is activated, then the file cannot be saved, deleted, or
renamed. This is only an internal write protection feature and is independ-
ent of the write protection of the operating system on your computer.
This write protection feature protects the saved determination data
against accidental modifications or modifications by unauthorized per-
sons.
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Create PC/LIMS report

on | off (Default value: off)

If this parameter is activated, then a machine-readable report with all of
the important data for the determination is created, a so-called PC/LIMS
report.

The settings are implemented in the device manager (see chapter 10.3.2,
page 68).

When you save the PC/LIMS report as a file, the file name will be gener-
ated automatically as follows: PC_LIMS_Report-first 16 characters of the
value of the parameter File name-Date-Time.txt. If the value of the
parameter File name contains one or more of the following characters,
then these will be automatically converted in the file name into the char-
acter "_": / \ : * ? " < > |.
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16 Electronic signatures

16.1 Signing methods/determinations electronically

Methods: Main dialog ▶ Edit parameters ▶ Method
options ▶ Properties ▶ Sign

Determinations: Results dialog ▶ More data ▶ Properties ▶ Sign

You can sign methods or determinations in the dialog Electronic signa-
ture. The following information is saved along with each electronic signa-
ture:

￭ User (complete name)
￭ Date and time
￭ Reason
￭ Comment

Methods can only be signed if they have the status saved. The status of a
method can be found in the dialog Method options / Properties.

Signature

Selection of the level at which the determination should be signed.

Selection Review (signature level 1) | Release (signature
level 2)
A maximum of three signatures from up to three
different users can given at each level. However, it is
not possible for a user to sign at both level 1 and
level 2.

Review (signature level 1)
If the method has never been signed before, then only level 1 can be
selected.

Release (signature level 2)
If the method has been signed three times at level 1 or already once at
level 2 then only level 2 can be selected.

User

Identification of the user who signs.

Password

Password of the user.
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Reason

Selection of the reasons for the signature. The list with reasons is compiled
in the user administration (see chapter 7.3.6, page 52).

Selection Selection of configured reasons

Comment

Entry 24 characters maximum

[Change password]

Change the current password.

[Sign]

Sign the method or determination with the data entered above.

16.2 Deleting electronic signatures

If a released method must be revised, e.g. in order to adapt to altered
conditions, then the signatures must be deleted. The method can other-
wise not be modified. In the case of released determinations, the signa-
tures can also be deleted. Signatures, however, cannot be deleted until
after the method/determination has been signed at Level 2.

Signatures are deleted automatically in the following cases:

￭ A method signed at Level 1 is being altered.
￭ A determination signed at Level 1 is being recalculated.

User

Identification of the user who deletes the signatures.

Password

Password of the user.

Reason

Selection of the reasons for the deletion of the signature. The list with rea-
sons is compiled in the user administration (see chapter 7.3.6, page 52).

Selection Selection of configured reasons

Comment

Entry 24 characters maximum

[Delete signature]

Delete all the signatures for the method or the determination. The method
is assigned the status saved.
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17 Control

Main dialog: Control

In the dialog Control, the settings for the execution of a single determi-
nation or of one sample series are defined.

If you work with the login function activated, you can log off the system
in this dialog. The login dialog will then be shown immediately.

Statistics

on | off (Default value: off)

With this option, you can enable or disable the statistics calculations for
individual determinations (see "Statistics", page 153).

NOTICE

The parameter Statistics in the method options will not be changed as
a result. This setting here will be adjusted automatically to match the
one in the method options.

Sample table

on | off (Default value: off)

If this option is activated, the sample data for a sample series can be
entered in a table (see chapter 20, page 162).
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Autostart

on | off (Default value: off)

If this option is activated, a new determination is started automatically at
the end of a determination. This continues until the number specified has
been reached (siehe Number of autostarts).

NOTICE

If you deactivate this option while a determination is running, then that
determination will be ended, although the next one will however also
not be started. This can be used to cancel a sample series.

Number of autostarts

Number of automatic starts.

Input range 1 to 9999 
Selection Table
Default value Table

Table
The number of automatic starts corresponds to the number of samples
in the sample table.

Sample number

The sample number is primarily used for documentation. Each time a
determination is started, it is increased by one. The sample number can,
however, also be entered manually. Each time the Coulometer is switched
on, the value is reset to zero.

Input range 0 to 9999 
Default value 0 

[Logout]

User logout (visible only when work is done with activated login function).

[Favorites]

Save methods/sample tables as a favorite (see chapter 18, page 155).
Depending on whether you are working with or without login function,
user-specific or common favorites can be created. On the main dialog, a
button is created for each favorite. This way, a method or a sample table
can be started with one single mouse click.

[Delete table]

Delete the sample table completely.

[Reset autostart]

Reset the value of the autostart counter to zero.
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[Delete statistics] 

Delete all statistics data.

The statistics data should be deleted manually if a sample series has been
canceled and a new sample series is to be started.

The statistics data is deleted automatically in following cases:

￭ when all of the determinations of the determination series have been
carried out and a new determination has been started afterwards.

￭ when a new method is loaded.
￭ when a determination is loaded (the method with which the determi-

nation was carried out is loaded simultaneously with the determina-
tion).

Statistics

In the dialog Control, you can deactivate the statistics calculations for
individual determinations. This option is required primarily in order to
insert the processing of an "urgent sample" during the processing of a
sample series when the urgent sample is not to be included in the statis-
tics calculations.

Interrupting a determination series for an "urgent sample"

If the same method is required for the "urgent sample" as is being used
for the sample series, then you need only deactivate the option Statistics
and then reactivate it after the determination is completed. Proceed as fol-
lows if you need to process the "urgent sample" with a different method:

 

1 Deactivate statistics calculation

￭ Deactivate the option Statistics.

 

2 Saving the determination

￭ Save the current determination of the sample series (see chapter
23.6, page 190).

 

3 Carrying out the determination

￭ Load the method for the "urgent sample".
￭ Carry out the determination.

 

4 Load the last determination of the sample series

￭ Reload the previously saved last determination.

The determination, the method used for it and the current statistical
data are loaded. The option Statistics is activated again and the
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value of the statistics counter corresponds to that in effect before the
interruption.

 

5 Continuing the sample series

￭ Carry out the remaining determinations in the sample series.
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18 Favorites

Main dialog: Control ▶ Favorites

Main dialog: System ▶ System settings ▶ User
admin. ▶ Edit ▶ Favorites

This chapter describes how you can create favorites. Favorites are compa-
rable to the favorites/bookmarks in your Internet browser. In the main dia-
log, a button is created for each favorite. By pressing a single key, you can
trigger an action without having to navigate through different dialogs.

The following objects can be saved as favorites:

￭ Methods
￭ Sample tables

User-specific or common favorites can be created, depending on whether
you are working with or without the login function.

￭ Operation with login function:
If you are working with the login function activated, user-specific
favorites can be created. These can only be used by a certain user.
User-specific favorites are created as follows:

– in the user administration by a user with administrator rights
(System ▶ System settings ▶ User admin. ▶ Edit).

– in the dialog Control for the user who is logged in.
￭ Operation without login function:

If you are working without the login function, common favorites can
be created. These favorites are available for all users. Common favor-
ites are created in the Control dialog.
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18.1 Creating favorites

The list of favorites gives the designation and position of the button on
the main dialog of each favorite configured.

[New]

Add a new favorite to the list, see following chapter.

[Delete]

Delete the selected favorite from the list.

[Edit]

Edit the properties of the selected favorite, see following chapter.

18.1.1 Editing favorites
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Position

On the main dialog, a button is created for each favorite. These buttons
are ordered in three rows at fixed positions. The position 1 can be found
top left.

Input range 1 to 14 
Default value 1 

Name

The designation of the favorite is used for unambiguous identification.

Entry 24 characters maximum

Type

Definition as to whether the favorite represents a single method or a com-
plete sample table.

Selection Method | Sample table
Default value Method

Memory

Memory location the method or the sample table is loaded from. Only the
currently accessible memory locations are selectable.

Selection Internal memory | External memory 1 | Exter-
nal memory 2 | Shared memory

Default value Internal memory

Shared memory
The favorite will be saved in a shared directory on the network. The
shared directory is selected in the Edit device / Shared memory dia-
log (see chapter 10.3.3, page 69).

Method / Sample table

Method or sample table of the favorite.

Selection Selection of stored methods/sample tables

[More options]

Parameterize the autostart function, see following chapter.

More options

The autostart function is parameterized under [More options].
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Autostart

on | off (Default value: off)

If this option is activated, a new determination is started automatically at
the end of a determination. This continues until the number specified has
been reached (siehe Number of autostarts).

Number of autostarts

This option can only be edited when Autostart is activated.

Number of automatic starts.

Input range 1 to 9999 
Default value 1 
Selection Table

Table
The number of automatic starts corresponds to the number of samples
in the sample table.
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19 Sample data

You can enter the sample data (identification, sample size, etc.) in a variety
of ways:

￭ Directly in the main dialog.
￭ Using the sample table. This is particularly useful with sample series.

The sample table is a table in which the sample data for up to 999
samples can be entered (see chapter 20, page 162).

￭ Automatic request immediately after the start of the determination (see
chapter 19.2, page 160).

You can also send the sample size and the unit from a connected balance
in any case. With some balances, the sample identification and method
can be also sent (see chapter 31.4, page 312).

19.1 Entering sample data in the main dialog

For a sample, you can enter the sample data directly in the main dialog,
even while the determination is running (see chapter 22, page 173).

Identification 1

Sample identification. The sample identification can be used in calculations
as the variable CI1. If you have defined a sample identification list (see
chapter 14.1.1, page 118) then the entries can be selected here.

Entry 24 characters maximum
Default value empty
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Identification 2

Sample identification. The sample identification can be used in calculations
as the variable CI2. If you have defined a sample identification list (see
chapter 14.1.1, page 118) then the entries can be selected here.

Entry 24 characters maximum
Default value empty

Sample size

Sample size. The value of the sample size can be used in calculations as
the variable C00.

Input range –99999999 to 9999999999 
Default value 1.0 

Unit of sample size.

Entry 6 characters maximum
Selection g | mg | µg | mL | µL | pieces
Default value g

Unit defined in method:
The unit defined in the method is ignored. The unit entered in the sample
table is used.

Balance connected and configured:
Value from the connected balance.

Fixed sample size defined in method:
The value will be entered in the corresponding line when the method is
loaded. The existing entry will be overwritten.

19.2 Requesting sample data at the start of the determi-
nation

The sample data can be automatically requested immediately after the
start of the determination in order to ensure that the sample data entry is
not forgotten. This automatic inquiry is requisite for reweighing.
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To accomplish this, you must insert and configure the command
REQUEST in the method (see chapter 28.10.3, page 299).

If the Hold sequence parameter is activated, then the run will be paused
and must be continued with [Continue] after the sample data has been
entered. If the Hold sequence parameter is deactivated, then the deter-
mination will continue in the background until the measured data is
required for further processing. This dialog will be displayed until the
entering of the sample data is confirmed with [Continue], even if the
titration/measurement is already completed. This ensures that the sample
data is available for calculations.

If a fixed sample size has been defined in the method (see chapter 15.5.3,
page 141), then it will be displayed at the time of the entry but it will not
be editable.
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20 Sample table

20.1 General

Main dialog: Sample table

The sample table is a table in which the sample data for up to 999 sam-
ples can be entered. If you are processing larger-sized sample series, it
makes sense to enter the sample data in this table.

Activating the sample table

Proceed as follows to enable the sample table:

 

1 Opening the control dialog

￭ In the main dialog, tap on [Control].

The control dialog is displayed:

 

2 Activating the sample table

￭ Activate the Sample table option.

￭ Tap on the fixed key [ ].

The main dialog is displayed:
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The display will show the number of determinations already carried
out and the total number of sample lines containing data. The sam-
ple table is still empty in this example.

The sample table contains numbered lines; each line represents one deter-
mination. In the standard settings, the first sample identification and the
sample size of each sample are displayed. In the properties, you define the
columns to be displayed (see chapter 20.3, page 167).

[Load/ Save]

Load a saved sample table (see "Loading a sample table", page 165) or
save the current sample table (see "Saving a sample table", page 164).

[Properties]

Edit the properties of the sample table (see chapter 20.3, page 167).

[Insert line]

Insert a new line above the line selected.

[Delete]

Delete the selected line from the sample table.



20.1 General ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

164 ￭￭￭￭￭￭￭￭ 917 Coulometer

[Edit]

Edit the data of the selected line (see chapter 20.2, page 165).

Saving a sample table

NOTICE

Sample tables can only be saved on external storage media or on a
shared file system.

Proceed as follows to save a sample table:

 

1 Opening the dialog

￭ In the Sample table dialog, tap on the [Load/ Save] button.

The Sample table / Load/Save dialog is displayed.

If no external storage medium is plugged in or if no file system is
shared, then [Save] is disabled.

 

2 Modify/apply a name

￭ Tap on [Save].
A name is suggested for new sample tables. If the sample table
has already been saved, the previous name will be displayed.

Applying the name:

￭ Tap on [Save].

The sample table is saved.

Entering a new name:

￭ Tap on the input field File name.
The text editor opens.

￭ Enter a new file name (max. 32 characters) and confirm with
[OK].

￭ Tap on [Save].

The sample table is saved.
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Loading a sample table

Proceed as follows to load a sample table:

 

1 Display the list of saved sample tables

￭ In the Sample table dialog, tap on the [Load/ Save] button.
The Sample table / Load/Save dialog is displayed.
If no external storage medium is plugged in or if no file system is
shared, then [Load] is disabled.

￭ Tap on [Load].
The selection of memory locations is displayed. This selection will
be skipped if only one memory can be accessed.

￭ Select the memory location where the desired sample table is
stored.
The selection of file groups is displayed (see chapter 11.1, page
91). If only one group is available, then the list of the saved sam-
ple tables will be displayed directly.

￭ Select the group with the desired sample table.
￭ Tap on [Show files].

The list with the saved sample table is opened.

 

2 Select the sample table

￭ Select the desired sample table.

 

3 Loading a sample table

￭ Tap on [Load].

The sample table is now loaded.

20.2 Editing sample data
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At the very top you will see the line number of the selected line. In this
example, the sample data of the first line is displayed. You can scroll
between individual data sets with the keys [–] and [+].

Method

Method used for processing the sample.

If you use the sample assignment table (see chapter 14.1.2, page 119),
then the method can no longer be defined here.

Selection Selection of stored methods | empty
Default value empty

empty
The currently loaded method is used.

Identification 1

Sample identification. The sample identification can be used in calculations
as the variable CI1. If you have defined a sample identification list (see
chapter 14.1.1, page 118) then the entries can be selected here.

Entry 24 characters maximum
Default value empty

Identification 2

Sample identification. The sample identification can be used in calculations
as the variable CI2. If you have defined a sample identification list (see
chapter 14.1.1, page 118) then the entries can be selected here.

Entry 24 characters maximum
Default value empty

Sample size

Sample size. The value of the sample size can be used in calculations as
the variable C00.

Input range –99999999 to 9999999999 
Default value 1.0 

Unit of sample size.

Entry 6 characters maximum
Selection g | mg | µg | mL | µL | pieces
Default value g

Unit defined in method:
The unit defined in the method is ignored. The unit entered in the sample
table is used.
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Balance connected and configured:
Value from the connected balance.

Fixed sample size defined in method:
The value will be entered in the corresponding line when the method is
loaded. The existing entry will be overwritten.

NOTICE

The sample size limits defined in the method are not monitored when
the sample data is being entered in the sample table.

20.3 Properties

Method memory

Memory location the method is loaded from. All memory locations are
selectable, even if they are currently not accessible.

Selection Internal memory | External memory 1 | Exter-
nal memory 2 | Shared memory

Default value Internal memory

Shared memory
Shared directory in the network.

Display in table

Selection of the columns to be displayed in the sample table.

Selection Method | Identification 1 | Identification 2
Default value Identification 1
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Method
Only the assigned method is displayed for each sample.

Identification 1
The first sample identification and the sample size are displayed for
each sample.

Identification 2
The second sample identification and the sample size are displayed for
each sample.

Number of lines

Maximum number of lines which can be present in the sample table.

Input range 2 to 999 
Default value 99 

Lock editing

on | off (Default value: off)

If this option is activated, then the sample data can no longer be altered.

Display options

Configure the sample data to be displayed in the dialogSample table /
Edit (see ""Properties / Display options" dialog", page 168).

Editing options

Specify the settings for the processing of the sample data (see ""Proper-
ties / Editing options" dialog", page 168).

Identifications

Define the designations for the input fields of Identification 1 and Identifi-
cation 2 (see "Dialog "Properties / Identifications"", page 169).

"Properties / Display options" dialog

Sample table: Properties ▶ Display options

In this dialog, you can configure which of the following sample data can
be edited in the sample table:

￭ Method
￭ Identification 1
￭ Identification 2
￭ Sample size

"Properties / Editing options" dialog

Sample table: Properties ▶ Editing options

In this dialog, you can define the settings so that the input of the sample
data becomes simpler and faster.
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End line with

Selection as to with which input the editing dialog for the next sample is
automatically displayed.

Selection Sample size | Identification 1 | Identification
2 | manual

Default value Sample size

manual
The editing dialog for the next sample can be displayed with the [New
sample] button in the editing dialog.

If, for example, you have to enter similar data for each sample, then you
can automatically copy the data which is identical for each sample into
the next line:

￭ Method
￭ Identification 1
￭ Identification 2
￭ Sample size

Dialog "Properties / Identifications"

Sample table: Properties ▶ Identifications

In the dialog Properties / Identifications, you can alter the designations
for the sample identifications in accordance with specific methods.
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21 Determination run

This chapter provides a description of how to carry out a determination,
i.e. how to process a single sample or a sample series. The current sample
data is used for calculations.

21.1 Carrying out a single KFC determination

When you carry out a determination, you can enter the sample data in
various ways (see chapter 19, page 159). The following instructions
describe how to enter the sample data in the main dialog.

To carry out a single determination, proceed as follows:

 

1 Loading the method

￭ See Chapter "Loading a method", Page 134.

 

2 Starting conditioning

Tap on the fixed key [ ].

Conditioning starts. Conditioning... is displayed until the endpoint
is reached. The working medium is titrated to the endpoint. This is
indicated by Conditioning OK. The status is kept stable.

 

3 Starting a determination

￭ If Conditioning OK is displayed, tap on the [ ] fixed key.
Conditioning is stopped. The request for adding the sample will
be displayed.

￭ Tap on the fixed key [ ].

 

4 Adding sample

￭ Add sample into the titration cell.
Afterward, the request for the sample size is displayed.

 

5 Entering the sample size

￭ Tap on the input field Sample size in the dialog.
The number editor opens.

￭ Enter the sample size and confirm with [OK].

The KF titration is already executed in the background during the
entry of the sample size.
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After the confirmation of the sample size, the live curve of the titra-
tion is displayed.

Sequence of the determination

￭ After a determination is started, a check is made as to
– whether all of the devices required are connected and ready for

operation.
– whether the sensor is present.
– whether the monitoring intervals for the sensor and common

variables are still valid.
– if a sample assignment table is activated (see chapter 14.1.2,

page 119):
whether the entered sample identification is defined in the sam-
ple assignment table. If this is the case, then the assigned
method will be loaded automatically and the actual determina-
tion will be started.

21.2 Performing a sample series

You can use the following functions with sample series:

￭ Statistics for multiple determinations
The statistics calculations are enabled in the method options (see chap-
ter 15.5, page 137).

￭ Sample table
You can enter the sample data for an entire sample series in the sample
table (see chapter 20, page 162).

Sequence of the sample series

￭ After a determination is started, a check is made as to
– whether all of the devices required are connected and ready for

operation.
–
– whether the sensor is present.
–
– whether the monitoring intervals for the sensor and common

variables are still valid.
– if a sample assignment table is activated (see chapter 14.1.2,

page 119):
whether the entered sample identification appears in the sample
assignment table. If this is the case, then the assigned method
will be loaded automatically and the actual determination will be
started. If a different method has been entered in the sample
table, then it will be ignored.
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￭ At the end of the determination,
– the line in the sample table is deleted.
– the next determination is started (if you are working with the

autostart function enabled (see chapter 17, page 151)).

21.3 Canceling determinations manually

You can cancel a determination at any time with the fixed key [ ]. The
command being carried out at that moment is canceled and only calcula-
tions and reports are executed or created.

If you are working with the autostart function activated (see chapter 17,
page 151), the entire series will be canceled.

NOTICE

If you do not wish to cancel the entire determination, but only the cur-
rent command, use the function [Cancel command] in the live display.

The subsequent method commands are carried out normally.
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22 Live modifications

22.1 Editing the sample data of the running determina-
tion

The sample data can be entered or modified in the main dialog while a
determination is running. The sample data entered at the end of the
determination is always used in calculations.

Proceed as follows to edit the sample data:

 

1 Display the main dialog

￭ Tap on the fixed key [ ].

The main dialog is displayed. The determination continues to run in
the background.

 

2 Edit the sample data

￭ Edit the sample data and apply with [OK].

 

3 Display the live dialog

￭ Tap on [Live display].

The live dialog is displayed once again.

NOTICE

Make sure that the input dialogs are closed before the determination is
ended. Otherwise the determination will have to be recalculated.
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22.2 Editing the sample table while a determination is
running

You can insert new lines or delete existing ones or edit sample data while
a determination is running.

NOTICE

To ensure that no problems arise during the run and that the current
data is always available for the calculation, we recommend that the
input dialogs always be closed.

Editing the sample table

Proceed as follows to edit the sample table:

 

1 Display the main dialog

￭ Tap on the fixed key [ ].

The main dialog is displayed. The determination continues to run in
the background.

 

2 Select the sample data

￭ Tap on Sample table.
The sample table is displayed. The first line always contains the
sample data of the running determination.

￭ Select the desired line.
￭ Tap on the button [Edit].

 

3 Edit the sample data

￭ Edit the sample data and apply with [OK].

NOTICE

In addition to the sample data, the method can also be modified,
except in cases where the determination is running.

 

4 Display the live dialog

￭ Tap on the fixed key [ ].
The main dialog is displayed.

￭ Tap on [Live display].
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The live dialog is displayed once again.

22.3 Live display

Main dialog: Live display

The current method and the system status are displayed in the title line.
The currently running command is displayed directly underneath the title
line.

The following functions are available to you while a determination is run-
ning:

￭ [Hold]
Pause the determination. The label changes to [Continue]. This can be
used to continue the run.

￭ [Cancel command]
Cancel the current method command. The next command is started.

￭ [View] (only for titrations/measurements)
To modify the settings for the curve and measured value display, see
below.

￭ [Sample data] (visible only if a titration or a measurement is not cur-
rently running)
Switch to the main dialog in order to edit the sample data.

￭ [Edit parameters]
Edit the method options and live parameters (see chapter 22.4, page
176).

￭ [Results]
Display the results dialog (see chapter 23, page 178).

Dialog "View"

Main dialog: Live display ▶ View

View

Type of curve display.

Selection Curve | Curve & meas. values | Measured val-
ues | Curve & sample data

Default value Curve & meas. values

Curve
Only the curve is displayed.

Curve & meas. values
The measured values are displayed to the right next to the curve.

Measured values
Only the measured values are displayed.

Curve & sample data
The sample data is displayed to the right next to the curve.
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[Meas. value options]

Define settings for the display of the measured values.

A maximum of three different values can be displayed at the same time.
The selection depends on the titration/measuring mode. The settings are
saved separately for each mode.

[Curve options]

Define the settings for the curve display (see "Curve options", page 191).
The settings are saved separately for each titration/measuring mode and
apply not only for the live display but also for the curve display in the
results dialog.

22.4 Live parameters

Live display: Edit parameters

Certain method parameters can be edited while a determination is being
carried out. The modified parameters are taken into account at once. If
you modify, for instance, the start conditions after the start volume has
been dosed, then these modifications will not be taken into account until
the next determination.

NOTICE

If the live modifications are also to be used in the future, then the
method must be saved after the determination has been completed.
The live modifications are discarded as soon as you load a new method.

If you are working with the sample table and a different method is used
for the next sample, then the live modifications will be discarded.

Proceed as follows to modify method parameters during an ongoing
determination:

 

1 Select the method command

￭ Tap on Edit parameters.
The command sequence is displayed.
[Edit command] is enabled only for those commands for which
the live parameters can be edited.
All of the functions except for the method properties can be
edited with [Method options].

￭ Select the desired method command.
￭ Tap on [Edit command].
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2 Edit the method parameters

￭ Change the desired parameters accordingly.

 

3 Display the live dialog

￭ Tap on the fixed key [ ].
The main dialog is displayed.

￭ Tap on [Live display].

The live dialog is displayed once again.
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23 Results and more determination data

Main dialog: Results

Detailed specifications concerning the current determination are displayed
in the Results dialog:

￭ Current method
Method with which the determination was carried out.

￭ Determination
Name of the determination. Displayed only if the determination has
been saved.

￭ Determination time
Date and time at which the determination was carried out.

￭ Results
Calculated results. If monitoring of the result limits is activated, then
the result will be highlighted in color:

– Green lettering: The result is within the limits
– Red lettering: The result is outside the limits

￭ Commands
List of the data-generating commands (titrations, measurements, etc.).
The most important data is displayed for each command.

[Result table]

Open result table (see chapter 25, page 199). The result table is a table in
which the results for several determinations can be saved.

[Statistics]

Display the statistical overview of a determination series (see chapter 24,
page 194).
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[Recalculate]

Recalculate the determination. The procedure will be executed immedi-
ately. Recalculation cannot be undone (see chapter 23.8, page 193).

[Sign]

Sign the current determination.

If the method contains a command SIGN, then this button will be dis-
played instead of [Recalculate]. The determination can be signed directly
on level 1 (with a second command also on level 2).

[Curve]

Display the curve of the current determination (see chapter 23.7, page
191).

[More data]

Display detailed specifications for the determination (determination prop-
erties, measuring point list, endpoint details, etc.), save determination (see
chapter 23.1, page 179).

23.1 More determination data

Results dialog: More data

All of the commands for which you can display other data (titrations,
measurements, evaluations, etc.) are listed in the Results / More deter-
mination data dialog.

[Load/ Save]

Load saved determinations(see chapter 23.5, page 185) and save current
determination (see chapter 23.6, page 190).

[Properties]

Display the properties of the current determination (see chapter 23.4,
page 183).
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[Local com. var.]

(available only with loaded determinations)

Display the list of the common variables defined at the time of the deter-
mination (see chapter 23.3, page 182).

[Messages]

Display list with all of the messages which occurred during the determina-
tion (see chapter 23.2, page 182).

[View data]

Display all of the details for the selected command.

23.1.1 Details
Results dialog: More data ▶ View data

All of the variables generated by the determination are listed in the More
determination data / View data dialog. These can be used in calcula-
tions.

[Titrant data]

(available only with loaded determinations)

Display titrant data which was valid at the time of the determination .

[Endpoint details]

Display details for each endpoint found (see "Endpoint details", page
181).

[Measuring point list]

Display measuring point list of titrations and measurements (see "Measur-
ing point list", page 180).

Measuring point list

Results dialog: More data ▶ View data ▶ Measuring point list
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Results dialog: Curve ▶ Display curve ▶ Measuring point list

The individual measured values are listed in the View data / Measuring
point list dialog. You can configure which columns are displayed ([View]
button). These settings are saved separately for each mode (KFC, MEAS,
etc.).

Column 1 / Column 2 / Column 3

Quantity displayed in the columns 1, 2 and 3. Both the selection of the
quantities and the default setting depend on the mode.

Selection Measured value | Water | Bromine | Time |
 Temperature | Drift | Index

Endpoint details

Results dialog: More data ▶ View data ▶ Endpoint details

Results dialog: Curve ▶ Display curve ▶ Endpoint details

Detailed information concerning each equivalence point or endpoint
determined is displayed in the View data / Endpoint details dialog.
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23.2 Messages

Results dialog: More data ▶ Messages

If messages occurred during a determination, they will be displayed in the
More determination data / Messages dialog. The following data for
the message is indicated under [Details]:

￭ Message number
Unique identification number.

￭ Time
Moment that the message occurred.

￭ Message
Message text.

23.3 Local common variables

Results dialog: More data ▶ Local com. var.

The list of common variables as it existed at the time of the determination
is displayed in the More determination data / Local common varia-
bles dialog.

NOTICE

Recalculation:

The common variables can be modified retroactively. The values dis-
played here are used for the recalculation of a loaded determination.
The list of common variables in the System / Common variables dia-
log is not changed as a result.
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23.4 Determination properties

Results dialog: More data ▶ Properties

Detailed information concerning the determination is displayed in the
More determination data / Properties dialog:

￭ User
User who carried out the determination.

￭ Sample number
Number which was entered in the dialog Control at the start of the
determination.

￭ Start counter
This value, just like the sample number, is increased by one each time a
determination starts. In contrast to the sample number, this value can-
not be modified by the user.

￭ Duration determ.
Duration of the entire determination.

￭ Method status
Current status of the method.

– new
The method has been newly created and not yet saved.

– saved
The current method has been saved.

– modified
The current method has been modified but not saved yet (e.g
live modification).

– reviewed
The current method has been signed at level 1.

– released
The current method has been signed at level 2.

￭ Determination
Name of the determination. Displayed only with saved determinations.

￭ End of determin.
Way in which the determination was ended.

– Regular without errors
The determination was automatically ended at the end of the
method.

– Manual stop
The determination has been canceled with the fixed key [ ].

– Error
The determination has been canceled due to an error.
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￭ Status of deter.
– original

The determination has not been recalculated.
– recalculated

The determination has been recalculated.
– loaded

The determination has been loaded.
– saved

The determination has been saved. The version number indicates
how many times the file has been saved.

– reviewed
The determination has been signed at level 1.

– released
The determination has been signed at level 2.

The following data is displayed only if the option Recalculating deter-
mination under Login options / Modification options is activated:

￭ Recalculated by
User who recalculated the determination.

￭ Recalculated on
Date and time at which the determination was recalculated.

￭ Reason
Reason for the recalculation of the determination.

￭ Comment
Comment for the recalculation of the determination.

The following information is displayed only if the determination has been
signed at level 1:

￭ Reviewed by
User who signed the determination at level 1.

￭ Reviewed on
Date and time at which the determination was signed at level 1.

￭ Reason
Reason for the signing of the determination.

￭ Comment
Comment for the signing of the determination.

The following information is displayed only if the determination has been
signed at level 2:

￭ Released by
User who signed the determination at level 2.

￭ Released on
Date and time at which the determination was signed at level 2.

￭ Reason
Reason for the signing of the determination.
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￭ Comment
Comment for the signing of the determination.

[Delete signature]

Delete all of the signatures for the method or the determination. This but-
ton is inactive if level 2 has not yet been signed (see chapter 16.2, page
150).

[Sign]

Sign the method or determination. This button is active only when work-
ing with activated login function and password (see chapter 16.1, page
149).

23.5 Loading a determination

Proceed as follows to load a determination:

 

1 Opening the determination list

￭ In the results dialog, tap on [More data].
￭ Tap on [Load/ Save].
￭ Tap on [Load].

The selection of memory locations is displayed. This selection will
be skipped if only one external storage medium is available.

￭ Select the memory location where the desired determination is
saved.
The selection of file groups is displayed (see chapter 11.1, page
91). If only one group is available, then the determination list will
be displayed directly.

￭ Select the group with the desired determination.
￭ Tap on [Show files].

The determination list with the stored determination opens:



23.5 Loading a determination ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

186 ￭￭￭￭￭￭￭￭ 917 Coulometer

 

2 Selecting a determination

￭ Select the desired determination.

 

3 Loading the determination

￭ Tap on [Load].

The determination is now loaded. The properties are displayed in the
results dialog.

NOTICE

When you load a determination, the method with which the
determination was carried out will be loaded automatically.

For this reason, save any modifications which may have been
made to the method currently loaded before you load a determi-
nation.

23.5.1 Determination list
Results dialog: More data ▶ Load/ Save ▶ Load ▶ Show
files ▶ View

In the Show files / View dialog you can depict the individual determina-
tions in greater detail. The sorting criterion and the number of saved
determinations are displayed at the very top. The list contains numbered
lines; each line represents one determination. In the default settings, the
first sample identification and the first calculated result of each determina-
tion are displayed. In the properties, you define which data is displayed in
the columns and the criteria according to which the determinations are
sorted (see "Properties", page 187). In addition, you can define search fil-
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ters to aid you in finding the desired determinations (see "Filter criteria",
page 188).

[Previous 100]

Display the previous 100 determinations.

[Next 100]

Display the next 100 determinations.

[Properties]

Configure the display of the columns and define filter criteria.

[Delete]

Delete the selected file.

[Load]

Load the selected file.

Properties

Determination list: Properties

In the View / Properties dialog, you can define which data is displayed
in the columns and the criteria according to which the determinations are
to be sorted.

Column 1

Selection of what is to be displayed in the first column.

Selection Identification 1 | Identification 2 | Determ.
time | Result name | Method | Sample size |
 User

Default value Identification 1

Column 2

Selection of what is to be displayed in the second column.
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Selection Result 1…9
The numbering of the results corresponds to the
order in which the results were calculated in the
determination run.

Sort by

Selection according to which criterion the list is to be sorted.

Selection Identification 1 | Identification 2 | Determ.
time | Result | Method | Sample size | User

Default value Determ. time

Identification 1
Sort alphabetically according to the first sample identification.

Identification 2
Sort alphabetically according to the second sample identification.

Determ. time
Sort chronologically according to the determination time.

Result
Sort according to the numerical value of the result.

Method
Sort alphabetically according to the method name.

Sample size
Sort according to the numerical value of the sample size.

User
Sort alphabetically according to the user who carried out the determi-
nation.

Sort sequence

Selection ascending | descending
Default value descending

[Filter]

Specify the filter criteria for the list.

Filter criteria

Determination list: Properties ▶ Filter
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You can set filters in the Properties / Filter dialog. A filter is a rule defin-
ing what is to be displayed in the determination list. If a filter has been set,
this is indicated with a corresponding symbol in the Show files / View
dialog.

Filter

Define the criterion according to which the list is to be filtered. The only
lines which will be displayed are those which fulfil the filter criterion.

Selection no filter | Identification 1 | Identification 2 |
 Date | Result | Method | Sample size | User

Default value no filter

no filter
The list itself will not be filtered.

Identification 1
In the input field is equal to, select or enter the first sample identifica-
tion according to which filtering is to be carried out.

Identification 2
In the input field is equal to, select or enter the second sample identi-
fication according to which filtering is to be carried out.

Date
In the input fields Date from … to, specify the period of time accord-
ing to which filtering is to be carried out.

Result
In the input fields Value from … to, specify the value range according
to which filtering is to be carried out.

Method
In the field is equal to, select or enter the method name according to
which filtering is to be carried out.

Sample size
In the input fields Value from … to, specify the value range according
to which filtering is to be carried out.
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User
In the field is equal to, select or enter the user according to whom
filtering is to be carried out.

NOTICE

The filter can be applied to empty fields as well, for example, if no sam-
ple identification has been entered. In this case, select only the desired
filter criterion and leave the fields below empty.

23.6 Saving a determination

Results dialog: More data ▶ Load/ Save ▶ Save

Determinations can be saved as follows:

￭ Manually in this dialog.
The suggested default setting for file names is the first 16 characters of
Identification 1, followed by the determination time in the format
YYYYMMDD-hhmmss. Extending the file name with the determination
time has the advantage that the file names of all determinations are
unique.

￭ Automatically at the end of the determination (see chapter 15.5.6,
page 146).

The following data is stored for each determination:

￭ Calculated results
￭ Measuring point lists, equivalence points, curves and variables which

were generated during the determination
￭ Determination properties
￭ Statistics (if carried out)
￭ Method with which the determination was carried out
￭ Common variables (values and properties of all common variables at

the time of the determination)
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23.7 Curves

Results dialog: Curve

The curve of the current determination is displayed in the Results / Curve
dialog. You can configure the curve display.

[Endpoint details]

Display details for each endpoint found (see "Endpoint details", page
181).

[Measuring point list]

Display measuring point list of titrations and measurements (see "Measur-
ing point list", page 180).

[Curve options]

Define the settings for the curve display (see "Curve options", page 191).
The settings are saved separately for each titration/measuring mode and
apply not only for the live display but also for the curve display in the
results dialog.

Curve options

Results dialog: Curve ▶ Curve options
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You can make the settings for the curve display in the Curve / Options
dialog. These settings are saved separately for each mode (KFC, MEAS,
etc.) and also apply for the live display. Both the selection of the quantities
and the default setting depend on the mode.

x axis

Quantity which is shown on the x axis of the graph.

y1 axis

Quantity which is shown on the y1 axis of the graph.

y2 axis

Quantity which is shown on the y2 axis of the graph.

Color

Selection of a color for the curves.

Grid

on | off (Default value: on)

If this parameter is activated, grid lines are shown.

Display measuring points

on | off (Default value: off)

If this parameter is activated, the curve is shown with the single measured
values.
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23.8 Recalculation and reevaluation

Results dialog: Recalculate

You can use the [Recalculate] function to recalculate and reevaluate
determinations. This is necessary in the following cases:

￭ If you have modified the evaluation parameters in a way that changes
the recognized endpoints or equivalence points.

￭ If you have modified the calculations.
￭ If you have modified the variables used in calculations, e.g. sample size,

titer or common variables.

NOTICE

Neither the recalculation nor the reevaluation can be undone.

We therefore recommend that the original determination be saved
beforehand (see chapter 23.6, page 190). The best way of doing this is
to use the Save determination automatically function (see chapter
15.5.6, page 146).

The following method commands are executed once again with the
[Recalculate] function:

￭ EVAL commands:
All evaluations are carried out again. You can also insert new evalua-
tions retroactively.

If a determination has been recalculated, this will be documented in the
determination properties (see chapter 23.4, page 183).

Recalculation/reevaluation of loaded determinations

With loaded determinations, it is assumed that they were carried out a
long time ago and that the common variables of the system no longer
correspond to those of the determination. This is why the list of common
variables is stored with each determination. This data will be used if you
recalculate a loaded determination. If you wish to recalculate the result
with a corrected common variable, you must therefore modify the
respective values in the More determination data / Local common
variables or More determination data / View data dialog.

If a result is assigned to a common variable, then the common varia-
ble which is currently valid in the system will not be overwritten until after
a query has been confirmed.

The recalculated results of loaded determinations are not saved in the
result table.
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24 Statistics

Main dialog: Results ▶ Statistics

In the dialog Results, you can use [Statistics] to display the statistical
overview of a determination overview. You can statistically evaluate a
maximum of nine results calculated in a determination. A statistical series
can contain a maximum of 20 determinations.

Activating the statistics function

Proceed as follows to activate the statistics function:

 

1 Editing the method options

￭ In the main dialog, tap on [Edit parameters].
￭ Tap on [Method options].

￭ Activate the Statistics option.
￭ Under Number of determinations, enter the desired number of

determinations.

The results for which statistical calculations are performed are
defined in the calculation command CALC (see "Variable for mean
value", page 123).
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In this dialog, the method with which the determination was carried out is
displayed in the first line. The second line shows how many determina-
tions have already been carried out and the total number of determina-
tions to be carried out. The name of the result and the mean value are
shown for each result.

[Add determ.]

Add a further determination to the determination series (see chapter 24.3,
page 197).

[Details]

Display the statistics results for the selected result and the single results
from all determinations, see next chapter.

NOTICE

If you recalculate a determination, the statistics for this determination
are also recalculated.
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24.1 Displaying details for a result

Results dialog: Statistics ▶ Details

In the dialog Statistics / Details, the following details are displayed:

￭ Result name
￭ Mean value

On the right-hand side of the dialog the number of single results from
which the mean value was calculated is displayed. In this example, it is
3.

￭ Absolute standard deviation (s abs)
￭ Relative standard deviation (s rel)
￭ Result and sample size of each single determination

Results that could not be calculated are indicated with invalid and
ignored.

[Sample data]

Display the sample data of the selected determination.

[Determ. on/off]

Remove all of the results of the selected determination from the statistics.
All of the entries of this line are marked with an asterisk (*), the statistics
will be recalculated automatically.

[Result on/off]

Remove the selected result from the statistics. The result is marked with an
asterisk (*), the statistics will be recalculated automatically.
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NOTICE

If the mean value has been assigned to a common variable (see CALC
command), then the determination must be recalculated manually (see
chapter 23.8, page 193)

24.2 Deleting statistical data

In the dialog Control, you can delete all of the statistics data manually
with the function [Delete statistics]. The statistics data is deleted auto-
matically in the following cases:

￭ when all of the determinations of the determination series have been
carried out and a new determination has been started afterwards.

￭ when a new method is loaded (even if it is the same method)
If the sample table or the sample assignment table is used, the
statistics data is only deleted when another method is loaded.

24.3 Adding a determination to a determination series

You can use the function [Add determ.] to add an additional sample to a
determination series, e.g. because a determination was faulty and had to
be removed from the statistics.

The number of determinations by which the set statistics counter has been
increased is shown above the list in brackets. This modification is also dis-
played in the main dialog and in the statistics report.
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NOTICE

The number of samples defined in the method options does not, how-
ever, change as a result.
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25 Result table

Main dialog: Results ▶ Result table

The result table is suitable for displaying in detail the results of all of the
determinations performed on a single day, for instance. You can save the
results of up to 200 determinations. A maximum of 9 results from a single
determination can be saved in the result table. You define which results
from this table are to be saved using the CALC command. Because the
size of the display is not sufficient to display all of the data at the same
time, it is practical to print out the result table.

The sorting criterion and the number of determinations from which results
are saved in the result table are displayed at the top. The list contains
numbered lines; each line represents one determination. In the default set-
tings, the first sample identification and the first calculated result of each
determination are displayed. In the properties, you define which data is
displayed in the columns and the criteria according to which the determi-
nations are sorted (see chapter 25.1, page 200). In addition, you can
define search filters to aid you in finding the desired determinations (see
"Filter criteria", page 202).

[Load/ Save]

Load a saved result table (see chapter 25.3, page 204) or save the current
result table (see chapter 25.2, page 204).

[Properties]

Configure the display of the columns and define filter criteria.

[Delete all]

Delete the result table completely.
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[Delete]

Delete the selected line from the result table.

[Details]

Display details concerning the selected determination.

"Result table / Details" dialog

The following determination data is displayed in this dialog:

￭ User
User who carried out the determination.

￭ Method
Method with which the determination was carried out.

￭ Determ. time
Date and time at which the determination was carried out.

￭ Sample data (Identification 1 and 2 and sample size).
￭ All of the results of this determination saved in the result table.

25.1 Properties

Result table: Properties

In the Result table / Properties dialog, you can select the data to be
displayed with each determination as well as the sorting criterion for the
list.

Column 1

Selection of what is to be displayed in the first column.

Selection Identification 1 | Identification 2 | Determ.
time | Result name | Method | Sample size |
 User

Default value Identification 1
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Column 2

Selection of what is to be displayed in the second column.

Selection Result 1…9
The numbering of the results corresponds to the
order in which the results were calculated in the
determination run.

Sort by

Selection according to which criterion the list is to be sorted.

Selection Identification 1 | Identification 2 | Determ.
time | Result | Method | Sample size | User

Default value Determ. time

Identification 1
Sort alphabetically according to the first sample identification.

Identification 2
Sort alphabetically according to the second sample identification.

Determ. time
Sort chronologically according to the determination time.

Result
Sort according to the numerical value of the result.

Method
Sort alphabetically according to the method name.

Sample size
Sort according to the numerical value of the sample size.

User
Sort alphabetically according to the user who carried out the determi-
nation.

Sort sequence

Selection ascending | descending
Default value descending

Max. number of lines

If the result table contains the quantity of lines defined here, then no fur-
ther results can be saved. If this is the case, save the result table and cre-
ate a new one.

Input range 10 to 200 
Default value 100 

[Filter]

Specify the filter criteria for the list.
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[Delete automat.]

Define the settings for the automatic deletion of the result table (see
"Deleting the result table automatically", page 203).

Filter criteria

Result table: Properties ▶ Filter

You can set filters in the Properties / Filter dialog. A filter is a rule defin-
ing what is to be displayed in the result table. If a filter has been set, this is
indicated with a corresponding symbol in the Results / Result table dia-
log.

Filter

Define the criterion according to which the list is to be filtered. The only
lines which will be displayed are those which fulfil the filter criterion.

Selection no filter | Identification 1 | Identification 2 |
 Date | Result | Method | Sample size | User

Default value no filter

no filter
The list itself will not be filtered.

Identification 1
In the input field is equal to, select or enter the first sample identifica-
tion according to which filtering is to be carried out.

Identification 2
In the input field is equal to, select or enter the second sample identi-
fication according to which filtering is to be carried out.

Date
In the input fields Date from … to, specify the period of time accord-
ing to which filtering is to be carried out.
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Result
In the input fields Value from … to, specify the value range according
to which filtering is to be carried out.

Method
In the field is equal to, select or enter the method name according to
which filtering is to be carried out.

Sample size
In the input fields Value from … to, specify the value range according
to which filtering is to be carried out.

User
In the field is equal to, select or enter the user according to whom
filtering is to be carried out.

NOTICE

The filter can be applied to empty fields as well, for example, if no sam-
ple identification has been entered. In this case, select only the desired
filter criterion and leave the fields below empty.

Deleting the result table automatically

Result table: Properties ▶ Delete automat.

In the Properties / Delete automatically dialog, you define when the
contents of the result table is to be automatically deleted.

Delete oldest line only

on | off (Default value: off)

If this option is activated at the same time that the result table is full, the
oldest entry will be deleted as soon as the results of a new determination
are saved.

Time when result table is deleted:

Switch on

on | off (Default value: off)

If this option is activated, then the result table will be deleted each time
you switch on the Coulometer.

Start a new sample series

on | off (Default value: off)

If this option is activated, then the result table will be deleted when you
start a new sample series (with activated autostart function!).
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Save result table

on | off (Default value: on)

If this option is activated, the result table will be deleted as soon as you
have saved it.

25.2 Saving the result table

NOTICE

When you save the result table, the complete determination will not be
saved with each entry. If you wish to save the determination data for
each determination, use the Save determination automatically
function (see chapter 15.5.6, page 146).

25.3 Loading the result table

Proceed as follows to load a result table:

 

1 Opening the current result table

￭ In the results dialog, tap on [Result table].
￭ Tap on [Load/ Save].
￭ Tap on [Load].

The selection of memory locations is displayed. This selection will
be skipped if only one external storage medium is available.

￭ Select the memory location where the desired result table is
saved.
The selection of file groups is displayed (see chapter 11.1, page
91). If only one group is available, then the list of the saved result
tables will be displayed directly.

￭ Select the group with the desired result table.
￭ Tap on [Show files].

The list with the saved result tables opens.

 

2 Selecting the result table

￭ Select the desired result table.

 

3 Loading the result table

￭ Tap on [Load].

The result table is now loaded and will be displayed immediately.
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26 Printing

Reports can be printed out as follows:

￭ Manually with the [ ] fixed key in this dialog.
The fixed key is disabled while a determination is running.

￭ Automatically in the determination run with the command REPORT
(see chapter 28.6, page 271).

This screenshot shows the printing dialog associated with the main dialog.
The sample data is entered in the main dialog, which is why you can print
out the sample data from there in a context-sensitive manner with [Cur-
rent sample data].

The following buttons are also available in the other print dialogs:

[Report seq. as def. in method]

Print out all of the reports which are defined in the loaded method.

[Print screenshot]

Activate the "Print Screen" function. The current screen contents will be
printed out the next time the fixed key [ ] is tapped on.

[Report options]

Defining the general settings for the report output.

[Clear spooler]

Delete all outstanding printing orders.

[More reports]

Open the list of available reports.

More reports

Fixed key [ ]: More reports
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The dialog Print / More reports displays a list of all of the available
reports.

NOTICE

If you are using a CUSTOM Neos printer, you can print only the
reports marked with a #. The designation on the reports is only visible
once the CUSTOM NEOS printer is selected (see screenshot above).

[System reports]

Opening the list of reports for the system settings.

NOTICE

If you are using a CUSTOM NEOS printer, you cannot print system
reports.

[Method reports]

Opening the list of reports for the current method.

NOTICE

If you are using a CUSTOM NEOS printer, you cannot print method
reports.

[Send]

Create a PC/LIMS report.

[Edit]

Edit the settings of the selected report.
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[Print]

Print the selected report.

26.1 General report options

Fixed key [ ]: Report options

The settings for the report printout can be adjusted in the dialog Print /
Report options to indicate, for example, whether a report header, a sig-
nature line or a frame is to be printed.

Report header

Defining the output of the report header. The report header contains gen-
eral information such as device type, serial number, program version and
the printing date.

NOTICE

You can also define your own report header, which is printed in addi-
tion to this report header (System ▶ Templates ▶ Report header).

Selection off | once | on each page
Default value on each page

off
The report header will not be printed.

once
The report header will only be printed on the first page.

on each page
The report header will be printed on every page.

Signature line

Output of a special line for date and signature. This line will be printed at
the very bottom of every page.

Selection off | once | on each page
Default value off

off
No signature line will be printed.

once
The signature line will only be printed on the last page.

on each page
The signature line will be printed on every page.



26.2 Settings of the individual reports ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

208 ￭￭￭￭￭￭￭￭ 917 Coulometer

Frame

on | off (Default value: on)

If this parameter is activated, a frame is printed as lateral marking.

26.2 Settings of the individual reports

Fixed key [ ]: More reports ▶ Report ▶ Edit

Command REPORT: Report ▶ Edit

Settings can be edited for the following reports (for details, see online
help):

￭ Result report
￭ Curve

Definition of the curve size, display of the individual measuring points
and grid lines, etc.

￭ Measuring point list
Definition of the method command to which the measuring point list is
to be printed.

￭ Calculations
Definition of the accuracy with which the variables used as well as the
results calculated are printed.

￭ Statistics short
Definition of the time at which the report is to be printed (with each
determination or only at the end of a sample series).

￭ Statistics overview
Definition of the time at which the report is to be printed (with each
determination or only at the end of a sample series).

￭ Sample table
￭ Result table

Definition of the time at which the report is to be printed (with each
determination, at the end of a sample series or at the end of the sam-
ple table).

￭ Used devices
￭ Variables
￭ Monitoring
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26.3 List of all printable reports

The following reports can be printed out with the fixed key [ ]:

NOTICE

If you have selected a CUSTOM NEOS printer, you can print only the
reports that are marked with a # on the display.

Report Contents

Result report # Report with determination properties, sample data, calcu-
lated results, etc. If there are multiple determinations, the
statistics will also be printed out.

Curve # Curve report. The settings for the curve print-out are adop-
ted from the curve options of the live display.

Measuring point list # Measuring point list report.

Calculations # Details concerning the calculations carried out (parameter
settings in accordance with the CALC command and the
calculated results).

Used devices  The devices used for the determination, as displayed in the
More determination data / Properties dialog.

Variables  All determination variables, as displayed in the results dia-
log.

Monitoring  Details for the monitored quantities.

Statistics

Statistics short # Summary of the statistics calculations. The number of
determinations, the mean value, and the absolute and rela-
tive standard deviations are printed out for each result.

Statistics overview # Detailed statistical overview. The sample data and all indi-
vidual results are printed out for each determination. The
number of determinations, the mean value, and the abso-
lute and relative standard deviations are printed out for
each result.

PC/LIMS
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Report Contents

PC/LIMS report  Machine-readable report with all of the important data for
a determination. This report can be saved as a TXT or
UTF-8 file or sent to a terminal program or a LIMS via an
RS-232 interface. The definition is carried out in the device
manager (see chapter 10.3.2, page 68).

Sample data

Current sample data  Sample data of the current determination, context-sensi-
tive only from the main dialog.

Sample table  List of all determinations in the sample table with the
respective sample data, as entered in the sample table.

Result table

Result table  List of all determinations in the result table with results and
with the determination data, as saved in the result table.

More reports ▶ Method reports

Method sequence  Method properties and the list of all method commands.

Parameters full  Method properties and options, all method commands
with all parameters.

All parameters which no longer have their default settings
will be printed in bold. All parameters which have been
modified in comparison to the stored version of the
method are indicated by an *.

Titration & measuring
param.

 Method properties; titration and measuring commands
with all parameters.

All parameters which no longer have their default settings
will be printed in bold. All parameters which have been
modified in comparison to the stored version of the
method are indicated by an *.

Modified parameters  Method properties, all method parameters which have
been modified in comparison to the stored version of the
method.

Non default parameters  Method properties, all method parameters which no longer
have any default settings.

More reports ▶ System reports

System settings

System settings  Settings for acoustic signals and accuracy of the measured
value display.
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Report Contents

Dialog options  Settings for routine dialog and expert dialog.

User list  List with all of the users configured in the system, together
with their data, context-sensitive only from the user list.

Login options  Login options, context-sensitive only from the respective
dialog.

Sensors

Sensor list  List of all the sensors configured in the system.

All sensor data short  The most important sensor data for all sensors.

All sensor data full  All of the sensor data for all of the sensors (name, working
life, etc.).

Sensor data short  The most important sensor data of the selected sensor,
context-sensitive only from the editing dialog.

Sensor data full  All of the sensor data of the selected sensor, context-sensi-
tive only from the editing dialog.

Device manager

Device list  List of all devices configured in the system.

All device properties  Properties of all the devices configured in the system.

Device properties  Properties of the selected device, context-sensitive only
from the editing dialog.

GLP manager

GLP data  All data stored in the GLP manager.

Common variables

Common variable list  List of all the common variables defined in the system,
together with their most important data (name, value, sta-
tus).

All common variable proper-
ties

 Properties of all common variables (name, value, validity,
status).

Common variable properties  Properties of the selected common variable (name, value,
validity, status), context-sensitive only from the editing dia-
log.

Local Common variable list  List with the common variables available at the time of the
determination, together with their most important data
(name, value, status), context-sensitive only from the dia-
log "More determination data / Local common variables".
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Report Contents

Local common var. proper-
ties

 Properties of the selected common variable (name, value,
validity, status), context-sensitive only from the dialog
"More determination data / Local common variables".

Templates

Templates sample data  Sample identification list and sample assignment table.

Result template list  List with all of the user-generated result templates.

All result templates details  Details of the all of the user-generated result templates
(calculation formula, result options, note).

Result template details  Details of the selected result template, context-sensitive
only from the editing dialog.

Input/Output lines  List with all of the defined input and output lines at the
remote interface (name, bit pattern).
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27 Manual control

The following functions are available in the manual control:

[Measure]

Carrying out manual measurements (see chapter 27.2, page 215).

Measuring modes:

￭ Ipol (voltametric measurement with selectable polarization current)
￭ Upol (amperometric measurement with selectable polarization voltage)
￭ T (temperature measurement)

[Dosing]

NOTICE

Only active if a Dosino or dosing unit is connected.

Manual dosing (see chapter 27.3, page 217).

The following dosing functions are available:

￭ Preparing the exchange unit or dosing unit
￭ Emptying the dosing unit
￭ Filling the dosing cylinder of the exchange unit/dosing unit
￭ Dosing a specified volume
￭ Dosing continuously

[Stir]

Controlling the stirrer manually (see chapter 27.4, page 223).
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[Remote]

Scanning the input lines on the remote interface and setting the output
lines (see chapter 27.5, page 224).

27.1 Opening and closing the manual control

Opening the manual control

 

1 Opening the dialog window

￭ Tap on the fixed key [ ].

Manual control opens:

 

2 Select the function

￭ Tap on the button for the desired function.

If the function can be carried out by several devices, a dialog to
select the device will appear first; otherwise the dialog for the
selected function will appear immediately.

Closing the manual control

 

1 ￭ Tap on the fixed key [ ].
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NOTICE

Manual control can also be exited when a manual sequence has been
started but has not yet ended. The fact that a sequence has been
started in manual control can be recognized by the corresponding sym-
bol in the title line (see chapter 6.2.3, page 34).

27.2 Measuring

Manual control ▶ Measure

Manual measurements can be carried out with the function [Measure].

Proceed as follows:

 

1 Selecting a sensor

￭ Select the desired sensor from the sensor list.
All of the sensors available in the sensor list are displayed. Sensors
are defined under System ▶ Sensors.

￭ Select the measuring input at which the sensor is connected.

 

2 Select a measuring mode

￭ Select the desired measuring mode.
Only those measuring modes are displayed which are advisable
for the selected sensor.
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3 Enter a measuring temperature

￭ Enter the measuring temperature if no temperature sensor is
connected. If a temperature sensor is connected, then the tem-
perature will be measured automatically.

 

4 Starting the measurement

￭ Tap on [Start].

The measured value display is opened:

The ongoing measurement is canceled with [Stop]. The label
switches once again to [Start].

27.2.1 Parameter description

"Manual control / Measure" dialog

Sensor

Selection of the sensor from the sensor list. Sensors are defined under
System ▶ Sensors.

Selection Selection of configured sensors

Measuring input

Selection of the measuring input the sensor is connected to. The selection
depends on whether the control device has one or two measuring interfa-
ces.

Selection 1 | 2
Default value 1

Measuring mode

Selection of the measuring mode. Only those measuring modes are dis-
played which are advisable for the selected sensor.

Selection Ipol | Upol | T

Ipol
voltametric measurement with selectable polarization current

Upol
amperometric measurement with selectable polarization voltage

T
temperature measurement

Temperature

Temperature entered manually. If a temperature sensor is connected, then
the temperature will be measured continuously.
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Input range –20.0 to 150.0 °C
Default value 25.0 °C

[Info sensor]

Display information on the sensor.

27.3 Dosing

Manual control ▶ Dosing

The following dosing functions are available:

￭ Preparing the exchange or dosing unit (see chapter 27.3.3, page 221)
￭ Emptying the dosing unit (see chapter 27.3.4, page 222)
￭ Filling the dosing cylinder of the exchange unit/dosing unit (see chap-

ter 27.3.5, page 222)
￭ Dosing a specified volume (see chapter 27.3.2, page 220)
￭ Dosing continuously (see chapter 27.3.1, page 218)

Selecting the dosing device

If several dosing devices are connected to a control instrument, then the
dialog for selecting a dosing device will be opened.

[Dosing device X]

Selection of the dosing device. The MSB connector and the type of the
connected dosing device are displayed.

Various information is shown next to the button:

￭ Titrant
For dosing devices of the type 8XX with an intelligent exchange unit or
dosing unit the titrant name is read off the data chip.

￭ Cylinder volume
For dosing devices of the type 8XX with an exchange unit without data
chip only the cylinder volume is displayed.

￭ ---
For exchange or dosing units which are not or not correctly attached.

￭ Manual busy
When a dosing function is being carried out.

[All dosing devices]

Carrying out the functions [Prepare], [Empty] and [Fill] at the same time
with several dosing devices of the control device.

Selecting the dosing function

If only one dosing device is connected, then the properties of this dosing
device will be shown directly. This information varies according to the type
of dosing device:
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￭ Type 8XX with integrated data chip:
If an exchange or dosing unit with integrated data chip is attached, the
data stored on the data chip is displayed.

￭ Type 8XX without integrated data chip:

[Empty]

Empty the cylinder and the tubings of the dosing unit (see chapter 27.3.4,
page 222).

[Prepare]

Rinse the cylinder and the tubings of the exchange / dosing unit (see
chapter 27.3.3, page 221).

[Fill]

Fill the cylinder of the exchange / dosing unit (see chapter 27.3.5, page
222).

[Dosing fixed vol.]

Dose a specified volume (see chapter 27.3.2, page 220).

[Dosing]

Dose continuously (see chapter 27.3.1, page 218).

27.3.1 Continuous dosing
Manual control: Dosing ▶ Dosing

With the function [Dosing], dosing is continuous for as long as you hold
the button [Dose] pressed down.

Proceed as follows:

 

1 Configure the dosing function

NOTICE

￭ The dosing and filling rates should be decreased for viscous liq-
uids.

￭ The maximum dosing and filling rates depend on the cylinder
volume (see chapter 31, page 310).

￭ Enter the dosing rate.
￭ Enter the filling rate.

 

2 Start dosing

￭ Tap on [Dose].
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The volume dosed is displayed. When the volume of one cylinder has
been dosed, the dosing cylinder will be refilled automatically.

 

3 Fill the cylinder

￭ Tap on [Fill].

The dosing cylinder is filled. The displayed volume value will be reset
to 0.0000 mL.

NOTICE

If you exit the dialog with the fixed key [ ], the dosing cylinder is
filled automatically.

Parameter description

Dosing rate

Rate at which it is dosed.

Input range 0.01 to 166.00 mL/min
Selection maximum | dynamic
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 31, page 310).

dynamic
This setting can only be selected when the dosing cylinder is filled. The
dosing is being carried out faster and faster until the maximum dosing
rate is reached (starting with 1 mL/min and then doubling the dosing
rate every 1.5 s).

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
31, page 310).
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27.3.2 Dosing fixed volumes
Manual control: Dosing ▶ Dosing fixed vol.

You can dose a particular volume with the [Dosing fixed vol.] function.

Proceed as follows:

 

1 Configure the dosing function

NOTICE

￭ The dosing and filling rates should be decreased for viscous liq-
uids.

￭ The maximum dosing and filling rates depend on the cylinder
volume (see chapter 31, page 310).

￭ Enter the desired volume.
￭ Enter the dosing rate.
￭ Enter the filling rate.

 

2 Start dosing

￭ Tap on [Start].

The volume display is shown. When the volume of one cylinder has
been dosed, the dosing cylinder will be refilled automatically.

Continuous dosing is paused with [Hold]. The label changes to
[Continue]. It can be used to resume the run.

 

3 Fill the cylinder

With the default settings (see "Fill automatic.", page 221) the dosing
cylinder is filled automatically.

Otherwise:

￭ Tap on [Fill].

The dosing cylinder is filled. The displayed volume value will be reset
to 0.0000 mL.

Parameter description

Volume

Volume which is dosed.

Input range 0.00000 to 99999.9 mL
Default value 0.10000 mL
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Dosing rate

The rate at which dosing takes place.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 31, page 310).

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
31, page 310).

Fill automatic.

on | off (Default value: on)

If this parameter is activated, then the dosing cylinder is being automat-
ically filled at the end of the dosing.

27.3.3 Preparing
Manual control: Dosing ▶ Prepare

The Prepare function is used to rinse and fill the cylinder and tubings of
the exchange or dosing unit air bubble-free. You should carry out this
function before the first determination or once a day.

If the titrant is selected (see "Selecting the dosing function", page 217),
the parameters defined for the titrant for preparing/emptying and the tub-
ing parameters will be used (dosing unit only). If the titrant is not selected,
default parameters will be used (see Chapter 31.1.2, page 310 and Chap-
ter 31.2.2, page 311).

The following two figures show the live display of an exchange unit and a
dosing unit:
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27.3.4 Emptying
Manual control: Dosing ▶ Empty

NOTICE

The function Empty is possible only with dosing units.

The cylinders and the tubings of the dosing unit are emptied with this
function.

If the titrant is selected (see "Selecting the dosing function", page 217),
the parameters defined for the titrant for preparing/emptying and the tub-
ing parameters will be used. If the titrant is not selected, default parame-
ters will be used (see Chapter 31.2.2, page 311 and Chapter 31.1.2, page
310).

27.3.5 Filling
Manual control: Dosing ▶ Fill

You can use the function [Fill] to fill the dosing cylinder of the exchange
unit/dosing unit manually. The filling rate cannot be configured; the maxi-
mum filling rate will be used.

27.3.6 Replacing reagent

NOTICE

You can easily change the reagent in a dosing unit without no contact
with the chemicals using the functions Prepare and Empty.

Proceed as follows:

 

1 Execute the function [Empty].

 

2 Attach the dosing unit to the bottle with a suitable solvent.

 

3 Execute the function [Prepare].

The last traces of the reagent in the cylinder and tubings are removed
with the solvent.

 

4 Execute the function [Empty] again.

 

5 Attach the dosing unit to the bottle with the new reagent.
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6 Execute the function [Prepare].

The dosing unit can now be used.

27.4 Stirring

Manual control ▶ Stir

The MSB connector and type of stirrer is indicated for each connected stir-
rer.

You can control a connected stirrer manually with the function [Stir].

Proceed as follows:

 

1 Setting the stirring rate

￭ Tap on the [–] or [+] button.
Each time one of the buttons is tapped, the stirring rate is reduced
or increased by one level.

 

2 Switching on the stirrer

￭ Tap on [Start].

The stirrer is started.

 

3 Switching off the stirrer

￭ Tap on [Stop].

The stirrer is stopped.



27.5 Remote ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

224 ￭￭￭￭￭￭￭￭ 917 Coulometer

Parameter description

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 31.3, page 311.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

NOTICE

If a stirrer is used in the determination run, it can still be manually con-
trolled at the same time. For example, you can use the manual control
to reduce the stirring rate of a stirrer which has been started in the
determination run.

27.5 Remote

Manual control ▶ Remote

With the function [Remote], you can define manual output signals to the
remote interface of a connected Remote Box. It is not possible to define
input signals; the current status of the input lines is, however, displayed.
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Inputs

Current status of the input lines.

Outputs

Selection of the signal out of the templates or entering the required bit
pattern. Templates are defined under System ▶ Templates ▶ Output
lines.

Entering the bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status
￭ p = set pulse

The output lines are always numbered from right to left, i.e. with the sig-
nal 00000000000001 line 0 is set. With a pulse, the length is set to 200
ms. If you wish to set pulses with other lengths, you have to define a cor-
responding template.

Entry Bit pattern containing exactly 14 characters
or a max. of 24 characters for the name of
the template

Default value 00000000000001
Selection Selection of the templates defined

[Set]

Set a defined output signal.

27.6 885 Compact Oven SC

Manual control ▶ Sample Processor
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You can control a connected 885 Compact Oven SC manually with the
[Sample Processor] function. The following functions are available:

￭ Initializing the rack
￭ Settings for the heating and the gas flow

Lift position

Current lift position.

Rack position

Current rack position. If the rack is not set to a valid position, e.g. after a
rack reset, -- is displayed to indicate this.

NOTICE

Note that the rack has to be set to a valid position for all lift move-
ments! Otherwise a corresponding error message will be displayed.

Move to a valid rack position with [Previous] or [Next]. Alternatively,
you can carry out a MOVE command.

[Home position]

Move the lift to the home position (corresponds to lift position 0 mm).

[Work position]

Move the lift to the work position of the current rack position.

The work position for sample beakers and conditioning beakers is defined
in the device manager (see chapter 10.5.2, page 77).

[↑]
Move the lift continuously upwards as long as the button is pressed down.
The lift moves in 6 mm steps.

[↓]
Move the lift continuously downwards as long as the button is pressed
down. The lift moves in 6 mm steps.

[Previous]

Move to the previous rack position.

[Next]

Move to the next rack position.

[Reset rack]

Initialize the rack. This function is identical with the command RACK. The
following actions are carried out:

￭ The lift is moved upwards.
￭ The sample rack is rotated to the starting position.
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￭ The sample variable is reset to the value 1.

[Heater Gas flow]

Display, control and settings of the current temperature and current gas
flow.

27.6.1 Controlling the heating/gas flow
Manual control: Sample Processor ▶ Heater Gas flow

You can see, control and set the current temperature and current gas flow
in the Sample Processor / Heater Gas flow dialog.

[Gas flow]

Edit parameters for the gas flow.

[Heater]

Edit parameters for the heater.

[Start / Stop Gas flow]

Starts or stops the gas flow.

[Start / Stop Heater]

Starts or stops the heater.

Settings for the gas flow

Flow rate

Flow rate for the gas flow.

Input range 10 to 150 mL/min (Increment: 1)
Default value 50 mL/min

Gas supply

Selection of the gas supply.
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Selection pump | valve
Default value pump

pump
The integrated air pump is used for the gas flow.

valve
The integrated inlet valve is used for the gas flow. The inlet valve in the
885 Compact Oven SC is connected to compressed air or nitrogen.

Gas type

Gas type of the carrier gas used.

Selection air | nitrogen
Default value air

Settings for the oven temperature

Temperature

Temperature to which the oven is heated.

Input range 50 to 250 °C (Increment: 1)
Default value 110 °C
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28 Parameters

NOTICE

For most of the numerical parameters, the result of a calculation can
also be utilized in place of a number. A description of this can be found
in the appendix of the manual.

28.1 Coulometric Karl Fischer titrations (KFC)

28.1.1 Control parameters
The control parameters for the endpoint are defined under [Control
parameters].

Endpoint at

Measured value for the endpoint.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the manual, in the "Technical specifications" chapter.

Input range –1250.0 to 1250.0 mV
Default value 50.0 mV
Selection off

Titration rate

Three predefined sets of parameters can be selected for the titration rate.

Selection slow | optimal | fast | user
Default value optimal

slow
For samples with a low water content or samples which release their
moisture only slowly.

optimal
For all standard titrations. The parameters have been optimized for the
most frequent applications.

fast
For uncritical samples with high water content.

user
The individual titration parameters can be modified.

The settings of the individual titration rates are listed in table 9, page 230.
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User-defined parameters

These parameters are only accessible when Titration rate = user.

Dynamics

This parameter defines the control range before the specified endpoint.
Within the control range, the iodine is generated step by step, the genera-
tion is finely controlled. The closer the endpoint, the slower the iodine is
generated until the rate defined under Min. rate is reached. The larger
the control range, the slower the titration. Outside the control range,
iodine is being continuously generated, the rate is defined under Max.
rate.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the manual, in the "Technical specifications" chapter.

Input range 0.1 to 1250.0 mV
Default value 70.0 mV
Selection off

Max. rate

Rate at which iodine is generated outside the control range.

Input range 1.5 to 2241.0 µg/min
Selection maximum
Default value maximum

Min. rate

Rate at which iodine is generated at the very beginning of the titration
and in the control range at the end of the titration. This parameter has a
vital influence on the titration rate and thus also on the accuracy. The
smaller the selected minimum rate, the slower the titration.

Input range 0.3 to 999.0 µg/min
Default value 15.0 µg/min

Table 9 Default values of the predefined titration rates for KFC

 Titration rate

slow optimal fast

Dynamics 120.0 mV 70.0 mV 30.0 mV

Max. rate 1000.0 µg/min maximum maximum

Min. rate 0.3 µg/min 15.0 µg/min 30.0 µg/min
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Stop criterion

Stop criterion

The titration is stopped when the endpoint has been reached and this
stop criterion has been fulfilled. If no stop criterion has been selected then
the titration will not be stopped. The stop conditions (see chapter 28.1.3,
page 232) always lead to a stop, even if the stop criterion has not been
reached.

Selection drift | time | rel. drift | off
Default value rel. drift

drift
The titration is stopped when the stop drift has been reached.

time
The titration is stopped if the endpoint has been exceeded during a
certain time period (Delay time).

rel. drift
The titration is stopped when the sum of the drift at the start of the
titration and the relative stop drift has been reached.

off
The titration will not be stopped until the stop conditions have been
fulfilled.

Stop drift

This parameter can only be edited with Stop criterion = drift.

The titration is stopped when the endpoint and the stop drift have been
reached.

Input range 1 to 999 µg/min
Default value 5 µg/min

Delay time

This parameter can only be edited with Stop criterion = time.

When the endpoint has been reached, the specified time is allowed to
elapse after the last dosing and the titration is then stopped.

Input range 0 to 999 s
Default value 10 s

Relative stop drift

This parameter can only be edited with Stop criterion = rel. drift.

The titration is stopped when the endpoint and the sum of the drift at the
start of the titration and the relative stop drift have been reached.
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Input range 1 to 999 µg/min
Default value 5 µg/min

28.1.2 Titration parameters
Under [Titration parameters], the parameters influencing the run of the
entire titration are defined.

Pause

Waiting time, for example for dissolving the sample. During this time no
iodine is generated.

Input range 0 to 999999 s
Default value 0 s

Extraction time

Minimum duration of the titration. The titration will not be stopped during
the extraction time, even if the endpoint has already been reached. The
titration is however stopped if a stop condition is fulfilled during this time
(see chapter 28.1.3, page 232). Entering an extraction time may e.g. be
advisable if a Karl Fischer oven is used.

Input range 0 to 999999 s
Default value 0 s

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.

Input range 0.1 to 999999.0 s
Default value 2.0 s

28.1.3 Stop conditions
The conditions for canceling the titration are defined under [Stop condi-
tions], if this does not occur automatically. This could be the case when
the endpoint set is not reached or if the stop criterion (see "Stop crite-
rion", page 231) is not fulfilled.
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Stop time

The titration is stopped when the specified time has elapsed since the start
of the titration.

Input range 1 to 999999 s
Selection off
Default value off

28.1.4 Conditioning
The conditions required for conditioning are defined under [Condition-
ing].

Conditioning

on | off (Default value: on)

If this parameter is activated, then the first time the titration is started the
working medium will be titrated to the endpoint with the specified control
parameters. The status is kept stable. The actual method run does not
begin until [ ] has been pressed once more.

Start drift

If the measured drift is smaller than this value for a certain time (so-called
stabilizing time), Conditioning OK is displayed and the titration can be
started. The stabilizing time is defined in the dialog Conditioning / Con-
ditioning options.

Input range 1 to 999 µg/min
Default value 20 µg/min

Drift correction

The endpoint amount can be corrected taking the drift value into account.
For this, the drift is multiplied with the drift correction time and this value
is then subtracted from the endpoint amount. The drift correction time is
the time interval between the end of conditioning and the end of the
determination.

Selection auto | manual | off
Default value auto

auto
The value of the current drift is automatically applied at the start of the
titration.

manual
If the drift is known throughout a longer period of time, this can be
entered manually.

off
No drift correction takes place.
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Drift value

This parameter can only be edited with Drift correction = manual.

Drift for manual drift correction.

Input range 0.0 to 99.9 µg/min
Default value 0.0 µg/min

Measured value display

on | off (Default value: off)

If this parameter is activated, the currently measured value is displayed
during the conditioning.

Automatic start [Automatic start]

NOTICE

If you use the automatic start function, then we recommend that the
start drift be reduced and that a stabilizing time be defined.

Recommendation: start drift ≤ 10 µg/min / stabilizing time ≥ 30 s

Automatic start

on | off (Default value: off)

If this parameter is activated, the determination is automatically started
when the measured voltage suddenly changes. This setting will be ignored
as long as the working medium has not been conditioned.

Threshold value

If the change in voltage is higher than this value, the determination will
automatically be started.

Input range 0 to 999 mV
Default value 50 mV

Conditioning options [Cond. options]

Stabilizing time

Waiting time, during which the measured drift has to be smaller than the
start drift defined until Conditioning OK is displayed. The start drift is
defined in the dialog Edit command / Conditioning.

Input range 0 to 999999 s
Default value 0 s
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Cond. stop time

Maximum permissible time over which conditioning may take place. Con-
ditioning is stopped when the specified time has elapsed.

Input range 1 to 999999 s
Selection off
Default value off

Delay reconditioning

on | off (Default value: off)

If this parameter is activated, the conditioning will not start before all the
method commands have been processed. Otherwise, the conditioning will
immediately start after the titration command.

NOTICE

This parameter must be activated if commands follow which must not
run simultaneously with the conditioning.

Example: Emptying the titration cell followed by adding new working
medium.

28.1.5 Cell
The parameters for the titration cell are defined under [Cell].

Generator electrode

Type of generator electrode.

Selection without diaphragm | with diaphragm
Default value without diaphragm

without diaphragm
Generator electrode without diaphragm.

with diaphragm
Generator electrode with diaphragm.

Generator current

Polarization current at the generator electrode.

Selection 100 mA | 200 mA | 400 mA | auto

400 mA
Default value, when Generator electrode = without diaphragm.
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auto
The current is adapted to the conductivity of the reagent and automat-
ically reduced near the endpoint. Default value, when Generator
electrode = with diaphragm.

Reagent monitoring

Selection of the reagent from the list of reagents. The selection depends
on the titration mode. Reagents are defined under System ▶ Reagents.

Selection Selection of configured reagents | off
Default value off

off
The reagent monitoring is not active.

28.1.6 Sensor
The parameters for the sensor are edited under [Sensor].

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

I(pol)

The polarization current is the current that is applied to a polarizable elec-
trode during the voltametric measurement.

Selection 5 µA | 10 µA | 20 µA | 30 µA
Default value 10 µA

Electrode check

on | off (Default value: off)

For polarizable electrodes and the generator electrode, an electrode check
can be carried out. The following will be tested:

￭ Polarizable electrodes
– Is the electrode connected?
– Is there a short circuit?

The electrode check is carried out when this command is started.
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￭ Generator electrode:
– Is the electrode connected?
– Is the generator system defective?
– Is the resistance of the sample solution very high?

The electrode check is carried out continuously during the execution of
this command.

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

28.1.7 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. The selection
does not depend on the number of MSB connectors of the control instru-
ment.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 31.3, page 311. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
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￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.

28.2 Bromine index determination (BRC)

28.2.1 Control parameters
The control parameters for the endpoint are defined under [Control
parameters].

Endpoint at

Measured value for the endpoint.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the "Technical specifications" chapter for the control
device used.

Input range –1,250.0 to 1,250.0 mV
Default value 200.0 mV
Selection off

Titration rate

Three predefined sets of parameters can be selected for the titration rate.

Selection slow | optimal | fast | user
Default value optimal

slow
For samples with slow bromine addition.

optimal
For all standard titrations. The parameters have been optimized for the
most frequent applications.

fast
For uncritical samples with fast bromine addition.

user
The individual titration parameters can be modified.

The settings of the individual titration rates are listed in table 10, page
239.
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User-defined parameters

These parameters are only accessible when Titration rate = user.

Dynamics

This parameter defines the control range before the specified endpoint.
Within the control range, the bromine is generated step by step, the gen-
eration is finely controlled. The closer the endpoint, the slower the bro-
mine is generated until the rate defined under Min. rate is reached. The
larger the control range, the slower the titration. Outside the control
range, bromine is continuously generated, the rate is defined under Max.
rate.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the manual, in the "Technical specifications" chapter.

Input range 0.1 to 1250.0 mV
Default value 400.0 mV
Selection off

Max. rate

Rate at which bromine is generated outside the control range.

Input range 10.0 to 19876.0 µg/min
Default value 1000.0 µg/min
Selection maximum

Min. rate

Rate at which bromine is generated at the very beginning of the titration
and in the control range at the end of the titration. This parameter has a
vital influence on the titration rate and thus also on the accuracy. The
smaller the selected minimum rate, the slower the titration.

Input range 1.0 to 999.0 µg/min
Default value 25.0 µg/min

Table 10 Default values for the predefined titration rates for BRC

 Titration rate

slow optimal fast

Dynamics 400.0 mV 400.0 mV 400.0 mV

Max. rate 500.0 µg/min 1000.0 µg/min 2000.0 µg/min

Min. rate 15.0 µg/min 25.0 µg/min 50.0 µg/min
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Stop criterion

Stop criterion

The titration is stopped when the endpoint has been reached and this
stop criterion has been fulfilled. If no stop criterion has been selected then
the titration will not be stopped. The stop conditions (see chapter 28.2.3,
page 242) always lead to a stop, even if the stop criterion has not been
reached.

Selection drift | time | rel. drift | off | drift & time
Default value drift & time

drift
The titration is stopped when the stop drift has been reached.

time
The titration is stopped if the endpoint has been exceeded during a
certain time period (Delay time).

rel. drift
The titration is stopped when the sum of the drift at the start of the
titration and the relative stop drift has been reached.

off
The titration will not be stopped until the stop conditions have been
fulfilled.

drift & time
The titration is stopped when the stop drift has been exceeded during
the time set and the endpoint has been reached.

Stop drift

This parameter can only be edited with Stop criterion = drift or drift &
time.

The titration is stopped when the endpoint and the stop drift have been
reached.

Input range 1 to 999 µg/min
Default value 15 µg/min

Delay time

This parameter can only be edited with Stop criterion = time or drift &
time.

When the endpoint has been reached, the specified time is allowed to
elapse after the last dosing and the titration is then stopped.

Input range 0 to 999 s
Default value 40 s
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Relative stop drift

This parameter can only be edited with Stop criterion = rel. drift.

The titration is stopped when the endpoint and the sum of the drift at the
start of the titration and the relative stop drift have been reached.

Input range 1 to 999 µg/min
Default value 5 µg/min

28.2.2 Titration parameters
Under [Titration parameters], the parameters influencing the run of the
entire titration are defined.

Pause

Waiting time, for example for dissolving the sample. During this time no
bromine is generated.

Input range 0 to 999999 s
Default value 0 s

Extraction time

Minimum duration of the titration. The titration will not be stopped during
the extraction time, even if the endpoint has already been reached. The
titration is however stopped if a stop condition is fulfilled during this time
(see chapter 28.2.3, page 242).

Input range 0 to 999999 s
Default value 0 s

Temperature

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.

Input range 0.1 to 999999.0 s
Default value 2.0 s
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28.2.3 Stop conditions
The conditions for canceling the titration are defined under [Stop condi-
tions], if this does not occur automatically. This could be the case when
the endpoint set is not reached or if the stop criterion (see "Stop crite-
rion", page 240) is not fulfilled.

Stop time

The titration is stopped when the specified time has elapsed since the start
of the titration.

Input range 1 to 999999 s
Selection off
Default value off

28.2.4 Conditioning
The conditions required for conditioning are defined under [Condition-
ing].

Conditioning

on | off (Default value: on)

If this parameter is activated, then the first time the titration is started the
working medium will be titrated to the endpoint with the specified control
parameters. The status is kept stable. The actual method run does not
begin until [ ] has been pressed once more.

Start drift

If the measured drift is smaller than this value for a certain time (so-called
stabilizing time), Conditioning OK is displayed and the titration can be
started. The stabilizing time is defined in the dialog Conditioning / Con-
ditioning options.

Input range 1 to 999 µg/min
Default value 20 µg/min

Drift correction

The endpoint amount can be corrected taking the drift value into account.
For this, the drift is multiplied with the drift correction time and this value
is then subtracted from the endpoint amount. The drift correction time is
the time interval between the end of conditioning and the end of the
determination.

Selection auto | manual | off
Default value off
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auto
The value of the current drift is automatically applied at the start of the
titration.

manual
If the drift is known throughout a longer period of time, this can be
entered manually.

off
No drift correction takes place.

Drift value

This parameter can only be edited with Drift correction = manual.

Drift for manual drift correction.

Input range 0.0 to 999.9 µg/min
Default value 0.0 µg/min

Measured value display

on | off (Default value: off)

If this parameter is activated, the currently measured value is displayed
during the conditioning.

Conditioning options [Cond. options]

Stabilizing time

Waiting time, during which the measured drift has to be smaller than the
start drift defined until Conditioning OK is displayed. The start drift is
defined in the dialog Edit command / Conditioning.

Input range 0 to 999999 s
Default value 0 s

Cond. stop time

Maximum permissible time over which conditioning may take place. Con-
ditioning is stopped when the specified time has elapsed.

Input range 1 to 999999 s
Selection off
Default value off

Delay reconditioning

on | off (Default value: off)

If this parameter is activated, the conditioning will not start before all the
method commands have been processed. Otherwise, the conditioning will
immediately start after the titration command.
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NOTICE

This parameter must be activated if commands follow which must not
run simultaneously with the conditioning.

Example: Emptying the titration cell followed by adding new working
medium.

28.2.5 Cell
The parameters for the titration cell are defined under [Cell].

Generator electrode

Type of generator electrode.

Selection without diaphragm | with diaphragm
Default value with diaphragm

without diaphragm
Generator electrode without diaphragm.

with diaphragm
Generator electrode with diaphragm.

Generator current

Polarization current at the generator electrode.

Selection 100 mA | 200 mA | 400 mA | auto
Default value auto

auto
The current is adapted to the conductivity of the reagent and automat-
ically reduced near the endpoint.

Reagent monitoring

Selection of the reagent from the list of reagents. The selection depends
on the titration mode. Reagents are defined under System ▶ Reagents.

Selection Selection of configured reagents | off
Default value off

off
The reagent monitoring is not active.
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28.2.6 Sensor
The parameters for the sensor are edited under [Sensor].

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

I(pol)

The polarization current is the current that is applied to a polarizable elec-
trode during voltametric measurement.

The values that are actually adjustable may vary from the values specified
here, depending on the hardware. The binding values can be found in the
manual, in the "Technical specifications" chapter.

Input range –125.0 to 125.0 µA (Increment: 2.5)
Selection –1.0 µA | 1.0 µA
Default value 1.0 µA

Electrode check

on | off (Default value: off)

For polarizable electrodes and the generator electrode, an electrode check
can be carried out. The following will be tested:

￭ Polarizable electrodes
– Is the electrode connected?
– Is there a short circuit?

The electrode check is carried out when this command is started.
￭ Generator electrode:

– Is the electrode connected?
– Is the generator system defective?
– Is the resistance of the sample solution very high?

The electrode check is carried out continuously during the execution of
this command.

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic
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continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).

28.2.7 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. The selection
does not depend on the number of MSB connectors of the control instru-
ment.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 31.3, page 311. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.
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28.3 Measurements (MEAS)

28.3.1 Measuring parameters
Under [Measuring parameters], the parameters influencing the run of
the entire measurement are defined.

Signal drift

Maximum permissible drift for the measured value acceptance, i.e. maxi-
mum change of the measured value per minute. For this value, a suitable
maximum waiting time is automatically calculated except you already have
modified this waiting time.

NOTICE

A constant measured value is often only reached after a certain time, as
mixing and the reaction itself require a certain time. The response time
of an electrode can also increase with time, i.e., reaching a constant
measured value takes longer and longer. Drift-controlled measured
value acceptance is particularly advisable in such cases, as the measured
values are only accepted when equilibrium has almost been reached.

Measuring mode Ipol:
Input range 0.1 to 999.0 mV/min
Default value 10.0 mV/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Measuring mode Upol:
Input range 0.01 to 99.90 µA/min
Default value 10.00 µA/min
Selection off

off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Measuring mode T:
Input range 0.1 to 999.0 °C/min
Default value 0.5 °C/min
Selection off
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off
Measured value acceptance will take place after the maximum waiting
time has elapsed.

Min. waiting time

The measured value is not accepted until the minimum waiting time has
elapsed, even if the signal drift has already been reached. The minimum
waiting time is only important for drift-controlled measurements.

Input range 0 to 999999 s
Default value 0 s

Max. waiting time

If the signal drift has been switched off or has not yet been reached, then
the measured value will be accepted when the maximum waiting time has
elapsed. As default value, a suitable waiting time for the signal drift is
automatically calculated.

Input range 0 to 999999 s
The default value depends on the measuring mode.

Selection off

off
The measurement is continued endlessly.

Stop meas. value

The measurement is canceled when the specified measured value has
been reached since the start of the measurement.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the .

Measuring mode Ipol:
Input range –2000.0 to 2000.0 mV
Selection off
Default value off

Measuring mode Upol:
Input range –200.00 to 200.00 µA
Selection off
Default value off

Measuring mode T:
Input range –20.0 to 150.0 °C
Selection off
Default value off
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Temperature

This parameter is not available with the MEAS T command (temperature
measurement).

Temperature entered manually. The temperature is being continuously
measured when a temperature sensor is connected and when Temp.
measurement = automatic or continuous is defined (see sensor dialog
of the command).

Input range –20.0 to 150.0 °C
Default value 25.0 °C

Time interval MP

Time interval for entering a measuring point in the measuring point list.
The measuring point list is limited to 1000 measuring points.

Input range 0.1 to 999999.0 s
Default value 2.0 s

28.3.2 Sensor
The parameters for the sensor are edited under [Sensor].

The parameters are valid for all measuring modes except for Temp.
measurement. This parameter is not available with the MEAS T com-
mand (temperature measurement).

Measuring input

Selection of the measuring input the sensor is connected to. The selection
is not dependent on whether the control device has one or two measur-
ing interfaces.

Selection 1 | 2
Default value 1

Sensor

Selection of the sensor from the sensor list. The selection depends on the
measuring mode. Sensors are defined under System ▶ Sensors. You can
also enter a sensor name which is not contained in the sensor list. When a
determination is started there is a check whether the sensor is contained
in the sensor list.

Selection Selection of configured sensors

I(pol)

The polarization current is the current that is applied to a polarizable elec-
trode during voltametric measurement. This parameter is available only
with I(pol) determinations.
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The values that are actually adjustable may vary from the values specified
here. The binding values can be found in the manual, in the Technical
specifications chapter.

Input range –125.0 to 125.0 µA (Increment: 2.5)
Default value 5.0 µA
Selection –1.0 µA | 1.0 µA

U(pol)

The polarization voltage is the voltage applied to the polarizable electrode
during an amperometric measurement. This parameter is available only
with U(pol) determinations.

The values that are actually adjustable may vary from the values specified
here. The binding values can be found in the manual, in the Technical
specifications chapter.

Input range –1,250 to 1,250 mV (Increment: 25)
Default value 400 mV

Electrode check

on | off (Default value: off)

For the following electrodes, an electrode check can be carried out:

￭ Metal electrodes

A check is made that the electrode is properly connected and that no
short-circuit is present. The electrode check is carried out when this com-
mand is started.

Temp. measurement

Type of temperature measurement.

Selection continuous | automatic | off
Default value automatic

continuous
A temperature sensor must be connected. The temperature is
measured continuously.

automatic
If a temperature sensor is connected then the temperature will be
measured continuously. Otherwise, the temperature entered manually
will be used (see dialog of the titration and measuring parameters).

off
The temperature will not be measured. The temperature entered man-
ually is used (see dialog of the titration and measuring parameters).
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28.3.3 Stirrer
The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. The selection
does not depend on the number of MSB connectors of the control instru-
ment.

Selection 1 | 2 | 3 | 4 | off
Default value 1

off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 31.3, page 311. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.
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28.4 Evaluations (EVAL)

Various additional evaluations (EVAL commands) can be carried out for
titrations and measurements. The evaluation always refers to the last titra-
tion or measurement prior to the EVAL command. Only those evaluation
commands which are available for the last titration or measurement prior
to the EVAL command can be inserted in the list of commands. If a titra-
tion or measuring command is deleted before the EVAL command, then it
will be shown in red in the list of commands, as the reference is missing.

EVAL commands can also be inserted in the method run at a later time
and the determination can be reevaluated ([Recalculate] function in the
results dialog).

Additional evaluations for KFC titrations

The following additional evaluations are possible:

￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time
– Amount of generated iodine

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL RATE (average dosing rate)

Additional evaluations for BRC titrations

The following additional evaluations are possible:

￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time
– Amount of generated bromine

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL RATE (average dosing rate)

Additional evaluations for measurements

The following additional evaluations are possible:

￭ EVAL FIX-EP (fixed endpoints)
Measured quantities:

– Measured value
– Time

￭ EVAL MIN/MAX (minimum/maximum)
￭ EVAL BREAK (break points)
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28.4.1 Fixed endpoint evaluation (EVAL FIX-EP)
For the fixed endpoint evaluation, the associated values are interpolated
from the measuring point list for one quantity (measured value, volume,
etc.). Up to nine fixed endpoints can be evaluated with one command.

Fixed quantity

Selection of the quantity to which the associated value is interpolated
from the measuring point list.

Selection Measured value | Time | Volume
Default value Measured value

Fixed EP1 at

The fixed endpoint must lie between the first and the final entry in the
measuring point list.

The values that are actually measurable may vary from the values specified
here, depending on the hardware. The binding measurement value ranges
can be found in the .

Measured value (measuring mode Ipol):
Input range –2,000.0 to 2,000.0 mV
Selection off
Default value off

Measured value (measuring mode Upol):
Input range –200.00 to 200.00 µA
Selection off
Default value off

Measured value (measuring mode T):
Input range –20.0 to 150.0 °C
Selection off
Default value off

Time:
Input range 0.0 to 999999.9 s
Selection off
Default value off

Volume:
Input range 0.00000 to 9,999.99 mL
Selection off
Default value off
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Fixed EP2 at…Fixed EP9 at

See Fixed EP1 at.

28.4.2 Minimum and maximum evaluation (EVAL MIN/MAX)
For the minimum or maximum measured value the associated volume,
time and temperature are interpolated from the measuring point list. The
evaluation begins as soon as the slope of the curve exceeds a particular
threshold value.

Threshold value

Minimum

Maximum

Measured value

Volume / Time

Figure 17 Evaluation of minimum and maximum

Evaluation

Selection whether the minimum or the maximum of the titration curve is
being evaluated. With a command either the minimum or the maximum
can be evaluated. If both values are needed, a second command has to be
defined in the method.

Selection Minimum | Maximum
Default value Maximum

Threshold value

The evaluation of the minimum or maximum begins as soon as the slope
of the curve exceeds the set threshold value. Use a lower threshold value
if the minimum or maximum is not found.

Measuring mode Ipol:
Input range 1.0 to 2,000.0 
Default value 25.0 

With titrations the unit is mV/mL, with measure-
ments mV/s.
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Measuring mode Upol:
Input range 0.5 to 10.0 
Default value 5.0 

With titrations the unit is µA/mL, with measure-
ments µA/s.

Measuring mode T:
Input range 0.1 to 20.0 °C/s
Default value 1.0 °C/s

28.4.3 Rate evaluation (EVAL RATE)
The rate evaluation provides the median dosing rate in a defined range
(so-called window). The median dosing rate is determined by means of lin-
ear regression through a minimum of three measuring points. If the dos-
ing is carried out with only one dosing device and if more than one cylin-
der volume is dosed, then the median dosing rate will be reduced as a
result of the filling time.

When the command is opened for the first time, a window over the entire
time range is already defined. In contrary to the potentiometric evaluation
of a DET/MET titration the individual windows may overlap. A maximum
of 9 windows can be defined.

[New]

Define a new window.

[Delete]

Delete the selected window.

[Edit]

Edit the settings of the selected window.

Lower limit

Time for the lower limit.

Input range 0 to 999999 s
Default value 0 s

Upper limit

Time for the upper limit.

Input range 0 to 999999 s
Default value 999999 s
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28.5 Calculations

The following calculation commands are available:

CALC Defining calculations of a determination.

CALC LIVE Defining the calculation whose result will be dis-
played in the live display (so-called live result)
during a titration or measurement.

28.5.1 Calculations (CALC)
Calculations are defined with the command CALC. A method may contain
a maximum of nine calculation commands. A maximum of nine calcula-
tions can be defined per command. A series of variables (raw data from
the determination, previously calculated results, etc.) is available for the
calculations.

The command contains the following options, among others:

￭ Save result as common variable
￭ Save result in result table
￭ Define result limits

The result name is specified in the list for each calculation.

[New]

Define a new calculation or load an existing template, see following chap-
ter.

[Delete]

Delete the selected calculation from the list.

[Edit]

Edit the data of the selected calculation (see chapter 28.5.1.2, page 259).
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28.5.1.1 Loading a result template

The most common calculations are already available, the so-called result
templates, in order to facilitate the definition of a new calculation. You
also have the option, however, of defining templates of your own (see
dialog System / Templates).

Proceed as follows to load an existing template:

 

1 Select a result template

￭ In the Sequence / Edit command dialog, tap on the [New]
button.
The list of Metrohm result templates is displayed:

￭ Select the desired Metrohm result template and tap on [Load
template].
or
Tap on [Custom templates] and select a template you gener-
ated yourself.

If a statistic variable SMN# (# = 1…9) is defined in the template
which is already used in another calculation, then the following mes-
sage will be displayed:
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2 Confirm the message

￭ Tap on [OK].

The Note dialog is displayed. This note is defined in the dialog Edit
result template / Note for wizard.

 

3 Enter the numerical values of the wildcards

￭ Tap on [Next].
The list of wildcards is displayed:

￭ Enter the numerical values of the wildcards.
￭ Tap on [Next].

The editing dialog of the new calculation is displayed:
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The calculation can now be edited further, e.g. define result limits,
see following chapter.

28.5.1.2 Editing a calculation

Result name

The result name is the text which will be shown in the result display and in
the report. The default name corresponds to the result variable.

Entry max. 24 characters
Default value R1…R9

Calc. formula R1...R9

Shows the calculation formula. A special editor is opened for the defini-
tion (see chapter 28.5.3, page 264). The designation R1...R9 corresponds
to the result variable. Under [Result variable] this can later be modified.

Entry max. 100 characters
Default value empty

Decimal places

Number of decimal places used to display the result.

Input range 0 to 5 
Default value 2 

Result unit

The result unit is displayed and saved together with the result.

Entry max. 10 characters
Selection % | mol/L | mmol/L | g/L | mg/L | mg/mL |

 mg/100 g | ppm | g | mg | µg | mL | µL | mg/
piece | °C | µg/min | mL/min | µL/min

Default value %
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[Note]

Entering a note on the calculation.

[Result variable]

Modifying the result variable.

[Result limits]

Defining the limits for the monitoring of the result.

[Result options]

Defining additional settings for the calculation.

Dialog "Edit calculation / Note"

In this dialog you can enter a short text, e.g. to describe the variables
used.

Dialog "Edit calculation / Result variable"

When a new calculation is created, the result variable will be automatically
issued. In this dialog, however, it can be modified at any time.

Result variable

To each calculation belongs an unambiguous result variable. With this
result variable you can use this result in additional calculations.

Selection R1 | R2 | R3 | R4 | R5 | R6 | R7 | R8 | R9
The selection contains only those result variables
which are not issued in this calculation command
yet.

Dialog "Edit calculation / Result limits"

For each result, limit values can be defined. These result limits are moni-
tored when the calculation is carried out. If monitoring is activated, the
results are shown as follows in the result display:

￭ Green, if the result falls within the limit values
￭ Red, if the result lies outside the limit values

Monitoring result limits

on | off (Default value: off)

Enabling and disabling the monitoring function.

Lower limit

When the monitored quantity falls below this value, the action defined in
the following is triggered.

Input range 0 to 9999999999 
Default value 0 
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Upper limit

When this value is exceeded, the action defined in the following is trig-
gered.

Input range 0 to 9999999999 
Default value 9999999999 

Action

Selection of the action, which is carried out when the result limits are
exceeded.

Selection Display message | Document message | Cancel
determination

Default value Display message

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the result limits
have been exceeded.

Cancel determination
The determination is stopped.

Dialog "Edit calculation / Result options"

In the dialog Edit calculation / Result options, settings for how to
process the calculated result are defined.

Variable for mean value

If the statistic calculations have been activated (see method options), the
mean value of the single results will be saved as variable SMN1 to SMN9.
As default value, always the first free variable is being displayed.

Selection SMN1 … SMN9 | off

off
For the result not statistic calculations are carried out.

Save as common variable

on | off (Default value: off)

The calculated result can be saved as a method-independent variable, a
so-called common variable. The result is then also available in other
methods for calculations. In all cases, only the single value will be saved,
even if the statistics function is enabled.

Variable

Selection of the common variable to which the result is being assigned.
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Selection CV01 … CV25

Display result

on | off (Default value: on)

If you deactivate this parameter, the result is neither displayed in the result
dialog nor printed in the result report. This can be advisable for intermedi-
ate results.

Save result in result table

on | off (Default value: off)

The calculated result can be saved in the result table. This may be advisa-
ble if e.g. the results of all determinations carried out on a particular day
are to be displayed clearly. A maximum of nine results from a determina-
tion can be saved in the result table.

Precision

Setting, with which accuracy the result is used in additional calculations.

Selection Round | Truncate | Full precision
Default value Round

Round
The result is rounded to the defined number of decimal places (com-
mercial rounding, in accordance with the US Pharmacopeia USP). If the
digit at the first dropped decimal place is 1, 2, 3 or 4, then it will be
rounded off; if this digit is 5, 6, 7, 8 or 9, then it will be rounded up.
Negative digits will be rounded in accordance with their amount, i.e.
away from zero.

Truncate
The result is cut to the number of decimal places defined.

Full precision
The result is used with full accuracy (floating point number either in
"single precision" (32 bit) or in "double precision" (64 bit), according to
the standard IEEE 754).

28.5.2 Calculations (CALC LIVE)
The command CALC LIVE can be used to define a calculation, the result
of which will be shown in the live display during a titration or measure-
ment. The current volume or measured value, respectively, is used for this
purpose. This is helpful, e.g. for Karl Fischer titrations, in order to be able
to track the water content directly during the titration.
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CAUTION

The command must be inserted directly before the corresponding titra-
tion or measuring command.

This command is identical with the CALC command except for the follow-
ing differences:

￭ The number of variables is limited.
￭ There are no result options.
￭ The result cannot be monitored.
￭ The result variable cannot be modified.
￭ The result will only be displayed in the live display. It appears neither in

the results dialog nor in a report.

Result name

With live calculations no custom result name can be defined, the designa-
tion LR cannot be modified.

Calculation formula

Shows the calculation formula. A special editor is opened for the defini-
tion (see chapter 28.5.3, page 264).

Entry max. 100 characters
Default value empty

Decimal places

Number of decimal places used to display the result.

Input range 0 to 5 
Default value 2 

Result unit

The result unit is displayed and saved together with the result.

Entry max. 10 characters
Selection % | mol/L | mmol/L | g/L | mg/L | mg/mL |

 mg/100 g | ppm | g | mg | µg | mL | µL | mg/
piece | °C | µg/min | mL/min | µL/min

Default value %

[Note]

Entering a note on the calculation.
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Dialog "Edit calculation / Note"

In this dialog you can enter a short text, e.g. to describe the variables
used.

Displaying the live result

Proceed as follows to display the live result in the live display:

 

1 Starting a determination

￭ Tap on [ ].

The determination starts and the live display is shown:

 

2 Define the display options

￭ Tap on the [View] button.
￭ Tap on the [Meas. value options] button.

A maximum of three measured values can be shown in the live
display.

￭ Select the option Live result at one of the three parameters.

 

3 Display the live display

￭ Tap twice on [ ].

The current result is displayed,

28.5.3 Formula editor
The formulas for the calculations are entered with the formula editor. The
maximum formula length is 100 characters.

The formula editor contains buttons for entering numbers, mathematical
operators and variables. The variables can be selected from lists. This is
advisable in order to avoid spelling mistakes. The formula editor is
equipped with an automatic syntax check, which is activated when apply-
ing the formula. The standard rules of priority apply for the calculation
operations.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 28 Parameters

917 Coulometer ￭￭￭￭￭￭￭￭ 265

Key Description

C00 Sample size

CI Sample identification CI# (# = 1 - 2)

EP Volume of endpoint EP# (# = 1…9)

CV Common Variable CV# (# = 1…25)

R Result R# (# = 1 - 9)

TITER Titer of the titrant selected in the previous command

CONC Concentration of the titrant selected in the previous
command

⌫ The character in front of the cursor is deleted.

Delete entry The content of the input field is deleted completely.

⇦ The cursor within the input field is shifted to the left by
one character.

⇨ The cursor within the input field is shifted to the right by
one character.

If the method contains more than one data-generating command (titra-
tion, measurement etc.) before the calculation command, then you will
have to indicate the command identification in front of the variable:

Variable Description

#M. Titration or measuring command

#C. Calculation command

#E. Evaluation command
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"#" stands for a sequential number that you must enter manually. The
number for each command identification will be counted separately and
does not necessarily correspond to the number of the command line.

Example: The variable 1M.TITER corresponds to the titer of the titrant
selected in the first titration command.

CAUTION

The command identifications are not adjusted automatically when addi-
tional commands are subsequently inserted into the method. Check the
formula for correctness in such cases.

[Variables]

Opening the list of additional variables (see chapter 28.5.3.1, page 266).

[Math. functions]

Opening the list with mathematical functions (see chapter 28.5.3.2, page
266).

28.5.3.1 Variables

All of the variables which can be used for calculations are divided up
according to subject in the dialog Calculation formula / Variables:

￭ System variable
List of the system-specific variables. These variables describe the cur-
rent status of the system.

￭ Result and statistics variables
List of the variables which are required for calculating results and statis-
tics for the current determination.

￭ Common variables
List of common variables. All of the common variables are listed, no
matter whether they possess a value or not.

You will find a detailed description of all of the variables in chapter
28.5.3.3, page 267.

28.5.3.2 Mathematical functions

The following mathematical functions can be utilized in a calculation for-
mula:

Function Description

y^z Power function

Example: 4^2 = 16



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ 28 Parameters

917 Coulometer ￭￭￭￭￭￭￭￭ 267

Function Description

SQRT(X) square root of X

Example: √(EP1)

ABS(X) absolute value of X

Example: ABS(C00); in order, e.g. with reweighings, to
convert the negative sample size to a positive value for
later calculations

LN(X) natural logarithm of X

LOG(X) decimal logarithm of X

FRAC(X) Fraction of X

Example: FRAC(2.5971) = 0.5971

INT(X) integer part of X

Example: INT(2.5971) = 2

TST(X,Y) Test function

If invalid variables (e.g. missing endpoints) occur in a
calculation, then these can be replaced with a valid value
by using this function. In this way invalid results can be
avoided.

￭ Syntax:
– X = variable to be tested
– Y = substitute value

28.5.3.3 Variable list

The following table contains all of the variables which can be used for cal-
culations. For variables having an index (e.g. 'EP1'), the index must be
entered manually. In the following table, this index is characterized with
the character "#".

Variable Description

C00 Sample size

CI1, CI2 Sample identifications

The sample identifications can be used in calculations only if numerical values are entered.

DD Duration of the entire determination

Titrants

TITER Titer of the titrant selected in the titration command

CONC Concentration of the titrant selected in the titration command

Titrations, measurements, calibrations
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Variable Description

EP# Volume/quantity of endpoint EP# (# = 1 - 9)

EC# Charge at endpoint EP# (# = 1 - 9)

EM# Measured value of endpoint EP# (# = 1…9)

EF# ERC of endpoint EP# (# = 1 - 9)

ET# Temperature at endpoint EP# (# = 1…9)

ED# Time at endpoint EP# (# = 1…9)

ESI# Recognition of endpoint EP# (# = 1 - 9)

Endpoint found = 1, no endpoint = 0

FMN Mean gas flow during MEAS T/F ON to MEAS T/F OFF

TMN Mean temperature during MEAS T/F ON to MEAS T/F OFF

TMI Minimum temperature during MEAS T/F ON to MEAS T/F OFF

TMA Maximum temperature during MEAS T/F ON to MEAS T/F OFF

MIM Initial measured value, i.e. measured value prior to the processing of the start conditions

MIT Initial temperature, i.e. temperature prior to the processing of the start conditions

MSA Volume for start volume

MSP Volume for start measured value

MSS Volume for start slope

MSV Volume for all the start conditions

MSD Duration of start conditions

MSM Start measured value, i.e. measured value after the processing of the start conditions

MST Start temperature, i.e. temperature after the processing of the start conditions

MCD Total duration of the titration, measurement or calibration

MTM Type of temperature measurement (Pt1000, NTC or manually)

Format = Text

MDD Duration of effective dosing, i.e. without filling times, pauses

MDC Drift for drift correction

DDC Time for drift correction

MCV End volume, i.e. total dosed volume at the end of the titration

MCQ End quantity, i.e. total amount of removed water or of generated bromine, respectively, at the end
of the titration (in µg)

MCC Final charge, i.e. total charge in mAs at the end of the titration

MCM End measured value

MCT End temperature

MMP Number of measuring points in measuring point list
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Variable Description

MTS Stop type

Format = Text

LV Currently dosed volume of the ongoing determination

LM Current measured value of the ongoing determination

LD Current duration of the ongoing titration or measuring command

LT Current temperature of the ongoing determination

Sensor

MEN Electrode zero point pH(0) or E(0)

MSL Electrode slope

MVA Electrode variance (mathematically only defined for three standards or more);

MCL Cell constant of conductivity measuring cell

Evaluations

FP# Volume of fixed endpoint FP# (# = 1 - 9)

FM# Measured value of fixed endpoint FP# (# = 1 - 9)

FT# Temperature at fixed endpoint FP# (# = 1 - 9)

FD# Time at fixed endpoint FP# (# = 1 - 9)

HP# Volume of pK value / half neutralization potential HP#

HM# Measured value of pK value / half neutralization potential HP#

HT# Temperature at pK value / half neutralization potential HP#

HD# Time at pK value / half neutralization potential HP#

XIP Volume/quantity of minimum measured value

XIM Minimum measured value

XIT Temperature at minimum measured value

XID Time at minimum measured value

XAP Volume/quantity of maximum measured value

XAM Maximum measured value

XAT Temperature at maximum measured value

XAD Time at maximum measured value

BP# Volume of break point BP# (# = 1 - 9)

BM# Measured value of break point BP# (# = 1 - 9)

BT# Temperature at break point BP# (# = 1 - 9)

BD# Time at break point BP# (# = 1 - 9)

RD# Mean rate in time slot # (# = 1 - 9)
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Variable Description

RDS# Standard deviation for RD# (# = 1 - 9)

RDC# Correlation coefficient for RD# (# = 1 - 9)

RM Mean rate for whole range

RMS Standard deviation for RM

RMC Correlation coefficient for RM

Results, statistics

R# Result (# = 1–9)

SMN# Mean value of result R# (# = 1–9)

SSA# Absolute standard deviation of SMN# (# = 1 - 9)

SSR# Relative standard deviation of SMN# in % (# = 1 - 9)

SNR# Number of results from which the mean value SMN# was calculated (# = 1 - 9)

SSD Number of determinations that are carried out for the statistics calculations

SNT Statistics status (statistics activated = 1, statistics deactivated = 0)

Common variables

CV# Common variable (# = 1…25)

System variables

%RN Sample number, i.e. number that is increased by one at each start of a determination

%SC Start counter, see dialog More determination data / Properties

%AS Autostart status (autostart activated = 1, autostart deactivated = 0)

%AC Autostart counter, i.e. number of autostarts already carried out

%AD Autostart setpoint counter, i.e. number of autostarts to be carried out

%SS Status of the sample table (sample table activated = 1, sample table deactivated = 0)

%SL Number of the current sample table line

%SE Last sample in the sample table processed (yes = 1, no = 0)
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28.6 Reports (REPORT)

The reports to be printed out are defined with the command REPORT. A
maximum of ten reports can be defined for each command. The following
reports can be inserted, among others:

￭ Result report
￭ Calculation report
￭ Parameter report
￭ System reports (system settings, sensor list, GLP data etc.)
￭ Method reports (method run, method parameters etc.)

[Report options]

Defining the general settings for the report output.

[Insert]

Add a new report to the list.

[Delete]

Delete the selected report from the list.

[Edit]

Edit the settings of the selected report.

28.6.1 General report options
The settings for the report printout can be adjusted in the dialog Edit
command / Report options to indicate, for example, whether a report
header, a signature line or a frame is to be printed.

Report header

Defining the output of the report header. The report header contains gen-
eral information such as device type, serial number, program version and
the printing date.
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NOTICE

You can also define your own report header, which is printed in addi-
tion to this report header (System ▶ Templates ▶ Report header).

Selection off | once | on each page
Default value on each page

off
The report header will not be printed.

once
The report header will only be printed on the first page.

on each page
The report header will be printed on every page.

Signature line

Output of a special line for date and signature. This line will be printed at
the very bottom of every page.

Selection off | once | on each page
Default value off

off
No signature line will be printed.

once
The signature line will only be printed on the last page.

on each page
The signature line will be printed on every page.

Frame

on | off (Default value: on)

If this parameter is activated, a frame is printed as lateral marking.

28.6.2 Settings of the individual reports

Fixed key [ ]: More reports ▶ Report ▶ Edit

Command REPORT: Report ▶ Edit

Settings can be edited for the following reports (for details, see online
help):

￭ Result report
￭ Curve

Definition of the curve size, display of the individual measuring points
and grid lines, etc.
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￭ Measuring point list
Definition of the method command to which the measuring point list is
to be printed.

￭ Calculations
Definition of the accuracy with which the variables used as well as the
results calculated are printed.

￭ Statistics short
Definition of the time at which the report is to be printed (with each
determination or only at the end of a sample series).

￭ Statistics overview
Definition of the time at which the report is to be printed (with each
determination or only at the end of a sample series).

￭ Sample table
￭ Result table

Definition of the time at which the report is to be printed (with each
determination, at the end of a sample series or at the end of the sam-
ple table).

￭ Used devices
￭ Variables
￭ Monitoring

28.6.3 List of reports
The following reports can be inserted in the command REPORT:

NOTICE

If you are using a CUSTOM NEOS printer, you can print only the
reports that are marked with a # on the display.

Report Contents

Result report # Report with determination properties, sample data, calculated results,
etc. If there are multiple determinations, the statistics will also be printed
out.

Curve # Curve report.

Measuring point list # Measuring point list report.

Calculations # Details concerning the calculations carried out (parameter settings in
accordance with the CALC command and the calculated results).

Used devices  The devices used for the determination, as displayed in the More
determination data / Properties dialog.

Variables  All determination variables, as displayed in the results dialog.

Monitoring  Details for the monitored quantities.

Statistics
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Report Contents

Statistics short # Summary of the statistics calculations. The number of determinations,
the mean value, and the absolute and relative standard deviations are
printed out for each result.

Statistics overview # Detailed statistical overview. The sample data and all individual results
are printed out for each determination. The number of determinations,
the mean value, and the absolute and relative standard deviations are
printed out for each result.

Sample data

Sample table  List of all determinations in the sample table with the respective sample
data, as entered in the sample table.

Result table

Result table  List of all determinations in the result table with results and with the
determination data, as saved in the result table.

More reports ▶ Method reports

Method sequence  Method properties and the list of all method commands.

Parameters full  Method properties and options, all method commands with all parame-
ters.

All parameters which no longer have their default settings will be prin-
ted in bold. All parameters which have been modified in comparison to
the stored version of the method are indicated by an *.

Titration & measuring param.  Method properties; titration and measuring commands with all parame-
ters.

All parameters which no longer have their default settings will be prin-
ted in bold. All parameters which have been modified in comparison to
the stored version of the method are indicated by an *.

Modified parameters  Method properties, all method parameters which have been modified in
comparison to the stored version of the method.

Non default parameters  Method properties, all method parameters which no longer have any
default settings.

More reports ▶ System reports

System settings

System settings  Settings for acoustic signals and accuracy of the measured value display.

Dialog options  Settings for routine dialog and expert dialog.

Titrants

Titrant list  List of all the titrants configured in the system.

All titrant data short  The most important titrant data of all titrants (name, concentration, titer,
last titer determination).

All titrant data full  All of the titrant data of all of the titrants (working life, titer options,
data concerning the exchange unit/dosing unit).
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Report Contents

Sensors

Sensor list  List of all the sensors configured in the system.

All sensor data short  The most important sensor data for all sensors.

All sensor data full  All of the sensor data for all of the sensors (name, working life, etc.).

Device manager

Device list  List of all devices configured in the system.

All device properties  Properties of all the devices configured in the system.

GLP manager

GLP data  All data stored in the GLP manager.

Common variables

Common variable list  List of all the common variables defined in the system, together with
their most important data (name, value, status).

All common variable properties  Properties of all common variables (name, value, validity, status).

Templates

Templates sample data  Sample identification list and sample assignment table.

Result template list  List with all of the user-generated result templates.

All result templates details  Details of the all of the user-generated result templates (calculation for-
mula, result options, note).

Input/Output lines  List with all of the defined input and output lines at the remote interface
(name, bit pattern).

Custom calibration buffers  Temperature tables for all defined custom calibration buffers.

Rack tables

Sample rack list  List with all of the sample racks configured in the system, together with
designation, number of positions and rack code.

Miscellaneous   

Form feed  If this entry is inserted between two reports, then these will each be
printed out on a separate page.
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28.7 Dosing and Liquid Handling

The following dosing commands are available:

Preparing the
exchange unit or
dosing unit (PREP)

Rinsing the cylinder and the tubings of the
exchange unit / dosing unit.

Emptying the dos-
ing unit (EMPTY)

Emptying the cylinder and the tubings of the
dosing unit.

Dosing a fixed vol-
ume (ADD)

Dosing a specified volume.

Liquid Handling
(LQH)

Carrying out complex dosing tasks with a Dos-
ino.

28.7.1 Preparing an exchange or dosing unit (PREP)
The PREP command is used to rinse and fill air bubble-free the cylinder
and tubings of the exchange or dosing unit. You should carry out this
function before the first determination or once a day.

Control device

Selection Selection of configured control devices

Dosing device

Selection of the MSB connector to which the dosing device is connected.
The selection does not depend on the number of MSB connectors of the
control instrument.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the parameters defined for the titrant for
the preparing as well as the tubing parameters (dosing unit only) are used.
Titrants are defined under System ▶ Titrants. You can also enter a name
which is not contained in the titrant list. When a determination is started
there is a check whether the solution is contained in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without integrated data
chip, the cylinder volume and the type of dosing drive are checked. For
the selected titrant, the validity of the titer, the working life of the titrant
and the time interval for the GLP test of the buret unit are checked at the
start of the determination.
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Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place. The command is carried out with default
parameters (see Chapter 31.1.2, page 310 and Chapter 31.2.2, page
311).

Cylinder volume to

This parameter can only be edited with Titrant = not defined.

Selection of the port via which the titrant is ejected. This setting is only rel-
evant for dosing units, in case of preparing an exchange unit, this setting
is ignored.

Selection Port 1 | Port 2 | Port 3 | Port 4
Default value Port 1

28.7.2 Emptying a dosing unit (EMPTY)
The EMPTY command is used to empty the cylinder and tubings of the
dosing unit.

Control device

Selection Selection of configured control devices

Dosing device

Selection of the MSB connector to which the dosing device is connected.
The selection does not depend on the number of MSB connectors of the
control instrument.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the parameters defined for the titrant for
the preparing as well as the tubing parameters (dosing unit only) are used.
Titrants are defined under System ▶ Titrants. You can also enter a name
which is not contained in the titrant list. When a determination is started
there is a check whether the solution is contained in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without integrated data
chip, the cylinder volume and the type of dosing drive are checked. For
the selected titrant, the validity of the titer, the working life of the titrant
and the time interval for the GLP test of the buret unit are checked at the
start of the determination.
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Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place. The command is carried out with default
parameters (see Chapter 31.1.2, page 310 and Chapter 31.2.2, page
311).

Air inlet

This parameter can only be edited with Titrant = not defined.

Selection of the port via which air is aspirated. This setting is only relevant
for dosing units, in case of preparing an exchange unit, this setting is
ignored.

Selection Port 1 | Port 2 | Port 3 | Port 4
Default value Port 4

28.7.3 Dosing a specified volume (ADD)
You can dose a specified volume with the command ADD.

28.7.3.1 Dosing parameters

The parameters for the dosing are defined under [Dosing parameters].

Volume

Volume which is dosed.

Input range 0.00000 to 99999.9 mL
Default value 10.0000 mL

Dosing rate

The rate at which dosing takes place.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing rate depends on the cylinder volume (see chap-
ter 31, page 310).

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum
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maximum
The maximum filling rate depends on the cylinder volume (see chapter
31, page 310).

28.7.3.2 Dosing device

The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
The selection does not depend on the number of MSB connectors of the
control instrument.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, etc.) is always used
for the calculation. Titrants are defined under System ▶ Titrants. You
can also enter a name which is not contained in the titrant list. When a
determination is started there is a check whether the solution is contained
in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

Tandem dosing

A second dosing device can be defined under [Tandem dosing] in order
to enable uninterrupted dosing. Dosing is carried out with a combination
of two dosing devices so that the second dosing device is dosing while
the first one is being filled and vice versa.

Dosing device

Selection of the MSB connector to which the dosing device is connected.
The selection does not depend on the number of MSB connectors of the
control instrument.
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Selection 1 | 2 | 3 | 4 | off
Default value off

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. Titrants are defined under System ▶ Titrants. You can
also enter a name which is not contained in the titrant list. When a deter-
mination is started there is a check whether the solution is contained in
list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without integrated data
chip, the cylinder volume and the type of dosing drive are checked. For
the selected titrant, only the time interval for the GLP test of the buret unit
is checked at the start of the determination.

NOTICE

The concentration, validity of the titer and the working life of the titrant
are ignored.

Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

Filling rate

Rate at which the dosing cylinder is filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum filling rate depends on the cylinder volume (see chapter
31, page 310).

However, in order to ensure uninterrupted dosing, the following points
must be taken into account:

￭ Use the highest possible filling rate in order to keep the filling times as
short as possible. The filling rate should be decreased for viscous liq-
uids.

￭ When you use two buret units with different dosing cylinders, the fill-
ing rate for the larger sized cylinder must be at the minimum:
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= filling rate in mL/min for the larger sized cylinder

= filling rate in mL/min for the smaller cylinder

= cylinder volume in mL of the buret unit of the second dosing
device

= cylinder volume in mL of the buret unit of the first dosing
device

Example:

Dosing device 1: volume = 20 mL, filling rate = 50 mL/min

Dosing device 2: volume = 50 mL

Filling rate 2 ≥ 50 mL/min · 50 mL / 20 mL ≥ 125 mL/min

￭ The dosing rate must not exceed 75% of the filling rate of the smaller
cylinder. These values are listed in the following table, valid at maxi-
mum filling rate:

Table 11 Maximum dosing rate for different dosing cylinders

Cylinder volume maximum dosing rate

Exchange unit Dosing unit

1 mL 2.25 mL/min –

2 mL – 5.00 mL/min

5 mL 11.25 mL/min 12.50 mL/min

10 mL 22.50 mL/min 25.00 mL/min

20 mL 45.00 mL/min 50.00 mL/min

50 mL 112.50 mL/min 124.50 mL/min

28.7.3.3 Stirrer

The parameters for the stirrer are edited under [Stirrer].

Stirrer

Selection of the MSB connector the stirrer is connected to. The selection
does not depend on the number of MSB connectors of the control instru-
ment.

Selection 1 | 2 | 3 | 4 | off
Default value 1
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off
No stirrer will be used.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 31.3, page 311. The optimum stirring
rate can be tested in the manual control.

The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

Switch off automatically

on | off (Default value: on)

If this parameter is activated, the stirrer will be switched off automatically
at the end of the titration, measurement, etc.

28.7.4 Liquid Handling (LQH)

28.7.4.1 Liquid Handling parameters

The parameters for the Liquid Handling function are defined under [Liq-
uid Handling param.].

Function

Type of Liquid Handling function.

Selection Dose | Fill | Aspirate | Eject | Exchange posi-
tion | Change port | Compensate | End volume

Dose
The given volume is dosed. The dosing cylinder neither is automatically
filled before nor afterwards.

Fill
The dosing cylinder is filled. The valve disc then remains at the selected
port.

Aspirate
Liquid is aspirated. The dosing cylinder neither is automatically filled
before nor afterwards. The aspirating volume has to be aspirated with
a single piston stroke.
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Eject
The whole cylinder content is ejected. The piston is, in contrast to the
function End volume, lowered to the stop point, i.e. past the maxi-
mum volume mark. This function should only be carried out for prepar-
ing a dosing unit before the pipetting procedure.

Exchange position
The dosing cylinder is filled. This means that, for example, air can be
aspirated via Port 4. The valve disc is then rotated to Port 2 and the
dosing drive can be removed from the dosing unit.

Change port
The stopcock is moved to the given port, but no piston movement
takes place.

Compensate
Because of the fact that the dosing units are interchangeable, the cou-
pling of the Dosino piston rod (spindle) exhibits a low mechanical toler-
ance that can be noticed when the piston changes its direction of
movement. This tolerance can be compensated with this function. A
short piston movement is first made in the same direction as the previ-
ous movement, which is then followed by a piston movement in the
reverse direction.

End volume
The whole cylinder content is ejected. The piston is lowered to the
maximum volume mark i.e. until 10'000 pulses have been dosed. This
command should be used for pipetting functions for emptying the cyl-
inder.

In-/Outlet

Selection of the port via which the Liquid Handling command is carried
out.

Selection Port 1 | Port 2 | Port 3 | Port 4

Port 1
Default value, when Function = Dose, Aspirate and End volume.

Port 2
Default value, when Function = Fill, Exchange position and
Change port.

Port 4
Default value, when Function = Eject and Compensate.

Volume

This parameter can only be edited with Function = Dose and Aspirate.

Volume which is dosed or aspirated.
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Function = Dose:
Input range 0.00000 to 99999.9 mL
Default value 1.00000 mL

Function = Aspirate:
Input range 0.00000 to 50.0000 mL
Default value 1.00000 mL

Flow rate

This parameter can only be edited with Function = Dose, Fill, Aspirate,
Eject, Exchange position and End volume.

Rate at which it is dosed or filled.

Input range 0.01 to 166.00 mL/min
Selection maximum
Default value maximum

maximum
The maximum dosing and filling rates depend on the cylinder volume
(see chapter 31, page 310).

28.7.4.2 Dosing device

The parameters for the dosing device are edited under [Dosing device].

Dosing device

Selection of the MSB connector to which the dosing device is connected.
The selection does not depend on the number of MSB connectors of the
control instrument.

Selection 1 | 2 | 3 | 4
Default value 1

Titrant

Selection of the titrant from the titrant list. We recommend always select-
ing the titrant. This ensures that the correct data (titer, etc.) is always used
for the calculation. Titrants are defined under System ▶ Titrants. You
can also enter a name which is not contained in the titrant list. When a
determination is started there is a check whether the solution is contained
in the list.

For buret units with integrated data chip, a check is made in the method
run to verify whether the correct titrant has been attached and whether
the type of dosing drive matches. For buret units without an integrated
data chip, the cylinder volume and the type of dosing drive are checked.
For the selected titrant, the validity of the titer, the working life of the
titrant and the time interval for the GLP test of the buret unit are checked
at the start of the determination.
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Selection Selection of configured titrants | not defined
Default value not defined

not defined
No check takes place.

28.8 Communication

The following communications commands are available:

Scanning remote
lines (SCAN)

Defining remote signals which are awaited
before the next method command is started.

Setting remote
lines (CTRL)

Defining remote signals.

Receiving RS-232
commands (SCAN
RS)

Defining RS-232 commands which are awaited
before the next method command is started.

Sending RS-232
commands (CTRL
RS)

Defining the RS-232 commands which are sent.

28.8.1 Scanning remote lines (SCAN)
The command SCAN can be used to define input signals at the remote
interface which are awaited before the next method command is started.

Control device

Selection Selection of configured control devices

Remote Box

Selection of the MSB connector the Remote Box is connected to. The
selection does not depend on the number of MSB connectors of the con-
trol instrument. The remote signal defined is requested on this Remote
Box.

Selection 1 | 2 | 3 | 4
Default value 1

Input signal

Selection of the signal out of the templates or entering the required bit
pattern. Templates are defined under System ▶ Templates ▶ Input
lines.

Entering a bit pattern:

￭ 0 = line inactive
￭ 1 = line active
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￭ * = retain line status

The input lines are always numbered from right to left, i.e. with the signal
*******1 line 0 is expected to be active.

NOTICE

We recommend masking lines that are of no interest or for which no
defined condition can be predicted with an asterisk (*).

Entry Bit patterns containing exactly 8 characters
or a max. of 24 characters for the name of
the template

Default value ********
Selection Selection of the templates defined

Timeout

When this time interval has expired without recognizing the remote signal,
the action defined in the following is triggered.

Input range 0 to 999 s
Default value 0 s

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.
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28.8.2 Setting remote lines (CTRL)
The command CTRL can be used to define output signals at the remote
interface.

Control device

Selection Selection of configured control devices

Remote Box

Selection of the MSB connector the Remote Box is connected to. The
selection does not depend on the number of MSB connectors of the con-
trol instrument. The remote signal defined is sent via this Remote Box.

Selection 1 | 2 | 3 | 4
Default value 1

Output signal

Selection of the signal out of the templates or entering the required bit
pattern. Templates are defined under System ▶ Templates ▶ Output
lines.

NOTICE

A line set active is not being reset automatically, not even at the end of
the determination.

Entering a bit pattern:

￭ 0 = line inactive
￭ 1 = line active
￭ * = retain line status
￭ p = set pulse

The output lines are always numbered from right to left, i.e. with the sig-
nal *************1 line 0 is set. With a pulse, the length is set to 200 ms.
If it is required to set pulses with other lengths, you have to define a corre-
sponding template.

NOTICE

We recommend masking lines that are of no interest or for which no
defined condition can be predicted with an asterisk (*).
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Entry Bit patterns containing exactly 14 characters
or a max. of 24 characters for the name of
the template

Default value **************
Selection Selection of the templates defined

28.8.3 Scanning the RS-232 interface (SCAN RS)
The command SCAN RS can be used to define RS-232 commands which
are awaited before the next method command is started.

Serial port

Selection of the serial interface the peripheral device is connected to. The
RS-232 command defined is requested on this interface.

Selection COM1 | COM2 | COM3 | COM4 | COM5 |
 COM6 | COM7 | COM8

Default value COM1

Character string

Input of the RS-232 command as character string. All characters of the
ASCII code page can be used. Control characters (Esc, FF etc.) have to be
entered as a three-place, decimal ASCII code, starting with a slash. Each
command is automatically terminated with the ASCII characters CR and
LF. The * can be used for one or more characters.

Entry ASCII string with a max. of 24 characters
Default value !*.R

Timeout

When this time interval has expired without recognizing the RS-232 com-
mand, the action defined in the following is triggered.

Input range 0 to 999 s
Default value 0 s

Action

Selection of the action which is carried out when the time interval has
expired.

Selection Display message | Document message | Cancel
determination

Default value Display message
For all three options it is documented in the deter-
mination data (see dialog More determination
data / Messages), that the time interval has been
expired.
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Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

Document message
In the determination data it will be documented, that the time interval
has been expired.

Cancel determination
The determination is stopped.

28.8.4 Defining RS-232 commands (CONTROL RS)
The command CONTROL RS can be used to define the RS-232 com-
mands which are sent.

Serial port

Selection of the serial interface the peripheral device is connected to. The
RS-232 command defined is sent via this interface.

Selection COM1 | COM2 | COM3 | COM4 | COM5 |
 COM6 | COM7 | COM8

Default value COM1

Character string

Input of the RS-232 command as character string. All characters of the
ASCII code page can be used. Control characters (Esc, FF etc.) have to be
entered as a three-place, decimal ASCII code, starting with a slash. Each
command is automatically terminated with the ASCII characters CR and
LF.

Entry ASCII string with a max. of 24 characters
Default value &M;$G

28.9 Automation

28.9.1 Rotating sample rack (MOVE)
The command MOVE is used to move to a rack position or an external
position.

Tower

Selection of the tower, with which the command is carried out. Both
Tower 1 and Tower 2 can always be selected, even if your Sample Pro-
cessor has only one tower.

Selection 1 | 2
Default value 1
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1
View from the front, the right tower.

2
View from the front, the left tower.

Destination

Selection of the required target position.

Beaker test action

This parameter can only be edited with Destination = Sample, Next
position or Prev. position.

Selection of the action which is carried out when the beaker sensor does
not detect any vessel at the sample position moved to. In addition, enable
the beaker sensor in the rack table.

Selection Rotate rack | Display message
Default value Display message

Rotate rack
The rack is moved to the next vessel on a sample position. Exception:
If the sample variable is newly defined in the method before this com-
mand (command SAMPLE), then the option Display message is
automatically valid.

Display message
A message is displayed. You can select whether you want to continue
with the determination or cancel the run.

NOTICE

This parameter is ignored with the 885 Compact Oven SC.

Options

Shift rate

Rate at which the sample rack is moved.

Input range 3 to 20 °/s
Default value 20 °/s

NOTICE

This parameter is ignored with the 885 Compact Oven SC.
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Shift direction

Direction in which the rack is moved.

Selection auto | + | -
Default value auto

auto
A shift direction, with which the shorter way has to be passed, is auto-
matically selected.

+
Counterclockwise rotation.

-
Clockwise rotation.

Swing rate

Rate at which the robotic arm is swung.

Input range 10 to 55 °/s
Default value 55 °/s

28.9.2 Moving the lift (LIFT)
The lift of a Sample Processor is moved with the command LIFT. The
movement can, however, only be carried out if the Sample Processor is
located at a valid rack position. This will not be the case, for example,
after a Rack Reset.

Tower

Selection of the tower, with which the command is carried out. Both
Tower 1 and Tower 2 can always be selected, even if your Sample Pro-
cessor has only one tower.

Selection 1 | 2
Default value 1

1
View from the front, the right tower.

2
View from the front, the left tower.

Lift position

Selecting a predefined lift position or enter any lift position. The prede-
fined lift positions are defined in the device properties of the Sample Pro-
cessor. They can, however, also be assigned in the manual control.

Input range 0 to 235 mm
Selection Work position | Shift position | Rinse position |

 Special position | Home position
Default value Work position
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Home position
The lift is being located at the upper stop position, i.e. at the position 0
mm.

For the 885 Compact Oven SC, the position 0 mm is approached when
Shift position, Rinse position and Special position is selected.

Lift rate

Speed at which the lift is moved.

Input range 5 to 25 mm/s
Default value 20 mm/s

NOTICE

This parameter is ignored with the 885 Compact Oven SC.

28.9.3 Resetting the rack (RACK)
The following actions are carried out with the command RACK:

￭ Rack, lift and robotic arm are being reset.
￭ The rack code of the rack attached is being read out and the corre-

sponding rack data is transferred to the Sample Processor.
￭ The sample variable is reset to the value 1.

Check rack

on | off (Default value: off)

Activate this parameter when the rack attached is to be checked. For this
you, however, have to additionally select the rack in the dialog Method
options / Start options at the option Check rack.

NOTICE

This option is not available with the 885 Compact Oven SC. Therefore,
this parameter must be set to no.

28.9.4 Defining the sample variable (SAMPLE)
The sample variable describes the current position of the sample on the
rack of the Sample Processor. It is automatically increased by 1 after the
end of a method run. In the following cases, the sample variable is auto-
matically reset to the value 1:

￭ if the autostart counter is reset.
￭ if the sample rack is reset.
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The sample variable can be altered specifically with the command SAM-
PLE.

Sample variable

Modifying the sample variable.

Selection = | + | -
Default value +

=
The sample variable corresponds to the number entered in the field
Value.

+
The sample variable corresponds to the current value plus the number
entered in the field Value.

-
The sample variable corresponds to the current value minus the num-
ber entered in the field Value.

Value

Value by which the current sample variable is to be modified.

NOTICE

The sample variable can only be set on rack positions which are not
defined as special beakers.

Input range 1 to 999 
Default value 1 

28.9.5 Creating a subsequence (SUBSEQ)
It is useful, particularly with more complex tasks, e.g. rinsing sequences or
Liquid Handling, to combine individual command sequences into a single
subsequence. Subsequences are managed the same as method com-
mands. A maximum of 99 commands can be combined to form a single
subsequence. There is no limit to the number of subsequences within one
method.

[Load/ Save]

Loading a saved subsequence or saving the current subsequence.

[Subseq. options]

Defining various settings which correspond to the entire subsequence.

[Insert command]

Insert a new method command. It is inserted before the selected com-
mand.
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NOTICE

Not all commands are available for subsequences. Commands which
cannot be inserted into subsequences are disabled.

[Delete command]

Delete the selected method command.

[Edit command]

Edit the selected method command.

28.9.5.1 Loading / saving a subsequence

[Load/ Save] is used to load stored subsequences or to save new subse-
quences. This means that they are available for all methods and only have
to be created once.

Loading a subsequence

[Own subseq.]

Opening the list of own subsequences.

[Load]

Loading the selected subsequence.

Saving a subsequence

Custom-made subsequences are saved in the internal memory.
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NOTICE

In order to be able to use the subsequences also for other titration sys-
tems, you have to create a backup. You can only restore the subse-
quences from this backup on another system.

File name

File name of the subsequence.

Entry max. 32 characters

[Save]

Saving the subsequence to the internal memory.

28.9.5.2 Subsequence options

In this dialog, the settings can be defined which correspond to the entire
subsequence.

Subsequence type

Selection Sample sequence | Start sequence | End
sequence | Stop sequence | Cond. sequence

Default value Sample sequence

Sample sequence
The subsequence is carried out with every determination.

Start sequence
This subsequence is only carried out at the start of a sample series
when the autostart counter = 1.

End sequence
This subsequence is only carried out at the last sample of a series when
the autostart counter has reached the setpoint value (number of autos-
tarts).

Stop sequence
The stop sequence is only carried out when canceling a method
because of one of the following cases: Manual stop with [ ], stop
because of an error, stop via remote signal.

Cond. sequence
This subsequence is carried out directly before the conditioning. This
gives you the possibility to start e.g. a connected Polytron® high-fre-
quency homogenizer before the conditioning as well as to set its stir-
ring rate. Use the command CONTROL RS for this.

Cycles

Number of directly consecutive repetitions of the subsequence.
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[Note]

Entering a note on the subsequence.

Dialog "Subsequence options / Note"

A short text can be entered in this dialog, e.g. for the description of the
subsequence commands or for the application purpose.

[Display options]

Definition when the note is being displayed.

Automatically after loading the subsequence

on | off (Default value: off)

If this parameter is activated, the note is displayed when loading the sub-
sequence. It can otherwise only be read in this dialog.

28.9.6 Controlling the heating (HEATER) 
The heating on the 885 Compact Oven SC is controlled with the HEATER
command.

Status

Switch the heater on or off.

Selection on | off
Default value on

on
The heater is switched on. The command is displayed in the method
run until the specified temperature is reached. The heater runs in the
background until it is explicitly switched off. The current temperature
can be seen in the Manual control.

off
The heater is switched off.

Temperature

Temperature to which the oven is heated.

Input range 50 to 250 °C (Increment: 1)
Default value 110 °C

28.9.7 Controlling the gas flow (FLOW) 
The gas flow is controlled on the 885 Compact Oven SC with the FLOW
command.

Status

Switch the gas flow on or off.
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Selection on | off
Default value on

on
The gas flow is switched on. The gas flow runs until it is switched off.
The current gas flow can be seen in the Manual control.

off
The gas flow is switched off.

Flow rate

Flow rate for the gas flow.

Input range 10 to 150 mL/min (Increment: 1)
Default value 50 mL/min

Gas supply

Selection of the gas supply.

Selection pump | valve
Default value pump

pump
The integrated air pump is used for the gas flow.

valve
The integrated inlet valve is used for the gas flow. The inlet valve in the
885 Compact Oven SC is connected to compressed air or nitrogen.

Gas type

Gas type of the carrier gas used.

Selection air | nitrogen
Default value air

28.9.8 Starting the measurement for temperature and gas flow (MEAS
T/F ON) 

Data acquisition and evaluation of the data of the 885 Compact Oven SC
is started with the MEAS T/F ON command.

The following values are output as raw data and are available as variables:

￭ Mean gas flow (evaluation starts after 10 s).
￭ Mean temperature
￭ Minimum temperature
￭ Maximum temperature

After a MEAS T/F ON command, there must also be a MEAS T/F OFF
command present in the method run. If one of the two commands is
missing or the order is not followed, the command is depicted in red. No
parameters can be edited for this command.
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28.9.9 Exiting the measurement for temperature and gas flow (MEAS
T/F OFF) 

The data acquisition evaluation of the data of the 885 Compact Oven SC
is finished with the MEAS T/F OFF command. There must be a MEAS
T/F ON command present before a MEAS T/F OFF command in the
method run. The command will be depicted in red if this is not fulfilled.
No parameters can be edited for this command.

28.10 Miscellaneous commands

28.10.1 Controlling a stirrer (STIR)
A stirrer is controlled with the command STIR.

Control device

Selection Selection of configured control devices

Stirrer

Selection of the MSB connector the stirrer is connected to. The selection
does not depend on the number of MSB connectors of the control instru-
ment.

Selection 1 | 2 | 3 | 4
Default value 1

Status/Duration

Switching the stirrer on or off.

Input range 0 to 999 s (Increment: 1)
During this time the stirrer is running.

Selection on | off
Default value on

on
The stirrer is switched on. The stirrer runs until it is explicitly switched
off. If the determination is canceled with the key [ ], the stirrer is
also switched off.

off
The stirrer is switched off.

Stirring rate

Setting the stirring rate. It can be set in steps of –15 to +15. The default
setting 8 corresponds to 1000 rpm. The formula for calculating the rota-
tional speed is specified in chapter 31.3, page 311. The optimum stirring
rate can be tested in the manual control.
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The algebraic sign of the stirring rate changes the direction in which the
stirring is done. When the stirrer is viewed from above, this means:

￭ "+": counterclockwise rotation
￭ "–": clockwise rotation

Input range –15 to 15 
Default value 8 

28.10.2 Pausing the method run (WAIT)
The method run can be paused with the command WAIT.

Hold sequence

on | off (Default value: off)

If this parameter is activated, then the method run is paused until it is con-
tinued manually.

Waiting time

This parameter can only be edited when Hold sequence is deactivated.

The method run is automatically continued after this waiting time.

Input range 0 to 99999 s
Default value 30 s

Message

on | off (Default value: off)

If this parameter is activated, the text message defined in the following is
displayed during the waiting time.

Message text

This parameter can only be edited when Message is activated.

Text which is displayed during the waiting time.

Entry max. 28 characters
Default value empty

28.10.3 Scan data (REQUEST)
The following data can be scanned in the method run with the command
REQUEST:

￭ Sample data
– Sample identification 1
– Sample identification 2
– Sample size (value and unit)

￭ Common variable
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You can select thereby whether the sequence should be paused or
resumed in the background.

Sample ident.

Selection of the sample identification that is queried in the method run.

Selection off | Identification 1 | Identification 2 | ID1 &
ID2

Default value off

Sample size

on | off (Default value: on)

If this parameter is activated, then the value for the sample size will be
requested.

Sample size unit

on | off (Default value: off)

If this parameter is activated, then the unit for the sample size will be
requested.

Common variable

Selection of the common variable which is queried in the method run.

Selection CV01…CV25 | off
Default value off

Hold sequence

on | off (Default value: on)

If this parameter is activated, then the run will be paused during the
request. If this parameter is deactivated, then the method continues in the
background until the following measurement or titration has been com-
pleted.

28.10.4 Defining an acoustic signal (BEEP)
The BEEP command can be used to produce an acoustic signal.

Duration

Approximate playing time in seconds of the permanently stored melody.

Input range 1 to 9 
Default value 1 
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28.10.5 Signing a determination (SIGN)
A determination can be signed with the SIGN command. The method run
is automatically paused as soon as this command is reached. At the same
time a switch is made to the result view. The run will not be continued
until the determination has been signed or the SIGN command has been
canceled. You can specify whether a routine user is allowed to cancel the
SIGN command in the setting System ▶ System settings ▶ Dialog
options ▶ Routine dialog. No parameters can be edited for this com-
mand. The parameters for signing determinations are described in chapter
16.1, page 149.

NOTICE

Methods with this command can only be started if you are working
with login and password protection.

The command should always be inserted at the end directly before the
REPORT command or at the end of the method sequence if a PC/LIMS
report is to be sent automatically.

28.10.6 Canceling the method run (END)
The method run will cancel as soon as the END command is reached. This
is a good idea if you wish to test only the first part of a method. No
parameters can be edited for this command.
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29 Operation and maintenance

29.1 System initialization

In very rare instances, a faulty file system (e.g. because of a program
crash) may lead to an impairment of program functioning. The internal file
system must be initialized in such cases.

CAUTION

If you carry out a system initialization, then all user data except the
methods will be deleted.

We recommend creating a backup of the system at regular intervals in
order to avoid data losses.

Proceed as follows for the system initialization:

 

1 Switching off the instrument

￭ Press the power switch at the rear.

 

2 Switching on the instrument

￭ Press the power switch at the rear.
An image with a frog will be displayed after a couple of seconds.

￭ While the image is being displayed, press the power switch again
and hold it down.

￭ Do not release the power switch until an acoustic signal sounds.

A system message is displayed.

 

3 Confirm system initialization

￭ Confirm the message with [Yes].
A second security prompt is displayed.

￭ Confirm this message with [Yes] as well.

Initialization is started. After the initialization has been completed,
the 917 Coulometer is started automatically.
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29.2 Maintenance

Maintenance

The electronic and mechanical functional groups of Metrohm instruments
can and should be checked by specialist personnel from Metrohm as part
of a regular preventive maintenance schedule. Please ask your local
Metrohm representative regarding the precise terms and conditions
involved in concluding a corresponding maintenance agreement.

For detailed information on this topic, please visit www.metrohm.com.

Cleaning

Cleaning the surfaces of the instrument

Prerequisites

￭ The instrument is disconnected from the power grid.

 

1 Clean the surfaces with a damp cloth.

NOTICE

Water or ethanol can be used as a cleaning medium.

NOTICE

The connectors at the rear of the instrument must only be cleaned
with a dry cloth.

http://www.metrohm.com
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30 Troubleshooting

30.1 Editing methods

Problem Cause Remedy

The method com-

mand cannot be

inserted.

No control instrument

which supports the

method command is con-

figured in the device man-

ager.

Add a control instrument which supports the

desired method command to the list of devices

(see chapter 10, page 64).

The additional eval-

uations (EVAL com-

mands) cannot be

inserted.

A titration or measuring

command to which the

evaluation can be applied

is missing.

1. Insert a titration or measuring command.

2. Insert the EVAL command directly after it.

A MEAS T/F ON

command or MEAS

T/F OFF command is

depicted in red in

the command list.

The corresponding MEAS

T/F ON command or MEAS

T/F OFF command is miss-

ing or not inserted in the

correct order in the

method run. To be able to

execute a method, both

MEAS T/F commands are

needed in the method run.

Insert the missing MEAS T/F command and

observe the logical order of the commands.

An EVAL command

is depicted in red in

the command list.

The associated titration or

measuring command has

been deleted or replaced

by a different one.

1. Delete the EVAL command.

2. Insert a titration or measuring command.

3. Insert the EVAL command directly after it.

30.2 Sample table

Problem Cause Remedy

The method cannot

be entered in the

sample table.

The option Use sample

assignment table is acti-

vated. The method

assigned to the sample

identification will be loa-

ded automatically at the

start of the determination.

Deactivate the option (see chapter 14.1, page

117).
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30.3 Results/Statistics

Problem Cause Remedy

No statistics are car-

ried out for a result.

Statistics is not activated. In the method options, activate the option

Statistics (see chapter 15.5, page 137).

No statistics variable has

been assigned to the

calculation.

In the result options (command CALC), define

a variable for the mean value (see "Variable for

mean value", page 123).

Statistics is not activated. In the control dialog, activate the Statistics

option (see chapter 17, page 151).

A result has been

removed from the

statistics, the mean

value has not been

reassigned to the

common variable or

to the TITER varia-

ble.

Assignment is not carried

out automatically with ret-

roactive modifications.

Recalculate the determination manually (see

chapter 23, page 178).

The result is not dis-

played in the result

table.

The column display in the

result table is incorrectly

configured.

Modify the settings for the display accordingly

(see chapter 25.1, page 200).

The parameter Save result

in result table is not acti-

vated.

In the result options (command CALC), acti-

vate the parameter (see "Save result in result

table", page 124).

30.4 Printing

Problem Cause Remedy

Tapping on the fixed

key [ ] has no

effect.

The fixed key is disabled. In the Dialog options / Fixed keys dialog,

activate the Print option (see chapter 7.2,

page 39).

A determination is running. Wait until the determination is finished.
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30.5 Manual control

Problem Cause Remedy

Tapping on the fixed

key [ ] has no

effect.

The fixed key is disabled. In the Dialog options / Fixed keys dialog,

activate the Manual control option (see

chapter 7.2, page 39).

A button in the

manual control is

disabled.

The required hardware is

either not connected or

incorrectly connected.

1. Switch off the 917 Coulometer.

2. Connect the hardware correctly.

3. Switch the 917 Coulometer back on.

The required hardware is

being used in the ongoing

determination.

Wait until the determination is finished.

30.6 Titration stand with pump

Problem Cause Remedy

Solvent is added at

the same time dur-

ing aspiration.

The adsorber tube is

blocked.

￭ Enlarge the hole of the drying tube cover

to 2 mm at least.

￭ Refill the adsorber tube, pack not too

tightly, perhaps remove some of the molec-

ular sieve.

The pump conveys

no liquid.

The add/aspirate key is not

pressed tightly enough.

￭ Usually the bottle attachments are not

screwed tightly enough to the reagent and

waste bottles.

￭ Check all connections for leak-tightness.

The solvent flows on

into the titration

vessel after the

addition, without

the add key being

pressed.

The solvent bottle is not

positioned correctly.

Position the solvent bottle in such a way that

the liquid level in the bottle is lower than that

in the titration vessel.

30.7 Coulometric Karl Fischer titration

Problem Cause Remedy

The drift is very high

during conditioning.

The titration cell is leaking. ￭ Check the septum and replace it if neces-

sary.

￭ Replace the molecular sieve.
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Problem Cause Remedy

￭ Check the ground-joint sleeves for frayed

edges. If necessary, trim the edges neatly

or replace the ground-joint sleeves.

Deposits containing water

can be found in the titra-

tion cell.

￭ Shake the titration cell.

The reagent is exhausted

or contaminated.

￭ Replace the reagent.

The catholyte is old or

moist.

￭ The catholyte must be replaced at least

once per week.

￭ Dry the catholyte with KF one-component

reagent.

The diaphragm of the gen-

erator electrode is contam-

inated.

￭ Clean the diaphragm (in accordance with

directions in the leaflet for the generator

electrode).

A side reaction is taking

place.

￭ Consider using a KF oven.

￭ See technical literature.

The molecular sieve on the

KF oven has reached its

capacity limit.

￭ Replace the molecular sieve.

The gas flow from the KF

oven into the titration cell

is too high.

￭ Reduce the gas flow (if you are working

with the oven method with sample vials,

set the gas flow between 40 and 60

mL/min).

The drift becomes

greater after each

titration.

The sample releases water

very slowly.

￭ Consider using a KF oven.

￭ See technical literature.

The drift is fluctuat-

ing.

The sample solution is

poorly stirred.

￭ Set the stirring rate in such a way that the

sample solution will become very well

mixed.

The Control parameters

are set incorrectly.

￭ Reset the Control parameters to default

values.

The titration time is

too long.

The drift during condition-

ing is not stable.

￭ Wait before starting the titration until the

drift has become stable.

The parameter Start drift

is set too high.

￭ Set the Start drift lower.



30.7 Coulometric Karl Fischer titration ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

308 ￭￭￭￭￭￭￭￭ 917 Coulometer

Problem Cause Remedy

￭ Adjust the Stop drift or use the Relative

stop drift.

The parameter Stop drift

is set too low.

￭ Set the Stop drift higher or use the Rela-

tive stop drift.

The water quantity is too

high.

￭ Observe the sample size and water con-

tents in accordance with .

The Control parameters

are set incorrectly.

￭ Set the parameter Dynamics lower and

the parameter Max. rate higher.

The result is too

high.

The titration cell is not yet

correctly conditioned.

￭ Shake the titration cell and wait until the

drift is stable.

The sample contains oxi-

dizable substances.

￭ Consider using a KF oven.

￭ See technical literature.

The parameter Stop drift

is set too low.

￭ Set the Stop drift higher or use the Rela-

tive stop drift.

The drift correction is too

small (e.g. for the use of a

KF oven or for manual drift

correction).

￭ Start the titration as long as the gas flow

still exists between the conditioning vial

and the titration cell.

￭ Set the parameter Drift correction to

auto (= automatic drift correction).

The result is too

low.

The sample releases iodine. ￭ Consider using a KF oven.

￭ See technical literature.

The parameter Stop drift

is set too high.

￭ Set the Stop drift lower.

The drift correction is too

large (e.g. with excessively

high start drift, with fluctu-

ating drift or with manual

drift correction).

￭ Ensure stable and lower drift.

￭ Set the parameter Drift correction to

auto (= automatic drift correction).

The parameter Min. rate

is set too low.

￭ Set the parameter Min. rate higher.

￭ Reset the Control parameters to default

values.

The results are

spread widely.

The sample is nonhomoge-

nous.

￭ Homogenize the sample if possible.

￭ Possibly use a larger sample size.
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Problem Cause Remedy

The sample addition is diffi-

cult to reproduce.

￭ Observe the instructions in .

The drift fluctuates. ￭ Ensure stable drift.
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31 Appendix

31.1 Dosing unit

31.1.1 Maximum dosing and filling rate
The maximum dosing rate and maximum filling rate for the dosing unit
depend on the cylinder volume:

Cylinder volume Maximum rate

2 mL 6.67 mL/min

5 mL 16.67 mL/min

10 mL 33.33 mL/min

20 mL 66.67 mL/min

50 mL 166.00 mL/min

Independent of the cylinder volume, values ranging from 0.01 to 166.00
mL/min can always be entered. When the function is carried out the rate
will be, if necessary, decreased automatically to the highest possible value.

31.1.2 Default parameters for preparing (PREP) and emptying (EMPTY)
The PREP command is used to rinse and fill the cylinder and tubings of
the dosing unit air bubble-free. You should carry out this function before
the first determination or once per day.

The command EMPTY is used to empty the cylinders and the tubings of
the dosing unit.

If no titrant is selected in the command, preparing and emptying will be
carried out with the following default parameters:

￭ The entire cylinder volume is dosed at the maximum dosing rate
through Port 1.

￭ The cylinder is filled at the maximum filling rate through Port 2.
￭ The following dimensions apply for the tubings:

– Tubing at Port 1: length = 40.0 cm, diameter = 2 mm
– Tubing at Port 2: length = 25.0 cm, diameter = 2 mm
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31.2 Exchange unit

31.2.1 Maximum dosing and filling rate
The maximum dosing rate and maximum filling rate for the exchange unit
depend on the cylinder volume:

Cylinder volume Maximum rate

1 mL 3.00 mL/min

5 mL 15.00 mL/min

10 mL 30.00 mL/min

20 mL 60.00 mL/min

50 mL 150.00 mL/min

Independent of the cylinder volume, values ranging from 0.01 to 166.00
mL/min can always be entered. When the function is carried out the rate
will be, if necessary, decreased automatically to the highest possible value.

31.2.2 Default parameters for preparing (PREP)
The PREP command is used to rinse and fill the cylinder and tubings of
the exchange unit air bubble-free. You should carry out this function
before the first determination or once per day.

If no titrant is selected in the command, preparing will be carried out with
the following default parameters:

￭ The entire cylinder volume is dosed twice at the maximum dosing rate.
￭ The cylinder is filled at the maximum filling rate.

31.3 Stirring rate

The stirring rate can be adjusted in steps from –15 to +15.

The approximate rotational speed for the internal magnetic stirrer
(depends on the product version) can be calculated with the following for-
mula:

Rotational speed/min (r/min) = 125 · Stirring rate

Example:

Configured stirring rate: 8

Rotational speed in revolutions per minutes = 125 · 8 = 1,000
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Figure 18 Rotational speed depending on the stirring rate

The information on the separately connectable 802 propeller stirrer can be
found in the "802 Stirrer" manual.

31.4 Balance

The sample size and the associated unit can be sent from a connected bal-
ance. The sample size is transmitted as a number with up to ten characters
(including algebraic sign and decimal point).

Sample size and unit are sent as a single character string. They are separa-
ted by a space character. The string is terminated with the ASCII charac-
ters CR and LF.

If the balance sends a negative sample size (e.g. when you are reweighing
a sample), then the algebraic sign is adopted. The algebraic sign is, how-
ever, ignored for the calculations.

NOTICE

With some balances, the sample identification and the method can be
sent in addition to the sample size.

Make sure that the balance does not send the sample size until the end.

Mettler AX

For the Mettler AX balance, the fields that contain the sample identifica-
tion or the method must be designated as follows:

￭ Designation for the field with the method name: METHOD
￭ Designation for the field with sample identification 1: ID1
￭ Designation for the field with sample identification 2: ID2
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31.5 Result variables as parameter setting

For most of the numerical parameters, the result of a calculation can also
be utilized in place of a number. This result must be calculated in a preced-
ing calculation command (command CALC). A typical application is the
use of a relative start volume.

The following example is used to explain how this method is used to
define a sample size-dependent start volume for a titration. Proceed as fol-
lows:

 

1 Create a new calculation

￭ Insert the calculation command CALC in front of the titration
command.

￭ Enter the calculation formula, e.g. R1 = C00*3.

 

2 Define a result variable as parameter setting

￭ In the titration command, enter the variable R1 as the start vol-
ume.

The selection of the result variables is displayed in the number editor.
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NOTICE

If the method before the command with the result variables applied
contains more than one calculation commands (possibly with result var-
iables bearing the same name), then the result variable of the preceding
calculation command will always be used.

Please note that the result must be within the input range of the
parameter, as otherwise the determination run will be stopped when
the parameter is accessed.

31.6 Using AuditTrailViewer

When you work in accordance with the FDA Guidance 21 CFR Part 11,
logs with detailed user activities (Audit Trail) are important. The
AuditTrailViewer supports you in your efforts to compile, filter and export
logs of this type as TXT files.

First you must install the AuditTrailViewer on your PC. Afterwards, you
must create a backup of your Coulometer (see chapter 11.3, page 97).
The Audit Trail is generated automatically when you create the backup.
The file name of the Audit Trail is log.madt. In the following you will find
detailed information about how you must proceed.

31.6.1 Installing AuditTrailViewer
You will find the file for installing the AuditTrailViewer on the USB flash
drive provided.

Proceed as follows:

 

1 Double-click on the file SetupAuditTrailViewer 1.2.2.exe.

The dialog Welcome to the AuditTrailViewer Setup Wizard is
displayed.

 

2 Click on [Next >].

The License Agreement dialog is displayed.

 

3 Click on [I Agree] to accept the contractual conditions.
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The Choose Install Location dialog is displayed. A memory loca-
tion for the AuditTrailViewer is suggested in this dialog.

 

4 If you accept the suggested memory location, click on [Next >].

or

Select a different memory location and click on [Next >].

The Confirm Installation dialog is displayed.

 

5 Click on [Install] to install the AuditTrailViewer.

As soon as the installation is completed, the dialog Installation
Complete is displayed.

 

6 Click on [Next >].

The dialog Completing the AuditTrailViewer Setup Wizard is
displayed.

 

7 If the AuditTrailViewer should not be started immediately, deactivate
the check box Run AuditTrailViewer.

 

8 Click on [Finish].

If the preceding instruction step has been skipped, then the
AuditTrailViewer will start.

31.6.2 Opening the Audit Trail
Create a backup of the data and of the settings of your Coulometer (see
chapter 11.3, page 97).

 

1 Open the backup on your PC.

 

2

Open the file log.madt with the AuditTrailViewer.



31.6 Using AuditTrailViewer ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

316 ￭￭￭￭￭￭￭￭ 917 Coulometer

AuditTrailViewer dialog window

31.6.3 Contents of the Audit Trail
In the following you will find a description of the dialog window and of
the menu bar of the AuditTrailViewer.

Table 12 Dialog window

Column Content

No. Each entry is numbered in sequence.
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Column Content

Symbol Classification of the entry:

￭

Actions that are neither relevant to safety nor alter the determination
data.

￭

Actions, e.g. changes to the login options and recalculation of determina-
tions.

￭

Errors that occur, e.g. entry of an incorrect password.

Date Precise time of the event.

User User who triggered the action.

Category Category to which the entry belongs.

Action Designation of the action.

Details Details of the action.

Menu bar

Print Print Audit Trail.

An Audit Trail can be printed by means of the  symbol.

Update Update view.

The list is updated automatically only at the time the dialog window is opened.

Quick filter Filter the Audit Trail.

Show all Display all entries once again.

31.6.4 Filtering the Audit Trail
The entries in the Audit Trail can be filtered. You can set the following fil-
ter criteria:

￭ Date
￭ User
￭ Category
￭ Action

Proceed as follows:

 

1 Click in a cell that contains the desired filter criterion (e.g. Category
= Method).
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2 Click on the  icon or the menu item Filter ▶ Quick filter.

The only entries which will be displayed are those which correspond
to the desired filter criterion.

 

3 Click on the  icon or the menu item Filter ▶ Show all.

All of the entries are displayed once again.

31.6.5 Exporting the Audit Trail
You can export the Audit Trail as .txt file. This way, the Audit Trail can be
archived and is available as required for inspections.

Proceed as follows:

 

1 Use the menu item File ▶ Export to open the dialog window for
the export.

 

2 Enter the path and file name with the extension .txt.

 

3 Click on [Open] and then on [Export].

The Audit Trail is exported.

31.7 Diagnosis

System ▶ Diagnosis

The electronic and mechanical functional groups of Metrohm instruments
can and should be checked by specialist personnel from Metrohm as part
of a regular maintenance schedule. Please ask your local Metrohm repre-
sentative regarding the precise terms and conditions involved in conclud-
ing a corresponding maintenance agreement.

The following functions are available:

￭ LCD test
Check the display for faulty pixels (see chapter 31.7.1, page 319).

￭ Format storage medium
Format the external storage medium (see chapter 31.7.2, page 319).

￭ Remove storage medium
Remove the external storage medium safely (see chapter 31.7.3, page
320).

￭ Touch adjustment
Adjust the touch-sensitive screen (see chapter 31.7.4, page 320).
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￭ Touch screen test
Test the function of the touch-sensitive screen (see chapter 31.7.5,
page 321).

￭ Software update
Update the software of Coulometer and of the control instruments (see
chapter 31.7.6, page 322).

￭ Service
Special functions for the service technician (see chapter 31.7.7, page
325).

31.7.1 LCD test
System ▶ Diagnosis ▶ LCD test

You can use the LCD test to check the display for faulty pixels. To do this,
various test images are displayed one after the other.

NOTICE

The [ ] fixed key is used to display the preceding test picture; the test

can be stopped at any time with the [ ] fixed key.

Proceed as follows:

 

1 ￭ Tap on [LCD test].

The entire display turns white.

 

2 ￭ Check the display for pixel errors and other irregularities.
￭ Continue the test with [ ].

Other colors and patterns will be displayed one after the other.

 

3 ￭ Repeat step 2 until the System / Diagnosis dialog is displayed
again.

 

4 ￭ Contact your Metrohm representative in the event of faults or
irregularities.

31.7.2 Formatting an external storage medium
System ▶ Diagnosis ▶ Format storage medium

With this function, you have the option of formatting an external storage
medium directly on the 917 Coulometer (quick formatting).

The following file systems can be selected:

￭ FAT
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￭ FAT32
￭ ExFAT

CAUTION

If you format the storage medium with the ExFAT file system, it is pos-
sible that it will no longer be recognized by a PC. Read the pertinent
information from Microsoft Support at http://support.microsoft.com.

Do not use this file system unless you need to be able to save more
than 999 files in a single group.

31.7.3 Removing an external storage medium
System ▶ Diagnosis ▶ Remove storage medium

As long as the stored data is not being accessed (reading/saving data), you
can plug in and disconnect the storage medium without difficulty at any
time. The [Remove storage medium] function offers additional protec-
tion. This ensures that the storage medium cannot be removed while any
data is being transferred.

31.7.4 Adjusting the touch screen
System ▶ Diagnosis ▶ Touch adjustment

With time the touch-sensitive screen may not register touches at their pre-
cise position. You can readjust the screen in this dialog.

Proceed as follows:

 

1 In the main dialog, tap on [System].

 

2 Tap on [Diagnosis].

 

3 Tap on [Touch adjustment].

A message in English and a cross hair will appear in the center of the
screen.

 

4 Touch a stylus (a special pen-shaped instrument for operating devices
with touch screens) to the center of the cross hair and maintain this
position until the cross hair moves to a new position on the screen.

 

5 Repeat this process as long as the cross hair continues to be reposi-
tioned on the screen.

A message in English will appear.

http://support.microsoft.com/?kbid=955704
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6 Tap at any location on the screen to confirm the adjustment.

 

7 Press [ ] to finish the adjustment.

31.7.5 Testing the touch screen
System ▶ Diagnosis ▶ Touch screen test

You can use this test to check the function of the touch-sensitive monitor
screen.

A calibration is not possible with this test. If the Touch screen does not
work correctly anymore, it will need to be replaced. For that please con-
tact your Metrohm representative.

NOTICE

You can use the [ ] fixed key to stop the test at any time.

Proceed as follows:

 

1 Tap on [Touch screen test].

A red square is displayed at the upper left.

 

2 Tap on the square as close to the center as possible.

The actual detected point of contact will be displayed by a cross hair,
and the deviation from the center will also be displayed on the lower
edge of the image.

The next red square will also be displayed.
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3 Repeat step 2 until all of the areas in the display have been tested.

A list with fixed keys will appear.

 

4 Tap on all of the fixed keys one after the other in any sequence.

The result is displayed in each case with a short information text, e.g.
[Print] key OK.

 

5 Finish Touch screen test with [ ].

31.7.6 Software update (loading program versions and language files)
System ▶ Diagnosis ▶ Software update

New program versions or language files can be loaded from an external
storage medium (e.g. USB flash drive). The corresponding files must be
stored on the storage medium in the 917/SwUpdates directory (see
"Directory structure", page 96).

NOTICE

The memory will be reformatted when updating to software version
5.917.0023.

Before carrying out the software update, make a backup in order to
save your data and the system settings (see chapter 11.3, page 97).

Use a separate USB flash drive for the software update. It must be
removed from the instrument after the successful software update.

Program files

The files are instrument-specific. The file names are structured as follows:

￭ Control software for 917 Coulometer:
5XXXyyyy.BIN
5XXXyyyy.MBIN

– XXX = instrument type (i.e. "917" for the 917 Coulometer)
– yyyy = program version

Language files

Language files may have the following content:

￭ one or more additional dialog languages
￭ the online help for one or more additional dialog languages
￭ supplements for existing dialog languages/online help documents

They can be recognized by means of the two-digit language code in the
file name. The file name has the following structure:
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￭ 5XXXyZZZML.BIN
5XXXyZZZML.MBIN

– XXX = instrument type (i.e. "917" for the 917 Coulometer)
– y = version number of the language package
– ZZZ = program version

31.7.6.1 Carrying out a software update

CAUTION

Make sure that the power supply is guaranteed during the entire
update process. Otherwise there is the chance that the instrument will
no longer be able to be switched on and that it will need to be sent in
for repair.

NOTICE

Make sure that no USB/RS-232 adapter is connected!

Proceed as follows:

 

1 Copying files to an external storage medium

NOTICE

In the case of the program versions and language files for the
Coulometer, it is imperative that both the BIN file and the associ-
ated MBIN file be copied.

￭ Copy the files to the "SwUpdates" directory.
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￭ Copy also the "MetrohmTools" folder with the "MUpdate-
Tool.exe" file to the external storage medium.
Make sure that the file is stored at the top level of the external
storage medium. This also applies to the "917" folder.

For the software update from version 5.917.0023, an
additional folder that is on the same level as Metrohm-
Tools with the name SRVPRF900 containing the file
St900_SrPrf.cfg is required

If this structure is not maintained, then the files will not be found,
because the directories are accessed directly during the update
process.

￭ Plug in the external storage medium at the Coulometer.

 

2 Opening the update dialog

￭ Under System ▶ Diagnosis, tap on the button Software
update.

 

3 Selecting the instrument

￭ Tap on the Control device list box and select the instrument to
be updated.

 

4 Selecting the file

￭ Tap on the Binary file list box.
The selection list with the BIN files saved in the "SwUpdates"
directory is opened.

￭ Select the required file.
￭ Tap on [Select].
￭ Update of the Coulometer: Continue with Step 5.

 

5 Starting the update (917 Coulometer)

￭ Tap on the [Start] button (NOT on the [ ] fixed key).
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￭ The message 023-102 Program update is displayed.
￭ Confirm the message with [Yes].

The update process is started, it runs automatically. The device is
automatically switched off and back on during this process, possi-
bly several times. No user intervention is required.

￭ After successfully updating the software, remove the
external storage medium (USB flash drive) from the
instrument.

 

6 Starting the update (control instruments)

￭ Tap on the [Start] button (NOT on the [ ] fixed key).
If Result = No errors is displayed, then the update has been suc-
cessful.

￭ Remove the external storage medium (USB flash drive)
from the instrument.

￭ Switch the 917 Coulometer off and then back on again.

31.7.7 Service
System ▶ Diagnosis ▶ Service

Access to the service functions is password-protected and only accessible
to Metrohm service technicians. We recommend that you have mainte-
nance performed on the system regularly by the Metrohm Service Depart-
ment. You can automatically monitor the time interval after which the
next service visit is due (see chapter 12.5.1, page 109).
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32 Technical specifications

32.1 Touch screen

Display VGA color display (640 pixels x 320 pixels), diagonal approx. 5.7"

Touch panel resistive

Resistance to
chemicals

resistant to the following chemicals (no visible changes after 24 h of
duration of action):
￭ without protective cover:

– Methanol
– Toluene
– Ethyl acetate
– Acetone
– Dichloromethane
– Hydrochloric acid c(HCl) = 2 mol/L

￭ with protective cover (order number 6.2723.300):
– Methanol
– Propanol
– Toluene
– Xylene
– Acetone
– Chloroform
– Formamide
– Sulfuric acid c(H2SO4) = 2 mol/L
– Hydrochloric acid c(HCl) = 2 mol/L
– Caustic soda c(NaOH) = 2 mol/L
– Composite 5
– 1-butanol
– 1-hexanol
– Decanol
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32.2 Measuring inputs

32.2.1 Generator electrode
One electrode connector (Gen.) for a generator electrode.

Iodine generation with current pulses or continuous current.

Current at the
electrode

auto: variable direct current
100, 200, 400 mA: pulsating direct current

Imax 400 mA

Titration rate max. 2.24 mg H2O/min

32.2.2 Indicator electrode
One measuring input (Ind.) for an indicator electrode.

Measuring mode
Ipol

Determination with adjustable polarization current.
Voltametric endpoint indication with alternating current.

AC 5, 10, 20, 30 µA

DC –125 - +125 µA

32.2.3 Temperature sensor
One measuring input (Temp.) for a Pt1000 or NTC temperature sensor.

Measuring range

Pt1000 –150 - +250 °C

NTC –5 - +250 °C
For an NTC sensor with (R (25 °C) = 30000 Ω and B (25/50) = 4100 K)

Resolution

Pt1000 0.1 °C

NTC 0.1 °C

Measuring accu-
racy

Pt1000 ±0.2 °C
(Applies for measuring range –20 - +150 °C; ±1 digit; without sensor
error, under reference conditions)

NTC ±0.6 °C
(Applies for measuring range +10 - +40 °C; ±1 digit; without sensor
error, under reference conditions)
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32.2.4 Determination range
Recommended 10 µg to 200 mg H2O

32.2.5 Resolution
0.1 µg H2O

32.2.6 Reproducibility
Sample: Standard of the reagent manufacturers
At 10 µg - 1000 µg H2O: ±3 µg
At >1,000 µg H2O: 0,3% or better

32.3 Internal stirrer

Rotational speed

Maximum rota-
tional speed

±(1700 - 1900) rpm

Rotational
speed settings

±15 steps

Change in rota-
tional speed per
step

±(115 - 125) rpm

Power consump-
tion

< 4 W

Fuse Electronic overload protection

32.4 Pump

Add > 600 mL/min (at 25 °C; standard accessories)

Aspirate > 400 mL/min (at 25°C; standard accessories)
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32.5 Interfaces and connectors

Power connection For connecting the external power supply unit.

MSB connector For connecting dosing devices, stirrers or a Remote Box.

USB connector Type A, for connecting USB devices.

Ethernet connec-
tor

For connection to a data network (LAN).

Sensor connectors One connector each for:
￭ Generator electrode
￭ Indicator electrode
￭ Temperature sensor (Pt1000 or NTC)

Two connection
nipples

For connecting tubing for aspirating solvent and extracting the con-
tents of the titration cell.

32.6 Power supply

Instrument

Input voltage 24 V DC

Max. power
consumption

2.0 A

External power
supply unit

6.2164.010, LPS conformity according to UL60950-1

Input current 1.5 A

Max. output
current

2.7 A

32.7 Declarations of Conformity

Up-to-date information on the EU conformity and the requirements for
electromagnetic compatibility for your product can be found on the Inter-
net under https://www.metrohm.com/en-us/products-overview/.

Using the article number, you can download the Declaration of conform-
ity for ... under the documents of the product.

https://www.metrohm.com/en-us/products-overview/
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32.8 Ambient temperature

Nominal function
range

+5 to +45 °C
at max. 80% relative humidity, non-condensing

Storage +5 to +45 °C

32.9 Reference conditions

Ambient tempera-
ture

+25 °C (±3 °C)

Relative humidity ≤ 60%

Operating temper-
ature status

Instrument in operation at least 30 min

Validity of the
data

After adjustment

32.10 Dimensions

Width 193 mm

Height

without titra-
tion vessel
holder

145 mm

Height

with titration
vessel holder

230 mm

Depth 448 mm

Weight (including
power supply unit)

6020 g

Material

Housing Poly(butylene terephthalate) (PBT)

Base Steel, stainless, coated
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32.11 Storage capacity

Random access
memory

128 MB

Internal memory 1 GB of which 900 MB available.

Required memory
per method

3–6 KB
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33 Accessories

Up-to-date information on the scope of delivery and optional accessories
for your product can be found on the Internet. You can download this
information using the article number as follows:

Downloading the accessories list

 

1 Enter https://www.metrohm.com/ into your Internet browser.

 

2 Enter the article number (e.g. 917) into the search field.

The search result is displayed.

 

3 Click on the product.

Detailed information regarding the product is shown on various tabs.

 

4 On the Included parts tab, click on Download the PDF.

The PDF file with the accessories data is created.

NOTICE

Once you have received your new product, we recommend download-
ing the accessories list from the Internet, printing it out and keeping it
together with the manual for reference purposes.

https://www.metrohm.com/
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800 Dosino .............................. 22
805 Dosimat ............................ 22

A
Acoustic signals ........................ 55
ADD ....................................... 278
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Mount ................................ 14
Adsorber tube

Fill ...................................... 10
Audit Trail ................................. 53

Archive ............................. 318
Export .............................. 318
Filter ................................. 317
Open ................................ 315

AuditTrailViewer
Installing ........................... 314
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Barcode reader
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BEEP ....................................... 300
BRC ...................................... 1, 30
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C
CALC ...................................... 256
CALC LIVE .............................. 262
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Add .................................. 256
Delete .............................. 256
Edit .................................. 256
Load template .................. 257
Note ................................. 260
Result options ................... 261
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BRC .................................. 244
KFC .................................. 235

Command
ADD ................................. 278
BEEP ................................. 300
BRC .................................. 238
CALC ................................ 256
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CONTROL RS .................... 289
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EMPTY .............................. 277
END ................................. 301
EVAL FIX-EP ...................... 253
EVAL MIN/MAX ................ 254
EVAL RATE ........................ 255
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Insert ................................ 136
KFC .................................. 229
LIFT .................................. 291
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REQUEST .......................... 299
SAMPLE ............................ 292
SCAN ............................... 285
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SIGN ................................ 301
STIR .................................. 298
SUBSEQ ............................ 293
WAIT ................................ 299

Command list ......................... 135
Common variable

Delete .............................. 111
Edit .................................. 111
Properties ......................... 113
Validity ............................. 114

Communication ...................... 285
Conditioning

BRC .................................. 242
KFC .................................. 233

Connect
Balance .............................. 25
Barcode reader ................... 26
Dosing device ..................... 22
MSB devices ....................... 21
PC keyboard ....................... 26
Printer ................................ 24
Remote Box ........................ 23
Stirrer or titration stand ...... 23
USB devices ........................ 24
USB hub ............................. 24

Control ................................... 151
Control instrument ................... 72
Control parameters

BRC .................................. 238
KFC .................................. 229

Control Remote Box ................. 66
CONTROL RS .......................... 289
Coulometer .............................. 66
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................................................. 29
CTRL ...................................... 287
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Statistics data ................... 153
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Cancel .............................. 172
Carry out .......................... 170
Data ................................. 178
Define filters ..................... 188
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......................................... 186
Load ................................. 185
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Message ........................... 182
Properties ......................... 183
Recalculate ....................... 193
Reevaluate ........................ 193
Save ................................. 190
Save automatically ............ 146
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Sign .................................. 149

Determination run .................. 170
Device

885 Compact Oven SC ....... 75
Add .................................... 65
Balance .............................. 83
Coulometer ........................ 72
Delete ................................ 64
Edit .................................... 64
New ................................... 64
Printer ................................ 79
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USB/RS-232 adapter ........... 85
Device manager ....................... 64

885 Compact Oven SC ....... 75
Diagnosis ............................... 318
Dialog language ....................... 37
Dialog options .......................... 39
Dialog settings

System-specific ................... 39
Directory structure .................... 96
Display ....................................... 7
Dosing ................................... 217

Continuous ....................... 218
Fixed volume .................... 220

Dosing curve .......................... 191
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Connect ............................. 22
Parameters ............... 279, 284

Dosing parameters
ADD ................................. 278

Dosing rate
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Dosing unit
Replace reagent ................ 222
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E-mail ....................................... 67
Electrode .................................. 60

Connect ............................. 16
Parameters ....... 236, 245, 249

Electrostatic charge .................... 5
EMPTY ................................... 277

Default parameters ........... 310
Emptying ................................ 222
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END ....................................... 301
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EVAL MIN/MAX ...................... 254
EVAL RATE .............................. 255
Evaluation
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Sensor ................................ 62
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Favorite .................................. 155

Add .................................. 156
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Edit .................................. 156
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........................................... 42, 53
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Copy .................................. 93
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File manager ............................ 91
Filling ..................................... 222
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Maximum ................. 310, 311
Filter

Determination .................. 188
Result table ...................... 202

Fixed endpoint
Evaluation ........................ 253

Fixed key
Back ..................................... 7
Help ..................................... 7
Home ................................... 7
Manual ................................. 7
Print ..................................... 7
START ................................... 7
STOP .................................... 7

FLOW ..................................... 296
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Formula editor ........................ 264
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Fill ...................................... 13
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Sample table .................... 165

Load result template ............... 257
Login

Options .............................. 48
Logout automatically ................ 49
LQH ....................................... 282

M
Manual control ....................... 213
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Dosing ............................. 217
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Filling ............................... 222
Measuring ........................ 215
Preparing .......................... 221
Remote lines ..................... 224
Stirring ............................. 223
Troubleshooting ............... 306
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MEAS ..................................... 247
MEAS T/F OFF ......................... 298
MEAS T/F ON ......................... 297
Measured value

Display resolution ............... 55
Measurement curve ................ 191
Measuring .............................. 215
Measuring parameters

MEAS ............................... 247
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Message

Determination .................. 182
Send e-mail ........................ 67

Method .................................. 132
Command list ................... 135
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Create .............................. 132
Delete signatures .............. 150
Edit .................................. 135
Insert command ............... 136
Load ................................. 134
Note ................................. 146
Options ............................ 137
Properties ......................... 144
Sample data ..................... 141
Save ................................. 133
Save as favorite ................ 155
Sign .................................. 149
Start options ..................... 138
Stop options ..................... 140
Troubleshooting ............... 304

Metrohm Serial Bus .................... 8
Metrohm Serial Bus MSB, see also
"MSB" ...................................... 21
Minimum evaluation ............... 254
Miscellaneous commands ....... 298
Molecular sieve

Replace .............................. 11
Monitoring

Limit values sample size .... 143
MOVE .................................... 289
MSB

Connect devices ................. 21
MSB connector ........................... 8

N
Network connection ................. 28
Note

Method ............................ 146
Numerical input ........................ 35
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Parameter
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KFC .................................. 229
LIFT .................................. 291
LQH ................................. 282
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REPORT ............................ 271
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SIGN ................................ 301
STIR .................................. 298
SUBSEQ ............................ 293
WAIT ................................ 299

Password
Forgotten ........................... 51
Options .............................. 50

PC keyboard
Connect ............................. 26

PC/LIMS report
Save ................................... 68
Send ................................. 146

PDF settings ............................. 80
Peripheral devices ..................... 64
Power connection ...................... 8
Power supply

Power supply unit ............... 15
Power supply unit

Connect ............................. 15
Power switch .............................. 8
PREP ....................................... 276
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Preparing ................................ 221

Default parameters ... 310, 311
Printer ................................ 24, 79

PDF settings ....................... 80
Printing .................................. 205

Troubleshooting ............... 305
Properties
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File ..................................... 94
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Pump
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Edit .................................... 56
Replace ............................ 222
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Reason ..................................... 52

Modification option ............ 52
Recalculation .......................... 193
Reevaluation ........................... 193
Remote Box

Connect ............................. 23
Remote lines

Manual control ................. 224
Report .................................... 205

Print ................................. 205
REPORT .................................. 271
Report header ........................ 130
REQUEST ................................ 299
Resolution

Measured value display ....... 55
Result ..................................... 178
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Limits ............................... 260
Save as a common variable
......................................... 115
Template .......................... 121

Result table ............................ 199
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Delete automatically ......... 203
Save ................................. 204
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Sample identification
Modify designation ........... 141
Modify the designation ..... 169

Sample identification list ......... 117
Sample series

Perform ............................ 171
Sample size

Fixed ................................ 141
Limit value ........................ 143
Limits ............................... 141
Send from a balance ......... 312

Sample table .......................... 162
Save as favorite ................ 155
Troubleshooting ............... 304

Save
Determination .................. 190
Result table ...................... 204
Sample table .................... 164
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